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UNIT-I 
 

Introduction to Computers  

 

Introduction:-  

 

What is a Computer? 
A Computer is a group of electronic devices used to process data. In the 1950s, 
computers were massive, special-purpose machines that only huge institutions 
such as governments and universities could afford. Primarily, these early computers 
performed complex numerical tasks, such as calculating the precise orbit of Mars or 
planning the trajectories of missiles or processing statistics for the Bureau of the 
census. Although computers were certainly useful for tasks like these, it soon became 
apparent that they could also be helpful in an ordinary business environment. 
 
In the 1960s, modern computers began to revolutionize the business world. IBM 
introduced its System/360 mainframe computer in April 1964 and ultimately 
sold over 33,000 of these machines. As a result of the commercial success of its 
System/360, IBM became the standard against which other computer 
manufacturers and their systems would be measured for years to come. 
 
In the 1970s, Digital Equipment Corporation (DEC) took two more giant steps toward 
bringing computers into mainstream use with the introduction of its PDP-11 and VAX 
computers. These models came in many sizes to meet different needs and budgets. 
Since then, computers continue to shrink in size while providing more power for less 
money. Today, the most common type of computer you will see is called a personal or 
PC, because it is designed to be used by just one person at a time. Despite its small 
size the modern personal computer is more powerful than any of the room-sized 
machines of the 1960s. 
 

Fundamentals of Computers 
 
A system can be defined as a set of components that work together to accomplish one 
or more common goals. A Computer is nothing but a system accepting input from a 
user, process the same, and giving the output in the required format. In other words a 
computer is a machine , which can be programmed to compute. The characteristics of a 
computer are: 
  
• Response to a specific set of commands called as Instructions. 
• Execution of a prerecorded list of instructions called Program 

 

Characteristics of Computers 
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There are various features or characteristics of the computer system depending on their 

size, capacity, and specifications. But, the major characteristics of the computer can be 

classified into Speed, Accuracy, Diligence, Versatility, Reliability, Consistency, Memory, 

Storage Capacity, Remembrance Power, and Automation. 

 

 

Limitations of Computer: 

Some limitations of the computer system are given below: 

• The computer itself cannot function. It needs a set of instructions to perform or process 
any task. 

• Computers cannot think or feel like humans. They can only work according to the 
instructions given. 

• Unlike humans, computers do not learn from experiences. 

• Power is required to operate the computer and unexpected problems or errors can 
occur in the event of a breakdown of the system. 

 

 

 

Block diagram of computer 
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The Computer system consists of mainly three types that are central processing unit 
(CPU),Input Devices, and Output Devices.The Central processing unit (CPU) again 
consists of ALU (Arithmetic Logic Unit) and Control Unit. 

The set of instruction is presented to the computer in the form of raw data which is 
entered through input devices such as keyboard or mouse. 

Later this set of instructions is processed with the help of CPU [Central Processing 
Unit], and the computer system produces an output with the help of output devices like 
printers and monitors. 

A large amount of data is stored in the computer memory with the help of primary and 
secondary storage devices temporarily and permanently. This is called as storage 
devices 

The CPU is the heart | Brain of a computer because without the necessary action 
taken by the CPU the user cannot get the desired output. The Central Processing Unit 
[CPU] is responsible for processing all the Instruction which is given to the computer 
system. 

Below Block Diagram of Computer and Its Components are mentioned for better 
understanding 

                     

The Basic components & parts of computer system are given below :: 
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Input Devices 

Output Devices 

CPU (Central Processing Unit) 

Storage Unit 

ALU(Arithmetic Logic Unit) 

Control Unit 

 

Types of computers and features 

There are two basic categories of computers: Special purpose and General Purpose. 

Special purpose computers are designed to perform a specific task such as keeping 

time in a digital watch or programming a video cassette recorder. In the case of General 

purpose computers they are adapted to perform any number of functions or tasks. 

Computers based on their size, cost and performance can be further classified into four 

types 

 

1. Super Computers 

2. Main Frames 

3. Mini Computers 

4. Micro Computers 

 

Super Computers 

 

Supercomputers are the most powerful computers made. They are built to process huge 

amounts of data. For example, scientists build models of complex processes and 

simulate the processes on a supercomputer. One such process is nuclear fission. As a 

fissionable material approaches a critical mass, the researchers want to know exactly 

what will happen during every nanosecond of a nuclear chain reaction. A 

supercomputer can model the actions and reactions of literally millions of atoms as they 

interact. 
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Because computer technology changes so quickly the advanced capabilities of a 

supercomputer today may become the standard features of a PC a few years from now, 

and next year‘s supercomputer will be vastly more powerful than today‘s. 

 

Main Frames 

 

The largest type of computer in common use is the mainframe. Mainframe computers 

are used where many people in a large organization need frequent access to the same 

information, which is usually organized into one or more huge databases. For example, 

consider the Texas Department of Public Safety, where people get their drivers‘ 

licenses. This state agency maintains offices in every major city in Texas, each of which 

has many employees who work at computer terminals. A terminal is a keyboard and 

screen wired to the mainframe. It does not have its own CPU or storage; it is just an 

input/output (I/O) device that functions as a window into a computer located somewhere 

else. The terminals at the Public Safety offices are all connected to a common database 

on a mainframe in the state capital. A mainframe computer controls the database that 

handles the input and output needs of all the terminals connected to it. Each used has 

continuous access to the driving records and administrative information for every 

licensed driver and vehicle in the stateliterally, millions of records. On smaller systems, 

handling this volume of user access to a central database would be difficult and more 

time consuming. 

 

No one really knows where the term mainframe originated. Early IBM documents 

explicitly define the term frame as a integral part of a computer: ―the housing,… 

hardware support structures,… and all the parts and components therein.‖ It may be 

that when computers of all sizes and shapes began to appear in computer 

environments, the big computer was referred to as the main frame, as in the main 

computer, and that eventually the term was shortened to one word, mainframe. 

 

Note :- The main difference between a super computer and a mainframe is that a super 

computer channels all its power into executing a few programs as fast as possible 

whereas a mainframe uses its power to execute many programs concurrently. 
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Micro Computers 

 

Microcomputers are the smallest type of computers available and are popularly known 

as personal computers. Personal computers are small relatively inexpensive computers 

that are designed for individual users. In terms of cost, they can range anywhere from a 

few hundred dollars to over few thousand dollars. Personal computers are designed for 

word processing, accounting, desktop publishing and database management 

applications. Personal computers first appeared in the late stage of 1970. One of the 

first and most popular computers was Apple 2, which was first introduced in 1977 by 

Apple Computer. During the late 1970s and early 1980s different new models and 

different operating systems started appearing daily. Then in 1981, International 

Business Machine (IBM) entered in the fray with the first personal computer called IBM 

PC. It became an overnight success and was the people's choice for personal 

computer. One of the few companies, which survive IBM's 

onslaught, is Apple Computer. 

 

Today the world of personal computers is divided between Macintosh and Personal 

Computers. The principal characteristics of PC's are that they are single-user systems. 

But they can be linked together to form a network. In terms of power there is a great 

variation. At the high-end, the distinction between personal computers and workstations 

has faded where high-end models of Macintosh and Personal Computer offer the same 

computing power and graphics capability. 

 
 
 
Mini Computers 

 

When Digital Equipment Corporation (DEC) began shipping its PDP series computers in 

the early 1960s, the press dubbed these machines minicomputers because of their 

small size compared to other computers of the day. Much to DEC‘s chagrin, the name 

stuck. The best way to explain the capabilities of a minicomputers is to say that they lie 

somewhere between those of mainframes and those of personal computers. Like 

mainframes, minicomputers can handle a great deal more input and output than 

personal computers can. Although some minis and designed for a single user, many 

can handle dozens or even hundreds of terminals.  
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A company that needs the power of a mainframe but cannot afford such a large 

machine may find that a minicomputer suits its needs nicely. The major minicomputer 

manufacturers include DEC, Date General, IBM, and Hewlett-Packard. 

Types of Programming Languages 

(Machine Languages, Assembly Languages, High Level Languages) 

Computer programming language, any of various languages for expressing a set of 

detailed instructions for a digital computer. Such instructions can be executed directly 

when they are in the computer manufacturer-specific numerical form known as machine 

language, after a simple substitution process when expressed in a 

corresponding assembly language, or after translation from some ―higher-level‖ 

language. Although there are many computer languages, relatively few are widely used. 

Machine and assembly languages are ―low-level,‖ requiring a programmer to manage 

explicitly all of a computer‘s idiosyncratic features of data storage and operation. In 

contrast, high-level languages shield a programmer from worrying about such 

considerations and provide a notation that is more easily written and read by 

programmers. 

Machine and assembly languages 

A machine language consists of the numeric codes for the operations that a particular 
computer can execute directly. The codes are strings of 0s and 1s, or binary digits 
(―bits‖), which are frequently converted both from and to hexadecimal (base 16) for 
human viewing and modification. Machine language instructions typically use some bits 
to represent operations, such as addition, and some to represent operands, or perhaps 
the location of the next instruction. Machine language is difficult to read and write, since 
it does not resemble conventional mathematical notation or human language, and its 
codes vary from computer to computer. 

Assembly language is one level above machine language. It uses 

short mnemonic codes for instructions and allows the programmer to introduce names 

for blocks of memory that hold data. One might thus write ―add pay, total‖ instead of 

―0110101100101000‖ for an instruction that adds two numbers. 

Assembly language is designed to be easily translated into machine language. Although 

blocks of data may be referred to by name instead of by their machine addresses, 

assembly language does not provide more sophisticated means of organizing complex 

information. Like machine language, assembly language requires detailed knowledge of 

internal computer architecture. It is useful when such details are important, as in 

https://www.britannica.com/technology/computer
https://www.britannica.com/technology/machine-language
https://www.britannica.com/technology/machine-language
https://www.britannica.com/technology/assembly-language
https://www.merriam-webster.com/dictionary/idiosyncratic
https://www.britannica.com/technology/binary-code
https://www.merriam-webster.com/dictionary/mnemonic
https://www.britannica.com/technology/computer-architecture
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programming a computer to interact with peripheral devices (printers, scanners, storage 

devices, and so forth). 

Algorithmic languages 

Algorithmic languages are designed to express mathematical or symbolic computations. 
They can express algebraic operations in notation similar to mathematics and allow the 
use of subprograms that package commonly used operations for reuse. They were the 
first high-level languages. 

FORTRAN 

The first important algorithmic language was FORTRAN (formula translation), designed 
in 1957 by an IBM team led by John Backus. It was intended for scientific computations 
with real numbers and collections of them organized as one- or multidimensional arrays. 
Its control structures included conditional IF statements, repetitive loops (so-called DO 
loops), and a GOTO statement that allowed nonsequential execution of program code. 
FORTRAN made it convenient to have subprograms for common mathematical 
operations, and built libraries of them. 

FORTRAN was also designed to translate into efficient machine language. It was 
immediately successful and continues to evolve. 

ALGOL 

ALGOL (algorithmic language) was designed by a committee of American and 
European computer scientists during 1958–60 for publishing algorithms, as well as for 
doing computations. Like LISP (described in the next section), ALGOL had recursive 
subprograms—procedures that could invoke themselves to solve a problem by reducing 
it to a smaller problem of the same kind. ALGOL introduced block structure, in which a 
program is composed of blocks that might contain both data and instructions and have 
the same structure as an entire program. Block structure became a powerful tool for 
building large programs out of small components. 

ALGOL contributed a notation for describing the structure of a programming language, 
Backus–Naur Form, which in some variation became the standard tool for stating 
the syntax (grammar) of programming languages. ALGOL was widely used in Europe, 
and for many years it remained the language in which computer algorithms were 
published. Many important languages, such as Pascal and Ada (both described later), 
are its descendants. 

LISP 

https://www.britannica.com/technology/input-output-device
https://www.britannica.com/technology/FORTRAN
https://www.britannica.com/technology/FORTRAN
https://www.britannica.com/topic/International-Business-Machines-Corporation
https://www.britannica.com/biography/John-Warner-Backus
https://www.britannica.com/science/real-number
https://www.britannica.com/technology/ALGOL-computer-language
https://www.britannica.com/place/Algol-star
https://www.merriam-webster.com/dictionary/algorithms
https://www.merriam-webster.com/dictionary/invoke
https://www.merriam-webster.com/dictionary/syntax
https://www.britannica.com/technology/Pascal-computer-language
https://www.britannica.com/technology/LISP-computer-language
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LISP (list processing) was developed about 1960 by John McCarthy at 
the Massachusetts Institute of Technology (MIT) and was founded on the mathematical 
theory of recursive functions (in which a function appears in its own definition). A LISP 
program is a function applied to data, rather than being a sequence of procedural steps 
as in FORTRAN and ALGOL. LISP uses a very simple notation in which operations and 
their operands are given in a parenthesized list. For example, (+ a (* b c)) stands 
for a + b*c. Although this appears awkward, the notation works well for computers. LISP 
also uses the list structure to represent data, and, because programs and data use the 
same structure, it is easy for a LISP program to operate on other programs as data. 

LISP became a common language for artificial intelligence (AI) programming, partly 
owing to the confluence of LISP and AI work at MIT and partly because AI programs 
capable of ―learning‖ could be written in LISP as self-modifying programs. LISP has 
evolved through numerous dialects, such as Scheme and Common LISP. 

C 

The C programming language was developed in 1972 by Dennis Ritchie and Brian 
Kernighan at the AT&T Corporation for programming computer operating systems. Its 
capacity to structure data and programs through the composition of smaller units is 
comparable to that of ALGOL. It uses a compact notation and provides the programmer 
with the ability to operate with the addresses of data as well as with their values. This 
ability is important in systems programming, and C shares with assembly language the 
power to exploit all the features of a computer‘s internal architecture. C, along with its 
descendant C++, remains one of the most common languages. 

Business-oriented languages 

COBOL 

COBOL (common business oriented language) has been heavily used by businesses 
since its inception in 1959. A committee of computer manufacturers and users and U.S. 
government organizations established CODASYL (Committee on Data Systems 
and Languages) to develop and oversee the language standard in order to ensure its 
portability across diverse systems. 

COBOL uses an English-like notation—novel when introduced. Business computations 
organize and manipulate large quantities of data, and COBOL introduced 
the record data structure for such tasks. A record clusters heterogeneous data—such 
as a name, an ID number, an age, and an address—into a single unit. This contrasts 
with scientific languages, in which homogeneous arrays of numbers are common. 
Records are an important example of ―chunking‖ data into a single object, and they 
appear in nearly all modern languages. 

https://www.britannica.com/technology/LISP-computer-language
https://www.britannica.com/biography/John-McCarthy
https://www.britannica.com/topic/Massachusetts-Institute-of-Technology
https://www.britannica.com/science/function-mathematics
https://www.britannica.com/technology/artificial-intelligence
https://www.merriam-webster.com/dictionary/confluence
https://www.merriam-webster.com/dictionary/dialects
https://www.britannica.com/technology/C-computer-programming-language
https://www.britannica.com/biography/Dennis-M-Ritchie
https://www.britannica.com/topic/ATandT-Corporation
https://www.britannica.com/technology/operating-system
https://www.merriam-webster.com/dictionary/composition
https://www.britannica.com/technology/systems-programming
https://www.britannica.com/technology/C-computer-language
https://www.britannica.com/technology/COBOL
https://www.britannica.com/technology/COBOL
https://www.merriam-webster.com/dictionary/diverse
https://www.britannica.com/technology/record-computing
https://www.britannica.com/technology/data-structure
https://www.merriam-webster.com/dictionary/heterogeneous
https://www.merriam-webster.com/dictionary/homogeneous
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SQL 

SQL (structured query language) is a language for specifying the organization 
of databases (collections of records). Databases organized with SQL are called 
relational, because SQL provides the ability to query a database for information that 
falls in a given relation. For example, a query might be ―find all records with both last 
name Smith and city New York.‖ Commercial database programs commonly use an 
SQL-like language for their queries. 

Education-oriented languages 

BASIC 

BASIC (beginner‘s all-purpose symbolic instruction code) was designed at Dartmouth 
College in the mid-1960s by John Kemeny and Thomas Kurtz. It was intended to be 
easy to learn by novices, particularly non-computer science majors, and to run well on 
a time-sharing computer with many users. It had simple data structures and notation 
and it was interpreted: a BASIC program was translated line-by-line and executed as it 
was translated, which made it easy to locate programming errors. 

Its small size and simplicity also made BASIC a popular language for early personal 
computers. Its recent forms have adopted many of the data and control structures of 
other contemporary languages, which makes it more powerful but less convenient for 
beginners. 

Pascal 

About 1970 Niklaus Wirth of Switzerland designed Pascal to teach structured 
programming, which emphasized the orderly use of conditional and loop control 
structures without GOTO statements. Although Pascal resembled ALGOL in notation, it 
provided the ability to define data types with which to organize complex information, a 
feature beyond the capabilities of ALGOL as well as FORTRAN and COBOL. User-
defined data types allowed the programmer to introduce names for complex data, which 
the language translator could then check for correct usage before running a program. 

During the late 1970s and ‘80s, Pascal was one of the most widely used languages for 
programming instruction. It was available on nearly all computers, and, because of its 
familiarity, clarity, and security, it was used for production software as well as for 
education. 

Logo 

https://www.britannica.com/technology/SQL
https://www.britannica.com/technology/database
https://www.britannica.com/topic/surname
https://www.britannica.com/topic/surname
https://www.britannica.com/place/New-York-City
https://www.britannica.com/technology/BASIC
https://www.britannica.com/technology/BASIC
https://www.britannica.com/topic/Dartmouth-College
https://www.britannica.com/topic/Dartmouth-College
https://www.britannica.com/biography/John-George-Kemeny
https://www.britannica.com/technology/computer/Time-sharing-and-minicomputers#ref216066
https://www.britannica.com/technology/data-structure
https://www.britannica.com/technology/Pascal-computer-language
https://www.britannica.com/biography/Niklaus-Emil-Wirth
https://www.britannica.com/place/Switzerland
https://www.britannica.com/technology/Pascal-computer-language
https://www.britannica.com/technology/ALGOL-computer-language
https://www.britannica.com/technology/FORTRAN
https://www.britannica.com/technology/COBOL
https://www.britannica.com/technology/software
https://www.britannica.com/technology/Logo
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Logo originated in the late 1960s as a simplified LISP dialect for education; Seymour 
Papert and others used it at MIT to teach mathematical thinking to schoolchildren. It had 
a more conventional syntax than LISP and featured ―turtle graphics,‖ a simple method 
for generating computer graphics. (The name came from an early project to program a 
turtlelike robot.) Turtle graphics used body-centred instructions, in which an object was 
moved around a screen by commands, such as ―left 90‖ and ―forward,‖ that specified 
actions relative to the current position and orientation of the object rather than in terms 
of a fixed framework. Together with recursive routines, this technique made it easy to 
program intricate and attractive patterns. 

Hypertalk 

Hypertalk was designed as ―programming for the rest of us‖ by Bill Atkinson for Apple‘s 
Macintosh. Using a simple English-like syntax, Hypertalk enabled anyone to combine 
text, graphics, and audio quickly into ―linked stacks‖ that could be navigated by clicking 
with a mouse on standard buttons supplied by the program. Hypertalk was particularly 
popular among educators in the 1980s and early ‘90s for classroom multimedia 
presentations. Although Hypertalk had many features of object-oriented languages 
(described in the next section), Apple did not develop it for other computer platforms 
and let it languish; as Apple‘s market share declined in the 1990s, a new cross-platform 
way of displaying multimedia left Hypertalk all but obsolete (see the section World Wide 
Web display languages). 

Object-oriented languages 

Object-oriented languages help to manage complexity in large programs. Objects 
package data and the operations on them so that only the operations are publicly 
accessible and internal details of the data structures are hidden. This information hiding 
made large-scale programming easier by allowing a programmer to think about each 
part of the program in isolation. In addition, objects may be derived from more general 
ones, ―inheriting‖ their capabilities. Such an object hierarchy made it possible to define 
specialized objects without repeating all that is in the more general ones. 

Object-oriented programming began with the Simula language (1967), which added 
information hiding to ALGOL. Another influential object-oriented language was Smalltalk 
(1980), in which a program was a set of objects that interacted by sending messages to 
one another. 

C++ 

The C++ language, developed by Bjarne Stroustrup at AT&T in the mid-1980s, 
extended C by adding objects to it while preserving the efficiency of C programs. It has 
been one of the most important languages for both education and industrial 

https://www.britannica.com/technology/Logo
https://www.britannica.com/technology/LISP-computer-language
https://www.merriam-webster.com/dictionary/dialect
https://www.britannica.com/topic/education
https://www.britannica.com/biography/Seymour-Papert
https://www.britannica.com/biography/Seymour-Papert
https://www.merriam-webster.com/dictionary/syntax
https://www.britannica.com/topic/computer-graphics
https://www.britannica.com/technology/Hypertalk
https://www.britannica.com/technology/Hypertalk
https://www.britannica.com/topic/Apple-Inc
https://www.britannica.com/technology/mouse-computer-device
https://www.britannica.com/technology/computer-programming-language/SGML#ref248133
https://www.britannica.com/technology/computer-programming-language/SGML#ref248133
https://www.britannica.com/technology/object-oriented-language
https://www.merriam-webster.com/dictionary/hierarchy
https://www.britannica.com/technology/C-computer-language
https://www.britannica.com/technology/C-computer-language
https://www.britannica.com/technology/C-computer-programming-language
https://www.merriam-webster.com/dictionary/efficiency
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programming. Large parts of many operating systems were written in C++. C++, along 
with Java, has become popular for developing commercial software packages that 
incorporate multiple interrelated applications. C++ is considered one of the fastest 
languages and is very close to low-level languages, thus allowing complete control over 
memory allocation and management. This very feature and its many other capabilities 
also make it one of the most difficult languages to learn and handle on a large scale. 

C# 

C# (pronounced C sharp like the musical note) was developed by Anders Hejlsberg at 
Microsoft in 2000. C# has a syntax similar to that of C and C++ and is often used for 
developing games and applications for the Microsoft Windows operating system. 

Ada 

Ada was named for Augusta Ada King, countess of Lovelace, who was an assistant to 
the 19th-century English inventor Charles Babbage, and is sometimes called the first 
computer programmer. Ada, the language, was developed in the early 1980s for 
the U.S. Department of Defense for large-scale programming. It combined Pascal-like 
notation with the ability to package operations and data into independent modules. Its 
first form, Ada 83, was not fully object-oriented, but the subsequent Ada 95 provided 
objects and the ability to construct hierarchies of them. While no longer mandated for 
use in work for the Department of Defense, Ada remains an effective language for 
engineering large programs. 

Data Organization 

Choosing one well-conceived system of data organization can help keeping on track 

with your data if there are multiple versions of data sets or changes in data sets. This 

holds especially in larger teams. To begin with your data organization, you have to 

define the structure of your research data. Most important structure types are shown 

below: 

 Flat rectangular files or tabular data is a classical and still often used data structure 
which can be read by all statistical and spreadsheet programs. 
 A common way to structure rectangular files is the wide format (table A in the 

image above): columns represent different variables, while lines represent 
different observations (e.g. subjects). However, problems in wide format arise 
when data is hierarchically structured, e.g. in designs with repeated 
measures (see table B in the image above). If the number of measurement 
occasions differs between observations, many cells will be left empty by design. 

 One solution can be to use the long format for the data set (see table C in the 
image above). In long format every line depicts one observational unit (e.g. one 

https://www.britannica.com/technology/Windows-OS
https://www.britannica.com/technology/operating-system
https://www.britannica.com/technology/Ada-computer-language
https://www.britannica.com/place/Ada-Oklahoma
https://www.britannica.com/biography/Ada-Lovelace
https://www.britannica.com/biography/Charles-Babbage
https://www.britannica.com/topic/US-Department-of-Defense
https://www.merriam-webster.com/dictionary/hierarchies
https://www.merriam-webster.com/dictionary/mandated
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measurement occasion for a specific person) and a variable characterizes the 
measurement occasion (e.g. day 1, pre-test etc.). This format permits the 
representation of hierarchical data in a classical rectangular file. Files in long 
format will contain some redundancies, because features of the higher order 
observation units are repeated in every line (e.g. time-invariant variables like 
subject‘s gender or year of birth). As functions within statistical packages usually 
work with one of these formats only, transformations between wide-format and 
long-format are a frequent task and corresponding functions exist (e.g. the 
reshape function and the reshape2 package in R). 

 Hierarchical files can be employed to avoid redundancies, that occur, when using 
rectangular files (see table E in the image above). XML files fulfill this requirement 
and allow to save data and metadata in one single file. However, despite these 
advantages XML-files are not commonly used in psychology and statistical software 
often requires tabular data as input. 

 Relational data bases organize data of different hierarchical levels in separate 
rectangular tables while the different tables are connected through defined 
associations. Individual tables can be statistically analyzed or linked to form new 
tables. Relational databases can depict complex associations in an elegant way but 
they need more administration and knowledge of database languages (e.g SQL). 

Organization of Research Data 

As there are neither best practices nor naming conventions that explicitly refer to 
psychological research data, we recommend the guidance developed in the Project TIER: 
Teaching Integrity in Empirical Research as a starting point for folder and file organization in 
empirical research projects. 
Furthermore, the general guidance on designing naming conventions of Boston University 
Libraries (n.d.) may be helpful: 

 The file naming you choose should be used consistently throughout your files 
(always include the same information, in the same order) 

Consider how, from a future point of view, your files should be organized, e.g. 
project_instrument_location_date_time_version. 

 You should always include dates in your file names so that changes can be retraced; 
use format YYYY-MM-DD. 

 Avoid the following symbols in your file names: ―/ \ : * ? ‖ < > [ ] & $. They have 
specific meanings in some computer operating systems and thus, may result in 
misreadings or even deletion of the file. 

 Don‘t use spaces to separate terms, instead use underscores (_). 
 Try to name folders in a descriptive way, so that it is clear what it contains, and keep 

the names short (15-20 characters max.) 
 Also try to keep file names short and descriptive (<25 characters) 
 If you do not use an automatic versioning software, include version numbers at the 

end of the file name (e.g. v01, v02,..) and change it every time the file is saved (also, 
refer to the knowledge base‘s section on versioning). This is especially important if 
there are several people working together on the files, so that changes can be 
tracked. 

https://seananderson.ca/2013/10/19/reshape.html
https://www.haverford.edu/tier
https://www.haverford.edu/tier
http://datawiz.zpid.de/index.php/during-data-collection/what-should-i-know-about-versioning/
http://datawiz.zpid.de/index.php/during-data-collection/what-should-i-know-about-versioning/
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 For your final version, use the word FINAL instead of a version number. This is 
especially useful and important if you share your files! 

 File names should only contain one period before the file extension, e.g. 
project_name_date.doc NOT project.name.date.doc OR project_name_date..doc) 

 If you already named many of your files, you can rename them quickly by using a file 
renaming application such as Bulk Rename Utility (Windows), ReNamer (Mac OS X) 
or PSRenamer (Mac OS X, Windows, Unix, Linux), and Zamzar  (convert files 
online). 

The DataWiz web application assists you in organizing your research data by offering a 
predefined structure and documentation scheme for your research project. 

Further Resources 

 SQL is a programming language that is specialized on managing data in relational 
database management systems. 

 XML is an interoperable human- and machine-readable markup language and is 
widely used in research data management due to its simplicity and generic usability. 

 

Drives 

Computer folks often throw around words, terms and acronyms assuming everyone else 

knows what they mean. I recently learned that‘s a bad assumption, though, as a 

customer discussing backing up files to an external hard drive remarked, ―You know, I 

don‘t think I really know what a hard drive is. What is a computer ‗drive,‘ anyway?‖ 

Wow, good question. In a nutshell, a computer ―drive,‖ also called a ―disk drive,‖ is a 

device that stores digital information from your computer, sort of like keeping beans in a 

jar. Beans can be added to or removed from the jar as desired, just as the zeroes and 

ones (0 and 1) that comprise digital information can be added to or removed from a 

computer disk drive as the computer user so chooses. 

All computer information is made up of various combinations of two numbers: zeroes 

and ones. Those numbers are the ―digital‖ components of the language that computers 

speak. When discussing computer ―files,‖ and the need for you to ―back up‖ your files, 

we are talking about large groups of zeros and ones that have been created when you 

type a manuscript, take a photograph with a digital camera or send a text message from 

your phone. That picture of the kids at Thanksgiving dinner is, in its basic form, nothing 

http://www.bulkrenameutility.co.uk/
https://renamer.com/
http://www.powersurgepub.com/products/psrenamer/index.html
http://www.zamzar.com/
http://www.zamzar.com/
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more than a big batch of numbers called a ―file.‖ Computers have the ability to take that 

group of numbers and turn it into an image on a screen. 

Computer drives are designed to allow us to store our files and retrieve them when 

needed. They were originally called ―disk‖ drives because the files were recorded on 

round things called ―disks.‖ ―Floppy‖ disks kept the information on a very thin, round 

piece of spinning material about the thickness of a piece of paper, and were about 3-

1/2, 5-1/4 or 8 inches in diameter. Housed inside a plastic or paper sheath, they were 

used in floppy disk drives. Very few people continue to use floppy disk drives. 

―Hard‖ disks use round platters made of very stiff material, usually aluminum, glass 

and/or ceramic. As with floppy disks, hard disks are coated with a layer of magnetic 

material that allows information to be stored, similar to the magnetic tape used in tape 

recorders. Hard disks, and the electronic circuits that make them work, are mounted 

inside rigid housings, and the entire assembly is called a hard disk drive, or, simply, 

―hard drive.‖ Hard drives can be mounted inside computers, or inside enclosures that 

allow them to be easily moved from one location to another. Drives like this are called 

―external‖ or ―portable‖ hard drives. 

Music CDs (Compact Disks) and DVDs (Digital Video Disks) are called ―optical‖ disks 

because, rather than using magnetic technology to store information, they use optical 

technology in the form of lasers. A powerful but very small laser beam scans the 

spinning disk to read and/or record the zeros and ones that comprise the stored 

information. If someone mentions an ―optical‖ drive, they are talking about a drive that 

uses CDs, DVDs or Blu-ray disks. Sometimes these drives, if they are capable of 

recording CDs or DVDs, are called ―burners‖ because, when recording a CD or DVD, 

the laser beam actually ―burns‖ spots on a layer of dye embedded in the disk, which the 

drive and computer can detect and interpret as zeroes and ones. 

―Flash‖ drives, sometimes called jump drives, thumb drives and USB drives, are also 

used to store digital files, but use ―solid-state‖ memory technology, rather than moving 

parts like motors and spinning disks. ―Solid-state drives‖ (SSDs) use the same method, 
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storing their information on digital integrated circuits (sometimes called ―chips‖) 

containing millions or billions of microscopic transistors, which act as switches. These 

switches, whether in an ―on‖ or ―off‖ state, are what store and process the zeroes and 

ones used by all computers. 

Why are disk drives called ―drives?‖ As near as I can tell, in electrical engineering, a 

drive is an electronic device used to provide power to a motor. That‘s the best reason 

I‘ve been able to come up with, so I hope it will do. 

Dave Moore has been performing computer consulting, repairs, security and networking 

in Oklahoma since 1984. He also teaches computer safety workshops for public and 

private organizations. 

Files 

A file is a container in a computer system for storing information. Files used in 

computers are similar in features to that of paper documents used in library and office 

files. There are different types of files such as text files, data files, directory files, binary 

and graphic files, and these different types of files store different types of information. In 

a computer operating system, files can be stored on optical drives, hard drives or other 

types of storage devices. 

In most operating systems, a file must have a unique name within a given file directory. 
However, while creating a filename, certain characters are considered illegal, and hence 
cannot be used. A filename is comprised of a name with a suffix, which is also known as 
a file extension. The file extension is two to four characters following the period in the 
complete filename. The file extension helps in identifying the type of file, file format and 
the attributes associated with the file. 

Most modern computer systems provide security or protection measures against file 
corruption or damage. The data contained in the files could range from system-
generated information to user-specified information. File management is done with the 
help of operating systems, third-party tools or done manually at times with the help of 
the user. 

The basic operations that can be performed on a file are: 

 Creation of a new file 
 Modification of data or file attributes 
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 Reading of data from the file 
 Opening the file in order to make the contents available to other programs 
 Writing data to the file 
 Closing or terminating a file operation 

In order to read or modify data in a file, specific software associated with the file 
extension is needed. 

Directories 

One of the most common pitfalls in building/publishing webpages is a lack of 

understanding of directory structure. Without this basic foundation, many people are lost 

when it comes to correcting link problems in their website. When you're creating a 

website, it's important that you understand WHERE your files are located WITHOUT the 

common shortcuts. When the website is published for everyone to view, those shortcuts 

won't be there and they don't work within a web page link to begin with. In order for the 

links to work properly, the server needs to know where they are truly located. If it can't 

find them, it will return a broken link. This is a common reason for broken image links. A 

basic understanding of the information here may help. 

Files  

Hopefully, you know that most of what you create on your computer is stored as "files." 

Files can take on many formats and attributes but in our case, we'll be looking at 

webpages and related files. Almost all files have what is known as a "file extension." A 

file extension is the last part of a file name and follows a "." The purpose of the file 

extension is to define the type of file.  

Mostly with web publishing, you'll be dealing with webpage (html) files and images. The 

most common file extensions in web publishing are listed below. Note, I've only included 

those extensions supported by UWG servers.  

• Web pages  

• .html Basic HTML  

• .htm Basic HTML  

• .php Hypertext Pre-processor  
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• Images  

• .jpg JPEG Image - Best for photography used on the web  

• .gif Graphic Interchange Format - Best for images with text and simple color like 

cartoons. Also supports transparency and animation.  

Directory Basics  

It may be easier to explain directory structure with an analogy. So think of your 

computer as a large file room, filled with file cabinets. Each file cabinet contains folders 

and files. This is the basic premise of directories. Directories are very similar to file 

cabinets. They can hold subdirectories and files.  

Location, location, location  

Just like you have a physical address for your residence, each directory and file has a 

"path" which indicates its location within your hard drive. Whenever you link to a file, 

you'll need to let the browser know where the file is located. This can be accomplished 

by an "absolute" or "relative" link.  

Absolute and Relative Links  

Absolute Links are like full addresses. These links are best used for external links such 

as other websites. For example, "http://www.westga.edu/departments/index.php" is a 

full web page address. With an absolute link, it doesn't matter where the file that 

contains the link is located because the browser is provided with the full address.  

Relative Links are paths which are "relative" to the file linking to it. In other words, if your 

index.html page links to another page in the same directory you only have to type 

"nameOfOtherPage.html" for the href="" attribute. The browser will begin with the path 

of the index.html page to determine the path of the image. Most web editing software 

will use relative links when you insert a hyperlink in your document. Because you do not 
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have to repeat the domain name in each link, they are easier and quicker to type. If your 

links aren't working, here are some clues to help you with relative links. 

Types of Memory 

(Primary And Secondary) RAM, ROM, PROM, EPROM. Secondary Storage Devices 

(FD, CD, HD, Pen drive):- 

Memory is the computer‘s electronic scratchpad. Programs are loaded into and run from 
memory. Data used by the program is also loaded into memory for fast access. The 
most common type of memory is called random access memory or RAM. As a result the 
term memory is commonly used to mean RAM. 
 
Perhaps the most important thing to remember about RAM is that it is volatile, so it 
needs a constant supply of power. When you turn off a computer, everything in RAM 
disappears. As you will soon learn this is why you frequently have to save everything 
you are working on to a storage device. 
 
One of the most important factors affecting the speed and power of a computer is the 
amount of RAM it has. Generally, the more it can do. The most RAM a computer has, 
the more it can do. The most common measurement unit for describing a computer‘s 
memory is the byte the amount of memory it tames to store a single character. When 
people talk about memory, the numbers are 
often so large that it is useful to use a shorthand term to describe the values 
 
� Kilobyte (KB)1024 bytes 
� Megabyte(MB)� 1024 kilobytes 
� Gigabyte (GB)1024 megabytes 
 
Today‘s Personal computers commonly have from 8 to 32 million bytes of memory or 8 
to 32 MB. 
 
Data processing systems often require access to a large amount of memory for which 
main memory is not enough. Memory can be classified into 2 types namely 
 
• Primary 
• Secondary 
 
Programs and data are stored in the memory unit of the CPU during processing. 
Memory consists of a number of storage locations. A unique number called address 
identifies each storage location. During processing, data may be stored in any location. 
Primary storage or main memory is of two types. 

 

• Random Access Memory (RAM) 
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• Read Only Memory (ROM) 
 
There are certain essential functions that the computer must perform when it is switched 
on. For example, connections have to be established within the various components of 
the computer and its peripherals. A series of programs or micro programs are required 
to perform these low-level functions. These programs are hardwired onto the Read Only 
Memory (ROM) chips at the time 
of manufacture. 
 
ROM is non-volatile that is when the computer is switched off, the data on these chips is 
not lost. When the machine is switched on, the memory, which is available to you, is 
called as Random Access Memory. The data can be read from and written to any 
location within RAM by specifying the relevant address. New data can be written onto 
any location, however, remember that any existing data at this location is overwritten. 
 
Unlike ROM, RAM is volatile. When the power goes off, the data is lost. It is necessary 
to store the data that is important onto a secondary storage device. 
 
Units of Storage 
 
It is possible for a computer to function with just processing, memory input and output 
devices. To be really useful however it also needs a place to deep program, files and 
related data when it is not using them. The purpose of storage is to hold data. 
 
It is helpful to think of storage as an electronic file cabinet and to think of RAM as an 
electronic worktable. When you need to work with a program or a set of data, the 
computer locate then in the file cabinet and puts a copy on the table. After you have 
finished working with the program or data, you put the new version into the file cabinet. 
There are three major distinction between storage 
and memory: 
 
1. There is more room in storage than in memory, just as there is, ore room in a file 
cabinet than there is on a tabletop. 
 
2. Storage retains its contents when the computer is turned off, whereas the programs 
or the data you put into memory disappear when you shut down the computer. 
3. Storage is much cheaper than memory. 
 
The most common storage medium is the magnetic disk. A disk is a round, flat object 
that spins around its center. Read18 write heads which are similar to the heads of a 
tape recorder or VCR float above and below the disk near its surface. 
 
The device that holds a disk is called a disk drive. Some disks are built into the drive 
and are not meant to be removed and other kinds of drives allow you to remove and 
replace disks. Most personal computers have a non removable hard disk. In addition, 
there are usually one or two diskette drives which allow you to use removable diskettes. 
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Typically a hard disk can store far more data than a diskette can , so the hard disk 
serves as the computer‘s primary filing cabinet. Diskettes are used to load new 
programs r data ont0 the hard disk to trade data with other users, and to make backup 
copies of the data on the hard disk. Because you can remove diskettes from a computer 
they are encased in a plastic or vinyl cover to protect then from fingerprints and dust. 
The first 
diskettes, commonly used in the late 1970s were 8-inch diskettes. Because the vinyl 
cover was very thin, the diskette was flimsy or floppy. Hence came the name of floppy 
disk. Next came the 5.25 inch diskettes that were common in the early PCs. Finally the 
3.5 inch diskette with its hard plastic shell appeared. 
 
Other types of storage devices include CD –ROM drives, tape drives, optical drives 
removable hard drives and man others. The CD-ROM drive is the most common type 
after the hard and diskette drives, Compact disks or CDs are aty0pe of optical storage 
device identical to audio CDs, that can store about 650MB or about 450 times as much 
information as a diskette. The type used in computers is called a CD-ROM, which 
stands for compact disk read only memory. The name implies that you cannot record 
over an audio CD. 
 
Having looked at various ways of storing data and also devices that store it, let us look 
at the way the computer stores this data. The computer being an electronic device runs 
on electricity. It recognizes the flow of electricity in states of ―on‖ or ―off‖. It in turn 
corresponds to the binary number system that has a base of two. Thus instead of 0-9, 
only the digits 0 and 1 are used. 
 
Each alphanumeric character is now represented in a storage location as a combination 
of binary digits (0s and 1s) or bits to form a byte. A byte typically stores 8 bits. The 
higher units are called megabytes, gigabytes, terabytes, and petabytes. 
 

8 bits                  = 1 Byte 
1024 bytes         = 1 Kilo Byte(KB) 
1024 KB             = 1 Mega Byte(MB) 
1024 MB            = 1 Giga Byte(GB) 
1024 GB            = 1 Tera Byte (TB) 
 

I/O Devices (Scanners, Plotters, LCD, Plasma Display:- 
 

Input Devices:-  

The set of instructions or information is provided to the computer system or PC with 
the help of input devices such as (keyboard, mouse, scanners, etc). The Instruction or 
data presented to the computer system is converted into binary form then it is supplied 
to a computer system for further processing . 
 
The Input Unit perform transferring the data from outside the world into the system and 
later this data is processed and the system produces instruction through output unit 
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such as Printer, monitors, etc. 
 
The Input devices enter the data from outside the world into the primary storage 
devices. The input devices are a means of communication with the outside world and 
our computer system. 

 Input Devices accepts or receives the data or instruction from outside the world 
such as input devices like keyboard and mouse 

 It converts the data or instruction or information into machine readable form for 
further processing. 

 Later it supplies the decipherable information to PC for additionally handling 

 They act like a connection between outside the world and our own computer 
system 

 Keyboard and mouse are the prime examples of input devices. 

 When the procedure is finished we get or receive desire result using output 
devices such as printer's and monitor's. 

 

Output Devices:- 

Output devices of computer produce or generate results with the help of devices or 
gadgets such as a printer, monitor, etc primarily these instruction or data provided to a 
computer system is in binary code so to produce or generate the desired output the 
system has to convert this data into human-readable form, to do so it has to first 
present the data or instruction to a computer system for further processing or handling. 
With the help and assistance of output devices, the system is linked or connected with 
outside world. 

 

For Example, The data or instruction such as Graphics, images or text is inserted in 
the computer system with the help of input devices as the data received from the input 
devices is in binary code, therefore, the data has to be primarily converted into human-
readable form after processing user get the required or desired data or set of 
information. 

The prime examples of Output devices are Printer, Monitor,Projectors etc 

 The output devices receives all the data or instruction in binary code. 

 The output devices converts the binary codes into human readable or intelligible 
form for better understanding and better functionality. 

 They produces the changed or converted result to the user .which is effectively 
comprehensible by humans for proper and accurate understanding. 

 They acts as a connection or link between outside world and computer system 
or our own PC framework. 

 Printers, monitors and projector's are the prime examples of output devices. 

 

https://www.chtips.com/computer-fundamentals/output-devices-of-computer-system
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Number Systems  Introduction to Binary:- 

Binary Number System:-  

The easiest way to vary instructions through electric signals is two-state system – on 
and off. On is represented as 1 and off as 0, though 0 is not actually no signal but 
signal at a lower voltage. The number system having just these two digits – 0 and 1 – 
is called binary number system. 

Each binary digit is also called a bit. Binary number system is also positional value 
system, where each digit has a value expressed in powers of 2, as displayed here. 

 

In any binary number, the rightmost digit is called least significant bit (LSB) and 
leftmost digit is called most significant bit (MSB). 

 

And decimal equivalent of this number is sum of product of each digit with its positional 
value. 

110102 = 1×24 + 1×23 + 0×22 + 1×21 + 0×20 

= 16 + 8 + 0 + 2 + 0 

= 2610 

Computer memory is measured in terms of how many bits it can store. Here is a chart 
for memory capacity conversion. 

 1 byte (B) = 8 bits 

 1 Kilobytes (KB) = 1024 bytes 

 1 Megabyte (MB) = 1024 KB 

 1 Gigabyte (GB) = 1024 MB 

 1 Terabyte (TB) = 1024 GB 

 1 Exabyte (EB) = 1024 PB 

 1 Zettabyte = 1024 EB 

 1 Yottabyte (YB) = 1024 ZB 

Octal Number System 
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Octal number system has eight digits – 0, 1, 2, 3, 4, 5, 6 and 7. Octal number system is 
also a positional value system with where each digit has its value expressed in powers 
of 8, as shown here – 

 

Decimal equivalent of any octal number is sum of product of each digit with its 
positional value. 

7268 = 7×82 + 2×81 + 6×80 

= 448 + 16 + 6 

= 47010 

 

Hexadecimal Number System 

Octal number system has 16 symbols – 0 to 9 and A to F where A is equal to 10, B is 
equal to 11 and so on till F. Hexadecimal number system is also a positional value 
system with where each digit has its value expressed in powers of 16, as shown here – 

 

Decimal equivalent of any hexadecimal number is sum of product of each digit with its 
positional value. 

27FB16 = 2×163 + 7×162 + 15×161 + 10×160 

= 8192 + 1792 + 240 +10 

= 1023410 

 

Conversion:- 

In our previous section, we learned different types of number systems such as binary, 

decimal, octal, and hexadecimal. In this part of the tutorial, we will learn how we can 
change a number from one number system to another number system. 

As, we have four types of number systems so each one can be converted into the remaining 

three systems. There are the following conversions possible in Number System 

1. Binary to other Number Systems. 

2. Decimal to other Number Systems. 
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3. Octal to other Number Systems. 

4. Hexadecimal to other Number Systems. 

 

Binary to other Number Systems 

There are three conversions possible for binary number, i.e., binary to decimal, binary to 
octal, and binary to hexadecimal. The conversion process of a binary number to decimal 
differs from the remaining others. Let's take a detailed discussion on Binary Number 
System conversion. 

Binary to Decimal Conversion 

The process of converting binary to decimal is quite simple. The process starts from 
multiplying the bits of binary number with its corresponding positional weights. And 
lastly, we add all those products. 

Simple Addition 

Binary addition is one of the binary operations. To recall, the term ―Binary Operation‖ 
represents the basic operations of mathematics that are performed on two operands. 
Basic arithmetic operations like addition, subtraction, multiplication, and division, play an 
important role in mathematics. In this lesson, all the concepts about binary addition are 
explained, which includes: 

 Definition 

 Rules 

https://byjus.com/maths/arithmetic-operations/
https://byjus.com/#definition
https://byjus.com/#rules
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 Method 

 table 

 Examples 

 Using 1‘s complement 

What is Binary Addition 

The binary addition operation works similarly to the base 10 decimal system, except that 
it is a base 2 system. The binary system consists of only two digits, 1 and 0. Most of the 
functionalities of the computer system use the binary number system. The binary code 
uses the digits 1‘s and 0‘s to make certain processes turn off or on. The process of the 
addition operation is very familiar to the decimal system by adjusting to the base 2. 

Before attempting the binary addition process, we should have complete knowledge of 
how the place works in the binary number system. Because most of the modern digital 
computers and electronic circuits perform the binary operation by representing each bit 
as a voltage signal. The bit 0 represents the ―OFF‖ state, and the bit 1 represents the 
―ON‖ state. 

Rules of Binary Addition 

Binary addition is much easier than the decimal addition when you remember the 
following tricks or rules. Using these rules, any binary number can be easily added. The 
four rules of binary addition are: 

 0 + 0 = 0 

 0 + 1 = 1 

 1 + 0 = 1 

 1 + 1 =10 

 

Subtraction 

Subtraction is an arithmetic operation that represents the operation of removing objects 
from a collection. The result of a subtraction is called a difference. Subtraction is 

signified by the minus sign, − . For example, in the adjacent picture, there are 5 − 

2 apples—meaning 5 apples with 2 taken away, resulting in a total of 3 apples. 
Therefore, the difference of 5 and 2 is 3, that is, 5 − 2 = 3. While primarily associated 
with natural numbers in arithmetic, subtraction can also represent removing or 
decreasing physical and abstract quantities using different kinds of objects 
including negative numbers, fractions, irrational numbers, vectors, decimals, functions, 
and matrices.  

Subtraction follows several important patterns. It is anticommutative, meaning that 
changing the order changes the sign of the answer. It is also not associative, meaning 
that when one subtracts more than two numbers, the order in which subtraction is 
performed matters. Because 0 is the additive identity, subtraction of it does not change 

https://byjus.com/#method
https://byjus.com/#table
https://byjus.com/#examples
https://byjus.com/#using-1's-complement
https://byjus.com/maths/binary-operation/
https://en.wikipedia.org/wiki/Arithmetic_operation
https://en.wikipedia.org/wiki/Minus_sign
https://en.wikipedia.org/wiki/Arithmetic
https://en.wikipedia.org/wiki/Negative_number
https://en.wikipedia.org/wiki/Fraction_(mathematics)
https://en.wikipedia.org/wiki/Irrational_number
https://en.wikipedia.org/wiki/Euclidean_vector
https://en.wikipedia.org/wiki/Anticommutative
https://en.wikipedia.org/wiki/Associativity
https://en.wikipedia.org/wiki/0_(number)
https://en.wikipedia.org/wiki/Additive_identity
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a number. Subtraction also obeys predictable rules concerning related operations, such 
as addition and multiplication. All of these rules can be proven, starting with the 
subtraction of integers and generalizing up through the real numbers and beyond. 
General binary operations that follow these patterns are studied in abstract algebra. 

Performing subtraction on natural numbers is one of the simplest numerical tasks. 
Subtraction of very small numbers is accessible to young children. In primary 
education for instance, students are taught to subtract numbers in the decimal system, 
starting with single digits and progressively tackling more difficult problems. 

In advanced algebra and in computer algebra, an expression involving subtraction 
like A − B is generally treated as a shorthand notation for the addition A + (−B). 
Thus, A − B contains two terms, namely A and −B. This allows an easier use 
of associativity and commutativity. 

 

Multiplication 

A multiplication algorithm is an algorithm (or method) to multiply two numbers. Depending on the 
size of the numbers, different algorithms are used. Efficient multiplication algorithms have existed 
since the advent of the decimal system. 

Grid method 

The grid method (or box method) is an introductory method for multiple-digit 
multiplication that is often taught to pupils at primary school or elementary school. It has 
been a standard part of the national primary school mathematics curriculum in England 
and Wales since the late 1990s.[1] 

Both factors are broken up ("partitioned") into their hundreds, tens and units parts, and 
the products of the parts are then calculated explicitly in a relatively simple 
multiplication-only stage, before these contributions are then totalled to give the final 
answer in a separate addition stage. 

The calculation 34 × 13, for example, could be computed using the grid: 

 

/ 30 4 

10 300 40 

3 90 12 

 

followed by addition to obtain 442, either in a single sum (see right), or through forming 
the row-by-row totals (300 + 40) + (90 + 12) = 340 + 102 = 442. 

This calculation approach (though not necessarily with the explicit grid arrangement) is 
also known as the partial products algorithm. Its essence is the calculation of the simple 
multiplications separately, with all addition being left to the final gathering-up stage. 

The grid method can in principle be applied to factors of any size, although the number 
of sub-products becomes cumbersome as the number of digits increases. Nevertheless, 
it is seen as a usefully explicit method to introduce the idea of multiple-digit 

https://en.wikipedia.org/wiki/Addition
https://en.wikipedia.org/wiki/Multiplication
https://en.wikipedia.org/wiki/Mathematical_proof
https://en.wikipedia.org/wiki/Integers
https://en.wikipedia.org/wiki/Real_number
https://en.wikipedia.org/wiki/Binary_operations
https://en.wikipedia.org/wiki/Abstract_algebra
https://en.wikipedia.org/wiki/Primary_education
https://en.wikipedia.org/wiki/Primary_education
https://en.wikipedia.org/wiki/Decimal
https://en.wikipedia.org/wiki/Computer_algebra
https://en.wikipedia.org/wiki/Associativity
https://en.wikipedia.org/wiki/Commutativity
https://en.wikipedia.org/wiki/Algorithm
https://en.wikipedia.org/wiki/Multiplication
https://en.wikipedia.org/wiki/Grid_method_multiplication
https://en.wikipedia.org/wiki/Primary_school
https://en.wikipedia.org/wiki/Elementary_school
https://en.wikipedia.org/wiki/Multiplication_algorithm#cite_note-1
https://en.wikipedia.org/wiki/Partial_products_algorithm
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multiplications; and, in an age when most multiplication calculations are done using a 
calculator or a spreadsheet, it may in practice be the only multiplication algorithm that 
some students will ever need. 

 

Long multiplication 

If a positional numeral system is used, a natural way of multiplying numbers is taught in 
schools as long multiplication, sometimes called grade-school multiplication, sometimes 
called Standard Algorithm: multiply the multiplicand by each digit of the multiplier and 
then add up all the properly shifted results. It requires memorization of the multiplication 
table for single digits. 

This is the usual algorithm for multiplying larger numbers by hand in base 10. 
Computers initially used a very similar shift and add algorithm in base 2, but modern 
processors have optimized circuitry for fast multiplications using more efficient 
algorithms, at the price of a more complex hardware realization. A person doing long 
multiplication on paper will write down all the products and then add them together; 
an abacus-user will sum the products as soon as each one is computed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://en.wikipedia.org/wiki/Numeral_system
https://en.wiktionary.org/wiki/multiplicand
https://en.wiktionary.org/wiki/multiplier
https://en.wikipedia.org/wiki/Multiplication_table
https://en.wikipedia.org/wiki/Multiplication_table
https://en.wikipedia.org/wiki/Multiplication_algorithm#Shift_and_add
https://en.wikipedia.org/wiki/Abacus
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UNIT-II 

Algorithm and Flowcharts 
Algorithm 

Definition:-  

An algorithm is set of instructions for solving a problem or accomplishing a task. One 
common example of an algorithm is a recipe, which consists of specific instructions for 
preparing a dish/meal. Every computerized device uses algorithms to perform 
its functions. 

 An algorithm is set of instructions for solving a problem or accomplishing a task. 
Every computerized device uses algorithms to perform its functions. 
 

 Algo trading, also known as automated trading or black-box trading, uses a 
computer program to buy or sell securities at a pace not possible for humans. 
Since prices of stocks, bonds, and commodities appear in various formats online 
and in trading data, the process by which an algorithm digests scores of financial 
data becomes easy. 
 

 Computer algorithms make life easier by trimming the time it takes to manually 
do things. In the world of automation, algorithms allow workers to be more 
proficient and focused. Algorithms make slow processes more proficient. In many 
cases, especially in automation, algos save companies money. 

 
How an Algorithm Works 
 
Financial companies use algorithms in areas such as loan pricing, stock trading, asset-
liability management, and many automated functions. For example, algorithmic trading, 
known as "algo" trading, is used for deciding the timing, pricing, and quantity of stock 
orders. Algo trading, also known as automated trading or black-box trading, uses a 
computer program to buy or sell securities at a pace not possible for humans. 

Since prices of stocks, bonds, and commodities appear in various formats online and in 
trading data, the process by which an algorithm digests scores of financial data 
becomes easy. The user of the program simply sets the parameters and gets the 
desired output when securities meet the trader's criteria. 

Computer algorithms make life easier by trimming the time it takes to manually do 
things. In the world of automation, algorithms allow workers to be more proficient and 
focused. Algorithms make slow processes more proficient. In many cases, especially in 
automation, algos save companies money. 

 
 

https://www.investopedia.com/terms/a/algorithmictrading.asp
https://www.investopedia.com/terms/t/trader.asp
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Types of Algos 
 
Several types of trading algorithms help investors decide whether to buy or sell. A mean 
reversion algorithm examines short-term prices over the long-term average price, and if 
a stock goes much higher than the average, a trader may sell it for a quick profit. 
Seasonality refers to the practice of traders buying and selling securities based on the 
time of year when markets typically rise or fall. A sentiment analysis algorithm gauges 
news about a stock price that could lead to higher volume for a trading period. 

Algorithm Example 
 
The following is an example of an algorithm for trading. A trader creates instructions 
within his automated account to sell 100 shares of a stock if the 50-day moving 
average goes below the 200-day moving average. 

Contrarily, the trader could create instructions to buy 100 shares if the 50-day moving 
average of a stock rises above the 200-day moving average. Sophisticated algorithms 
consider hundreds of criteria before buying or selling securities. Computers quickly 
synthesize the automated account's instructions to produce the desired results. Without 
computers, complex trading would be time-consuming and likely impossible. 

Algorithms in Computer Science 
 
In computer science, a programmer must employ five basic parts of an algorithm to 
create a successful program. 

First, he/she describes the problem in mathematical terms before creating the formulas 
and processes that create results. Next, the programmer inputs the outcome 
parameters, and then he/she executes the program repeatedly to test its accuracy. The 
conclusion of the algorithm is the result given after the parameters go through the set of 
instructions in the program. 

For financial algorithms, the more complex the program, the more data the software can 
use to make accurate assessments to buy or sell securities. Programmers test complex 
algorithms thoroughly to ensure the programs are without errors. Many algorithms can 
be used for one problem; however, there are some that simplify the process better than 
others.  

 

 

 

 

https://www.investopedia.com/terms/m/meanreversion.asp
https://www.investopedia.com/terms/m/meanreversion.asp
https://www.investopedia.com/terms/a/averageprice.asp
https://www.investopedia.com/terms/m/movingaverage.asp
https://www.investopedia.com/terms/m/movingaverage.asp
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Characteristics 

Basic characteristics about computer are: 

 

 

1. Speed: – As you know computer can work very fast. It takes only few seconds for 
calculations that we take hours to complete. You will be surprised to know 
that computer can perform millions (1,000,000) of instructions and even more per 
second. 

Therefore, we determine the speed of computer in terms of microsecond (10-6 part of a 
second) or nanosecond (10 to the power -9 part of a second). From this you can 
imagine how fast your computer performs work. 
 

2. Accuracy: – The degree of accuracy of computer is very high and every calculation 
is performed with the same accuracy. The accuracy level is 7. determined on the basis 
of design of computer. The errors in computer are due to human and inaccurate data. 

3. Diligence: – A computer is free from tiredness, lack of concentration, fatigue, etc. It 
can work for hours without creating any error. If millions of calculations are to be 
performed, a computer will perform every calculation with the same accuracy. Due to 
this capability it overpowers human being in routine type of work. 
 

https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
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4. Versatility: – It means the capacity to perform completely different type of work. You 
may use your computer to prepare payroll slips. Next moment you may use it for 
inventory management or to prepare electric bills. 

5. Power of Remembering: – Computer has the power of storing any amount 
of information or data. Any information can be stored and recalled as long as you 
require it, for any numbers of years. It depends entirely upon you how much data you 
want to store in a computer and when to lose or retrieve these data. 

6. No IQ: – Computer is a dumb machine and it cannot do any work without instruction 
from the user. It performs the instructions at tremendous speed and with accuracy. It is 
you to decide what you want to do and in what sequence. So a computer cannot take 
its own decision as you can.  

7. No Feeling: – It does not have feelings or emotion, taste, knowledge and 
experience. Thus it does not get tired even after long hours of work. It does not 
distinguish between users. 

8. Storage: – The Computer has an in-built memory where it can store a large amount 
of data. You can also store data in secondary storage devices such as floppies, which 
can be kept outside your computer and can be carried to other computers. 

 

Advantages and disadvantages 

The invention of the computer is considered to be one of the greatest inventions of all 
time. The modern computer has changed our daily life to some extent. A computer is 
an integral part of human beings and we can not imagine our lives without the use of a 
computer. 

As there are two sides of the coins there are advantages and disadvantages of 
computer system in points which we are going to discuss in detail. 

We will focus on each and every topic briefly. The computer has reached to every 
section of human society, from schools to hospitals business organizations, institutions 
everywhere we cannot imagine our daily life without the use of computers. 

The impact of computers on humans is beyond imagination, people use a computer for 
selling and purchasing goods, online studies (E-Learning ) for searching virtually 
anything on the web, playing games, watching movies, downloading software's, for 
business promotions, railways, and airplanes tickets, etc almost everything can be 
done with the help of computer and the output can be obtained with just a few clicks. 

Their uses and study of computers are mandatory for students because of its 
worldwide use and acceptance. 

The computers have made a vital impact on education, students can learn online, and 
get the required skills and knowledge just sitting at home, the computers have made 
the distance virtually zero. 

https://ecomputernotes.com/fundamental/information-technology/what-do-you-mean-by-data-and-information
https://ecomputernotes.com/fundamental/information-technology/what-do-you-mean-by-data-and-information
https://ecomputernotes.com/computernetworkingnotes/computer-network/what-is-a-difference-client-computer-and-workstation-and-dumb-terminals
https://ecomputernotes.com/fundamental/input-output-and-memory/memory
https://ecomputernotes.com/fundamental/input-output-and-memory/explain-secondary-storage-devices
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Students are getting a higher education, certificates, and degrees from the reputed 
institutes before they just dreamed of it computer has made their dreams into reality. 

They even had made a significant impact in business, now businessman prefers to use 
a computer to a huge extent they have made their business life so peaceful that now 
they can perform multitasking, with almost 100% accuracy, The advantages of 
computer in research has made the scientist to solve complex to complex problems 
with ease before would take longs hours or even months to solve. 

As there are 2 sides of coins there are Advantages and Disadvantages of 
computers :: 

 Speed 

 Accuracy 

 Stores Huge Amount of Data 

 Online Trading 

 Online Education | Distance Learning 

 Research 

 Forecasting Weather,and Predicting Earthquakes ,Volcano Eruptions 

 Produce Employment 

 Internet 

 In Business 

Speed 
 
The speed of computer has made a vital impact on human society before some 
decades computer were just used for the purpose of some numerical calculations, but 
nowadays computers are used in virtually every single part of human life. 

The modern computer is not just a calculating device anymore with their speed and 
accuracy it can perform multiple tasks, operations, and complex numerical problems 
within fractions of second. They can perform about Trillions of instruction per second. 

People can play songs, perform their documentation work, surf the internet, check 
emails, search for your requirements on the internet with great speed and accuracy. 

The speed is considered as the biggest advantage of computers because it can perform 
all operations with an incredible speed which can reduce the amount of time spend 
when working manually. 
 
For Example : It can calculate the salaries of Employees within a fraction of seconds 
before it would take long hours when done manually by people. 

Accuracy 
 
Not only speed but a computer can work with almost 100% accuracy. This is also one of 
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its advantages, as it can perform complex numerical calculations not only with speed 
but with unbelievable accuracy.. 

Imagine you have given a task to calculate the gross salary of ten thousand employees 
with reduction as per the rules and regulations of the organization. That‘s not a simple 
task to calculate the given salaries manually, you are bound to make mistakes and even 
a small mistake can harm you badly economically. 

And now here comes the magic of computers it can perform all the hard work of 
calculating the salaries of the employees and deduction as per the requirements. You 
can derive the results at your fingertips within a fraction of seconds when given correct 
and proper input, with great speed and incredible accuracy. 

Hence the big organizations with hundreds of employees working for them use 
computer-generated bills and payslips. Even in the Government sector, all the manual 
calculations had been shifted to computers. 

Stores Huge Amount of Data 
 
Data storing capabilities of computers these days are ―HUGE‖ as compared to previous 
years. They can save or store any volume of data or instruction given to them 
permanently. 

Users can recall the data or instructions or information given to them anytime & any 
place. 

The Storing capability of computer is measured in MB (Mega-Bytes), GB (Giga-Bytes), 
TB (Tera-Bytes) Railways use modern computer for storing their passenger details, 
route of trains and even their employee's details. India has a population of around 125 
cr people, 93% of them have received their aadhaar card issued by the Government of 
India. 

Online Trading 
 
People tend to use computer and internet while purchasing and selling their goods, 
according to a recent survey more than 50% of people across the world will use 
computers for their online trading. 

Online trading is very simple and time saving, you have a variety of products to choose 
with the best prices, many websites offer their users a heavy discount. People are more 
inclined toward online shopping and trading these days due to their simplicity in use. 

 

 

 

Examples Flowchart: 
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Definition 

A flowchart is simply a graphical representation of steps. It shows steps in sequential 
order and is widely used in presenting the flow of algorithms, workflow or processes. 
Typically, a flowchart shows the steps as boxes of various kinds, and their order by 
connecting them with arrows. 

 

 

What is a Flowchart? 

A flowchart is a graphical representations of steps. It was originated from computer 

science as a tool for representing algorithms and programming logic but had extended 

to use in all other kinds of processes. Nowadays, flowcharts play an extremely 

important role in displaying information and assisting reasoning. They help us 

visualize complex processes, or make explicit the structure of problems and tasks. A 

flowchart can also be used to define a process or project to be implemented. 
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Define symbols of flowchart 

Different flowchart shapes have different conventional meanings. The meanings of 

some of the more common shapes are as follows: 
 

Terminator 

The terminator symbol represents the starting or ending point of the system. 

                                   Start/End Symbol 

 

                                       Action or Process Symbol 

 

                                    Document Symbol 
 

                                       Multiple Documents Symbol 
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            Preparation Symbol 

 

 Connector Symbol 

 

 Or Symbol 

 

                         Summoning Junction Symbol 
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Advantages and disadvantages 

A flowchart is actually a graphical representation of a computer program in relation to its 

sequence of functions. Which will help the programmer to draw out the basic build block 

and working mechanism of the program or the system? 

In the flowchart, we generally use geometric symbols like a rectangle, oval shapes and 

arrows to define the relationships. In simple terms, it will explain the start and end of the 

program. 

Advantages of Flowchart 

1. It is a convenient method of communication. 

2. It indicates very clearly just what is being done, where a program has logical 

complexities. 

3. A key to correct programming. 

4. It is an important tool for planning and designing a new system. 

5. It clearly indicates the role-played at each level. 

6. It saves the inconveniences in future and serves the purpose of documentation 

for a system. 

7. It provides an overview of the system and also demonstrates the relationship 

between various steps. 

8. Facilitates troubleshooting. 

9. It promotes logical accuracy. 

10. It makes sure that no logical path is left incomplete without any action being 

taken. 

Disadvantages of Flowchart 

1. The flowchart is a waste of time and slows down the process of software 

development. 

2. The flowchart is quite costly to produce and difficult to use and manage. 

3. Flowcharts are not meant for man to computer communication. 

4. Sometimes the Complex logic of the program logic is quite complicated to draw 

out on by using different defined shapes. In that case, flowchart becomes 
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complex and clumsy. This will become a pain for the user, resulting in a waste of 

time and money trying to correct the problem 

5. If you need to modify or alternate the process then it will be very hard to do in the 

flowchart. Because either you will have to erase the end of the flowchart or start. 

 
 

Flowchart Advantages 

 
 Flowcharts are easier to understand compare to Algorithms and Pseudo code. 

 It helps us to understand Logic of given problem. 

 It is very easy to draw flowchart in any word processing software like MS Word. 

 Using only very few symbol, complex problem can be represented in flowchart. 

 Software like RAPTOR can be used to check correctness of flowchart drawn   
           in computers. 

 Flowcharts are one of the good way of documenting programs. 

 It helps us in debugging process.  

 
Flowchart Disadvantages 
 
 Manual tracing is needed to check correctness of flowchart drawn on paper. 

 Simple modification in problem logic may leads to complete redraw of flowchart. 

 Showing many branches and looping in flowchart is difficult. 

 In case of complex program/algorithm, flowchart becomes very complex and  
           clumsy. 

 Modification of flowchart is sometimes time consuming. 

 

Examples 
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UNIT-III 

Operating System and Services in O.S. 

 

Dos – History 

MS-DOS (shorthand for Microsoft Disk Operating System) is a single tasking, single 
user, non-graphical command line operating system. Originally developed for use 
with IBM's earliest line of personal home computers, MS-DOS is one of the most 
successful operating systems of its kind. As an operating system, DOS is simple, 
compact, and remarkably robust; especially considering its age. While it may have 
been surpassed by the newer, and more user friendly, graphical user interface 
(GUI) operating systems, MS-DOS remains in widespread use by businesses and 
independent programmers throughout the world. 

A History of MS-DOS 

The origins of MS-DOS can be traced back to two earlier operating systems, CP/M 
and QDOS. CP/M (AKA Control Program for Microcomputers) was created in the 
mid 1970s by Gary Kildall of Digital Research. CP/M was an 8-bit operating system, 
and was one of the first to be widely used in the emerging line of commercial 
microcomputers. In 1980, Tom Paterson of Seattle Computer Products developed 
QDOS (Quick and Dirty Operating System) for Intel's new 16-bit 8086 central 
processing unit(CPU). QDOS was largely based on CP/M, and it is here that 
Microsoft entered the picture. 

In 1981 Microsoft purchased QDOS from Seattle Computer Products, renaming it 
MS-DOS 1.0 and offering it to IBM for use in their new personal computers. In a 
prescient move, Gates retained the licensing for MS-DOS and it would become the 
most important factor in Microsoft's move from a simple vendor of computer 
programming languages to a giant in the computer software industry. The success 
of MS-DOS directly paralleled the growing popularity of the personal home 
computer, and remained Microsoft's most significant source of income even after 
the firm began to introduce its own GUI in the form of MS-Windows. 

The Evolution of an Operating System 

In many ways MS-DOS laid the groundwork for Microsoft's ongoing success, and 
over the years it remained a focus for research and development. From 1981 
through to 1997 it would undergo several revisions and enhancements, resulting in 
a number of different iterations. Each new version of MS-DOS built upon its 
predecessor, evolving to meet the demands of lay-users and professional 
programmers alike. 
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The earliest revisions of MS-DOS addressed the need for larger hard disk drives, 
with support for multiple directories, networks, and foreign and extended characters. 
Later iterations would bring support for multiple HDD partitions, disk compression 
and fragmentation, enhanced memory management, and improvements in the 
operating system's text editing functions. The final versions, MS-DOS 7.0 and 7.1, 
were revised for close integration with Microsoft's newest operating system 
Windows 95. MS-DOS 7 eliminated a number of redundant utilities which were 
included in the Windows 95 OS, and brought in support for long filenames and the 
FAT32 file system. 

Microsoft no longer uses MS-DOS in any of its iterations in their primary operating 
systems, though both Windows 2000 and Windows XP do contain an emulation 
layer which allows for the running of MS-DOS programs, thereby providing 
backward compatibility with legacy-styled software. 

Clones and Imitations 

Over the years the success of MS-DOS has inspired a number of imitators, and 
many so-called 'clones' of the operating system have been launched by 
independent software developers and computer enthusiasts. Some of the more 
notable imitators include DR-DOS, OpenDOS, and FreeDOS. Many of the systems 
were developed and released as a direct response to Microsoft's announcement 
that they were halting further development of MS-DOS and would no longer be 
supporting the system with regular updates and revisions. 

The most successful of these clones has been FreeDOS. Developed by Jim Hall in 
1994, FreeDOS is lean and robust and offers some improvements over its parent 
operating system. It can run on legacy hardware and embedded systems, and 
includes several additions to the command structure not found in MS-DOS itself. 

The Future of MS-DOS 

While the last iteration of MS-DOS was released in 1997, the operating system itself 
still forms a large part of the modern computing landscape. Many businesses and 
independent programmers still rely on DOS for many embedded applications. DOS 
survives, in no small part, because it is a highly compact and eff icient operating 
system that performs well with a minimum of required maintenance. With the 
ongoing advances in hardware (specifically larger memories and faster CPUs) MS-
DOS and its clones still have much to offer. Moreover, developments by hobbyists 
and independent programmers like Jim Hall are introducing new and improved 
utilities and applications to the system despite Microsoft's own disinterest.  
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Online Tutorials 

MS-DOS has a fairly long history, and as such there is plenty of reference material 
available to anyone interested in learning more about the operating system and its 
many applications. Online tutorials offer a good starting point, and can provide 
insight into the development of DOS and its value and use as an operating system. 

 An Inside Look at MS-DOS: from the Paterson Technology website, this article presents 
an overview of the fundamentals of MS-DOS. The website itself also offers a history of 
MS-DOS, its developmental roots, and a selection of archived manuals. There is also a 
short bio of Tim Paterson, the creator of QDOS and Paterson Technology's owner and 
managing director. 

 MS-DOS Literacy — an Introduction to MS-DOS: from Silicon Mountain and Aames 
Production comes a video tutorial aimed at the early PC home market. Published in 
1992, this tutorial looks more than a little dated. However, the fundamentals are 
presented in an easy to understand and interactive manner that makes this a 
surprisingly effective learning tool, particularly for the novice. 

 Learning MS-DOS Basics — a Tutorial (PDF): This document was prepared by the staff 
at the University of North Carolina Wilmington, and it offers a comprehensive 
introduction to basic MS-DOS commands. This easy to understand tutorial covers 
command prompts, managing directories, managing files, and formatting floppy disks. 

 Using DOS Commands with MS-DOS 6.22: Que Publishing provides this extensive 
guide to using DOS, specifically the 6.22 iteration. Topics include "Understanding the 
Elements of DOS Commands," "Issuing DOS Commands," and "Troubleshooting 
Program Files." Best suited to someone with a basic working knowledge of MS-DOS. 

Books 

Many books have been written on the subject of MS-DOS and its various iterations. 
Some have been aimed at the mass market, acting as basic instruction manuals for 
first time programmers. Others have been more technical in their approach, 
appealing mostly to the professional programmer and the more experienced 
computer enthusiast. 

 DOS for Dummies by Dan Gookin: one of the more popular books on MS-DOS and one 
of the most successful of the "Dummies" franchise. This book is specifically targeted to 
a mass audience, and as such is mostly suitable for beginners. There is also a follow-
up, More DOS for Dummies, which goes into a bit more detail than the original. 

 Running MS-DOS, the 20th Anniversary Edition by Van Wolverton: the original Running 
MS-DOS became a best seller, and this anniversary edition expands upon earlier 
editions with updated material. Special emphasis is given to MS-DOS 6.22 (the latest 
iteration upon time of publication). The book is informative and easy to understand, 
making it suitable for both beginners and experienced programmers. 

 Using MS-DOS 6.22 (3rd Edition) by Jim Cooper: this is one of the most extensive 
guides to MS-DOS, and also one of the most highly regarded. The 3rd edition brings 
things up to date, with an emphasis on the latest iteration (6.22 at time of publication) of 

http://www.patersontech.com/dos/byte-inside-look.aspx
https://www.youtube.com/watch?v=QozAzYol9-Y
http://people.uncw.edu/pattersone/121/labs/L1_MSDOS_Primer.pdf
http://www.quepublishing.com/articles/article.aspx?p=131120
https://www.amazon.com/DOS-Dummies-Dan-Gookin/dp/0764503618/ref=sr_1_6
https://www.amazon.com/More-DOS-Dummies-Computers/dp/1568840462/ref=pd_sim_14_3
https://www.amazon.com/Running-MS-DOS-20th-Anniversary-Wolverton/dp/0735618127/ref=sr_1_3
https://www.amazon.com/Special-Using-MS-DOS-6-22-3rd/dp/0789725738/ref=sr_1_1
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the DOS operating system. Cooper covers all aspects of MS-DOS, including its history 
and development. Ideal for experienced programmers and serious hobbyists. 

 DOS: The Complete Reference (4th Edition) by Kris Jamsa: this book is not so much an 
introduction to DOS as it is a reference guide for those with some working knowledge of 
the operating system. The work itself is forthright and easy to understand, but is 
perhaps best suited to readers with some experience of DOS who need to refresh their 
skills. 

 Advanced MS-DOS Programming: The Microsoft Guide for Assembly Language and C 
Programmers by Ray Duncan: this book targeted the professional programmer circa 
1988. More than a 'how-to' guide, this is an in-depth look at MS-DOS as a programming 
environment, including best uses and applications. Not for the novice or inexperienced 
hobbyist. 

Summary 

Technically, MS-DOS has been retired and Microsoft has made it clear their will be 
no more iterations or updates to the operating system. But MS-DOS still has a place 
in the computing landscape, even beyond its attraction to hobbyists and niche 
programmers. MS-DOS continues to be used around the world, and is responsible 
for many of the embedded applications that we all take for granted. MS-DOS may 
not be the vital operating system that it once was, but it still has merit and deserves 
the attention of serious programmers. 

 

MS-DOS (Microsoft Disk Operating System) is a single-user, single-
tasking computer operating system that uses a command line interface. In spite of its 
very small size and relative simplicity, it is one of the most successful operating systems 
that has been developed to date. 

 
A Quick and Dirty History 

When IBM launched its revolutionary personal computer, the IBM PC, in August 1981, it 
came complete with a 16-bit operating system from Microsoft, MS-DOS 1.0. This was 
Microsoft's first operating system, and it also became the first widely used operating 
system for the IBM PC and its clones. 

MS-DOS 1.0 was actually a renamed version of QDOS (Quick and Dirty Operating 
System), which Microsoft bought from a Seattle company, appropriately named Seattle 
Computer Products, in July 1981. QDOS had been developed as a clone of the CP/M 
eight-bit operating system in order to provide compatibility with the popular business 
applications of the day such as WordStar and dBase. CP/M (Control Program for 
Microcomputers) was written by Gary Kildall of Digital Research several years earlier 
and had become the first operating system for microcomputers in general use. 

https://www.amazon.com/DOS-Complete-Reference-Kris-Jamsa/dp/0078819040
https://www.amazon.com/Advanced-MS-DOS-Programming-Microsoft-Programmers/dp/1556151578
https://www.amazon.com/Advanced-MS-DOS-Programming-Microsoft-Programmers/dp/1556151578
http://www.linfo.org/computer.html
http://www.linfo.org/operating_system.html
http://www.linfo.org/command_line.html
http://www.linfo.org/interface.html
http://www.linfo.org/bit.html
http://www.linfo.org/clone.html
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QDOS was written by Tim Paterson, a Seattle Computer Products employee, for the 
new Intel 16-bit 8086 CPU (central processing unit), and the first version was shipped in 
August, 1980. Although it was completed in a mere six weeks, QDOS was sufficiently 
different from CP/M to be considered legal. Paterson was later hired by Microsoft. 

Microsoft initially kept the IBM deal a secret from Seattle Computer Products. And in 
what was to become another extremely fortuitous move, Bill Gates, the not 
uncontroversial co-founder of Microsoft, persuaded IBM to let his company retain 
marketing rights for the operating system separately from the IBM PC project. Microsoft 
renamed it PC-DOS (the IBM version) and MS-DOS (the Microsoft version). The two 
versions were initially nearly identical, but they eventually diverged. 

The acronym DOS was not new even then. It had originally been used by IBM in the 
1960s in the name of an operating system (i.e., DOS/360) for its System/360 computer. 
At that time the use of disks for storing the operating system and data was considered 
cutting edge technology. 

Until its acquisition of QDOS, Microsoft had been mainly a vendor of computer 
programming languages. Gates and co-founder Paul Allen had written Microsoft BASIC 
and were selling it on disks and tape mostly to PC hobbyists. 

MS-DOS soared in popularity with the surge in the PC market. Revenue from its sales 
fueled Microsoft's phenomenal growth, and MS-DOS was the key to company's rapid 
emergence as the dominant firm in the software industry. This product continued to be 
the largest single contributor to Microsoft's income well after it had become more 
famous for Windows. 

Subsequent versions of MS-DOS featured improved performance and additional 
functions, not a few of which were copied from other operating systems. For example, 
version 1.25, released in 1982, added support for double-sided disks, thereby 
eliminating the need to manually turn the disks over to access the reverse side. 

Version 2.0, released the next year, added support for directories, for IBM's then huge 
10MB hard disk drive (HDD) and for 360KB, 5.25-inch floppy disks. This was followed 
by version 2.11 later in the same year, which added support for foreign and 
extended characters. 

Version 3.0, launched in 1984, added support for 1.2MB floppy disks and 32MB HDDs. 
This was soon followed by version 3.1, which added support for networks. 

Additions and improvements in subsequent versions included support for multiple 
HDD partitions, for disk compression and for larger partitions as well as an improved 
disk-checking utility, enhanced memory management, a disk defragmenter and an 
improved text editor. 

http://www.linfo.org/cpu.html
http://www.linfo.org/acronym_list.html
http://www.linfo.org/storage.html
http://www.linfo.org/data.html
http://www.linfo.org/software.html
http://www.linfo.org/hdd.html
http://www.linfo.org/character.html
http://www.linfo.org/network.html
http://www.linfo.org/partition.html
http://www.linfo.org/data_compression.html
http://www.linfo.org/memory.html
http://www.linfo.org/text_editor.html
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The final major version was 7.0, which was released in 1995 as part of Microsoft 
Windows 95. It featured close integration with that operating system, including support 
for long filenames and the removal of numerous utilities, some of which were on the 
Windows 95 CDROM. It was revised in 1997 with version 7.1, which added support for 
the FAT32 filesystem on HDDs. 

Although many of the features were copied from UNIX, MS-DOS was never able to 
come anywhere close to UNIX in terms of performance or features. For example, MS-
DOS never became a serious multi-user or multitasking operating system (both of which 
were core features of UNIX right from the start) in spite of attempts to retrofit these 
capabilities. Multitasking is the ability for a computer to run two or 
more programs simultaneously. 

 
The Rise of the GUI 

The introduction of the Apple Macintosh in 1984 brought about a surge of interest 
in GUIs (graphical user interfaces), and it soon became apparent that they would 
eventually replace command line interfaces such as that used by MS-DOS. Although 
many MS-DOS application programs created their own primitive GUIs, this approach 
required duplication of programming effort, and the lack of a consistent GUI among 
programs made it more difficult for users to learn new programs. 

It took Microsoft years until it was able to offer a fairly high quality GUI of its own, with 
the introduction of Windows 95 in 1995 (or arguably with Windows 3.0 in 1990). 
Microsoft had also begun work on a joint project with IBM called OS/2, which was 
originally a protected-mode version of MS-DOS with a GUI, but Microsoft soon 
abandoned the project in order to devote more resources to the development of 
Windows NT, a completely new operating system that was independent of MS-DOS. 

Protected mode and real mode are the two modes of operation supported by the Intel 
x86 architecture. The former enables 32-bit memory addressing, thereby permitting use 
of the extended memory that cannot be easily accessed from real mode. This makes it 
possible to assign separate memory areas to the operating system kernel (i.e., the core 
of the operating system) and to each process (i.e., program or task), thus resulting in 
much more stable multitasking than can be attained with real mode. 

Early versions of Microsoft Windows ran under MS-DOS, whereas later versions were 
launched under MS-DOS but were then extended by going into protected mode. 
Windows NT and its successors, Windows 2000 and XP, do not use MS-DOS; however, 
they contain an emulation layer on which MS-DOS programs can be operated, mainly 
for backward compatibility with legacy (i.e., old) software. 

 
 

http://www.linfo.org/cdrom.html
http://www.linfo.org/filesystem.html
http://www.linfo.org/unix_upper.html
http://www.linfo.org/multitasking.html
http://www.linfo.org/program.html
http://www.linfo.org/gui.html
http://www.linfo.org/kernel.html
http://www.linfo.org/process.html
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DOS Commands 

MS-DOS has a relatively small number of commands, and an even smaller number of 
commonly used ones. Moreover, these commands are generally inflexible because, in 
contrast to Linux and other Unix-like operating systems, they are designed to 
accommodate few options or arguments (i.e., values that can be passed to the 
commands). 

Some of the most common commands are as follows (corresponding commands on 
Unix-like operating systems are shown in parenthesis): 

CD - changes the current directory (cd) 
COPY - copies a file (cp) 
DEL - deletes a file (rm) 
DIR - lists directory contents (ls) 
EDIT - starts an editor to create or edit plain text files (vi, vim, ed, joe) 
FORMAT - formats a disk to accept DOS files (mformat) 
HELP - displays information about a command (man, info) 
MKDIR - creates a new directory (mkdir) 
RD - removes a directory (rmdir) 
REN - renames a file (mv) 
TYPE - displays contents of a file on the screen (more, cat) 

 
Comparison between MS-DOS and Linux 

MS-DOS and Linux have much in common, primarily because MS-DOS copied many 
ideas from UNIX. However, there are some very fundamental differences, including: 

(1) Linux is a full-fledged multiuser, multitasking operating system, whereas MS-DOS is 
a single-user, single-tasking operating system. 

(2) MS-DOS does not have built-in security concepts such as file-ownership 
and permissions, which are fundamental to Linux. 

(3) Linux has an inverted tree-like filesystem in which all directories and files branch 
from a single directory, i.e., the root directory, and its subdirectories. MS-DOS can have 
multiple, independent root directories, such as A:, C:, D:, etc. 

(4) Linux uses forward slashes "/" to separate directories, whereas MS-DOS 
uses backslashes "\" for the same purpose. 

(5) Linux filenames can contain up to 255 characters. MS-DOS filenames are limited to 
an eight characters plus a three-character extension and have restrictions on allowable 
characters. Also, filenames are case-sensitive in Linux, whereas they are not in MS-
DOS. 

http://www.linfo.org/command.html
http://www.linfo.org/linuxdef.html
http://www.linfo.org/unix-like.html
http://www.linfo.org/option.html
http://www.linfo.org/argument.html
http://www.linfo.org/file.html
http://www.linfo.org/cp.html
http://www.linfo.org/rm.html
http://www.linfo.org/plain_text.html
http://www.linfo.org/vi/index.html
http://www.linfo.org/man.html
http://www.linfo.org/mkdir.html
http://www.linfo.org/rmdir.html
http://www.linfo.org/mv.html
http://www.linfo.org/cat.html
http://www.linfo.org/permissions.html
http://www.linfo.org/root_directory.html
http://www.linfo.org/forward_slash.html
http://www.linfo.org/backslash.html
http://www.linfo.org/file_name.html
http://www.linfo.org/filename_extension.html
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(6) Linux has a vastly richer command set than does MS-DOS, with a much greater 
number of commands and individual commands having greater power, flexibility and 
ease of use. Commands are case-sensitive in Linux, but they are not in MS-DOS. 

(7) Although Linux and MS-DOS both have pipes and input/output redirection, the MS-
DOS pipes use a completely different -- and inferior -- implementation. 

(8) MS-DOS is not sufficiently flexible and efficient to serve as a base for a high quality, 
general-purpose GUI (and thus it had to be abandoned by Microsoft). In sharp contrast, 
Linux is an excellent base for a GUI (and it is used as a base for the X Window System, 
which is extremely configurable and whose already excellent performance continues to 
improve). 

 
MS-DOS Clones and Emulators 

The great success of MS-DOS led to the development of several similar operating 
systems, including DR-DOS, FreeDOS, OpenDOS and PC-DOS. The most promising of 
these clones is FreeDOS, which is claimed to be the only free operating system that is 
fully compatible with MS-DOS. 

Development of FreeDOS was begun in 1994 by Jim Hall, then a physics student at the 
University of Wisconsin-River Falls. His motivation was Microsoft's announcement that it 
would stop supporting MS-DOS because of its impending replacement by Windows 95. 

Like MS-DOS, FreeDOS is lean and robust, and it can run on old hardware and 
in embedded systems. A major improvement as compared with MS-DOS is the addition 
of options to the commands. Moreover, FreeDOS is released under the GPL (although 
some software in the distribution is covered by other licenses), thus making it ideal for 
bundling a version of DOS into products without having to pay royalties. 

Because Linux was originally developed on PCs and at a time when MS-DOS was the 
dominant PC operating system, a variety of tools were developed to help developers 
and users bridge the gap between the two operating systems. Among them is dosemu, 
a DOS emulator which is included with Red Hat and other distributions and on which it 
is possible to run DOS programs. Emulators are also available for running DOS on 
other Unix-like operating systems, even on non-x86 processors. 

mtools is a collection of utilities that make it easy to access an MS-DOS floppy disk from 
Linux by merely inserting it into the floppy disk drive and without having to use 
any mounting commands (which can be tricky for inexperienced users). Included in 
mtools are more than 20 commands, all of which are identical to their MS-DOS 
counterparts except that the letter m is added to the start of each of their names and 
forward slashes are used instead of backslashes. For example, the MS-DOS 
command type a:\file1.txt to display the contents of a file named file1.txt that is located 
on a floppy disk would become mtype a:/file1.txt. 

http://www.linfo.org/pipes.html
http://www.linfo.org/redirection.html
http://www.linfo.org/x.html
http://www.linfo.org/robust.html
http://www.linfo.org/embedded_system.html
http://www.linfo.org/distributions_list.html
http://www.linfo.org/microprocessor.html
http://www.linfo.org/mounting.html
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Outlook For the Future 

Although it is widely believed that MS-DOS is an antiquated and useless operating 
system with few features and capabilities, this is far from correct. In fact, although not 
generally publicized, MS-DOS is still used today by numerous businesses and 
individuals around the world. A good analogy is the ancient programming language 
COBOL (introduced in 1960!), which is still in widespread use and, amazingly, accounts 
for roughly half of all the computer code still in existence. Both MS-DOS and COBOL 
have survived for so long because they are robust, relatively simple and continue to get 
the job done with a minimum of maintenance. 

In many cases, it was not MS-DOS itself that was the limiting factor in system 
performance; rather, it was the hardware, including small memories, slow CPUs and 
slow video cards. The capabilities of MS-DOS have, in fact, continued to increase even 
after Microsoft Windows became widespread. This is a result of continuing advances in 
the hardware and the introduction of new or improved utilities and applications. DOS as 
a whole is also being strengthened by the improvements that are being made to the 
MS-DOS clones, particularly FreeDOS. 

DOS will be around for many years into the future not only because of the continued 
existence of legacy applications but also because of the development of new 
applications. The main area of growth will most likely be simple embedded applications, 
for which DOS is eminently well suited because of its extremely small size, very reliable 
operation and zero cost (in the case of FreeDOS). 

DOS is so tiny, in fact, that it can fit on a single floppy disk and still leave sufficient room 
on the same disk for an embedded program and data files. Although there are many 
alternatives for embedded systems, including embedded Linux and Microsoft Windows 
CE, DOS can be the best choice if space is severely limited. Moreover, in contrast to 
FreeDOS, Windows CE has the disadvantages of not being free and having various 
licensing issues with which to contend. 

Files and Directories 

An understanding of files and directories is a necessity if you regularly use computers 

today.  You must become familiar with the techniques of creating, removing, and 

copying files and directories for your preferred operating system.  This brief tutorial will 

cover the Windows 95/NT family of operating systems.  

  

This primer is also intended for those switching to the Windows OS from another OS.  If 

this is the case, you can skip the first few paragraphs and jump here. 
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Introduction 

What is a File? 

Every document that you have saved on your hard drive is called a file.  Whenever you 

write a paper in a word processor and save it, you have just created a file.  Similarly, 

every Excel spreadsheet is a file.  So is every Access database.  So is every JPEG or 

GIF image.  So is every MP3 music song.  If you create a web page and call it 

‗my_resume.html‘, then you have just created a new file which must be stored on your 

hard drive, a floppy disk, or some other storage device on your computer.  

  

What is a Folder? 

Think of your disk drives as large filing cabinets. However, think of them as large filing 

cabinets that have no drawers and none of those manila folders inside.  Instead, 

whenever you have a paper or document you wish to file away, you just toss it directly 

into your large cabinet.  After a few hundred documents have been tossed 

haphhazardly inside the this cabinet, you would of course discover that finding any one 

document inside that large pile of papers is time-consuming and difficult.  Instead, what 

most of us do is to label a series of manila folders and then place them inside our file 

cabinet.  You might keep a folder dedicated to academic transcripts, another for tax 

papers, another for old poetry you‘ve written, and another to hold the warranties that 

came with your new PC. 

  

The same thing applies to your hard drive.  In Windows, a folder (also called a directory) 

is analogous to the yellow folders people use in filing cabinets.  You might create a 

folder on your drive called ―school_essays‖, and another called ―scanned_photos‖, and 

perhaps another called ―215_homework‖.   Over time you will come to accumulate a 

number of different folders, but you will be glad you did since finding and organizing 

your documents will be significantly easier.  

  

In fact, you will notice that there are already a large number of directories that have 

been created for you.  When a new program is installed on your machine, it will usually 

create one or more new folders in which to store the relevant files.  

 

 

https://condor.depaul.edu/ymendels/tutorials/directories/default.htm#disk_drive_def
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Windows Explorer 

So let‘s begin by examining the ways in which we can directly access files and 

directories in Windows. The two most common way for doing so is via ‗My Computer‘, 

represented by a or similar icon.  However, I highly recommend using Windows‘ 

Explorer.  Explorer gives you much more efficient control over your files and 

directories.  In fact, I‘d recommend placing a shortcut directly on your desktop.  (It is 

possible that one is already there).  

Create a shortcut for Explorer on the desktop 

1. Right-click on an empty part of the desktop.  (Right-click = click the right mouse 
button). 

2. Choose ―New‖, then ―Shortcut‖ 
3. Type ―explorer.exe‖ 
4. Windows will prompt you for a ―friendly‖ name.  Type ―Windows Explorer‖ or 

something similar.  
  

Now when you double-click (click twice rapidly) on the Explorer icon, you will see 

something similar (but not identical) to the following: 

Now as if often the case, much confusion arises from the plethora of options 

available.  With Explorer, there are several different views you can choose.  If your 

Explorer looks significantly different from mine, do the following: 

Change views in Explorer 

1. With Explorer open, click on ―Tools‖, then ―Folder Options‖ 
2. Look for the option that says something to the effect of ―Use Windows Classic 

Folders‖ and check it.  
  

Later on you may choose to use on of the other views, but in my opinion, the standard 

(―classic‖) view is the most efficient one.  

 What are all those + signs next to the folders? 

It is common to have folders inside of folders.  By clicking on the + sign, you can see the 

folders contained within the current folder.  For example, you may create a folder called 

‗School Papers‘.  Inside that folder you may have a few other folders containing 

documents pertaining to each course.  (For example, ‗Chemistry‘, ‗English‘, 

‗Biology‘).  Notice the + next to the ‗English‘ folder.  This tells you that that folder 

contains other folders.  

 

https://condor.depaul.edu/ymendels/tutorials/directories/default.htm#desktop_def
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PROPERTIES OF FILES AND DIRECTORIES 
 

On this page, we will look at the following features and concepts related to files and 
directories: 

 Files and directories 
 Naming practices 
 Paths 
 File types 
 Data size units 
 Managing file and folder views 

 
FILES AND DIRECTORIES 

A file refers to data stored on a hard drive or other storage media as a separate entity. 
For example, you would usually save a thesis or a slide presentation or a photograph as 
a file. Files typically have the following characteristics: 

 A file always has a name. 
 A file always takes up storage space. 
 A file is always saved in a certain format: a body of text is saved in one of the 

many text file formats, a photo in one of the many image file formats, etc. 
 A file contains information on when it was created and when it was last modified. 
 Files usually have access rights, especially if they are online. 

Files are saved on the user‘s own computer or in a remote location. 

A directory or folder is a place where files or other directories are saved. 
 

NAME 

Think carefully about how you name your files. Use descriptive file names so that even 
years later you will be able to recognize the contents of the file by its name. Avoid 
abbreviations and, instead, use whole words. For example, a file name like ―Cultural 
encounters‖ is better than ―Cult‖. 

The naming conventions for files and directories vary by operating system: in Windows, 
for example, the dot in the file name is usually followed by a file extension consisting of 
one or several characters that indicate the file type. In Linux, on the other hand, no 
extension is necessary. 
Depending on the system, it may not be possible to use certain special characters (: > / 
* ? ‖ > |) in the file name. In addition, using a space or Scandinavian umlauts (å, ä, ö) 
may sometimes cause problems, especially over the Internet. If you have trouble 
posting files online, try removing special characters from the name. 
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In Linux, the use of UPPER CASE and lower case letters in file names makes a 
difference; e.g. Ray.txt is different from ray.txt. In Windows, upper and lower case 
letters can be used more freely. 

PATHS 

A string of text that shows the location of a file or directory is called a Path. The path to 
a single file on the hard drive of your home computer (in Windows) can be e.g.: 
 

C:\Users\rkeskiva\Studies\Study diary.docx 

structure of the path depends on the operating system; you can read more about the 
path structure in, say, Linux in the additional reading section. 
 

FILE TYPES 

A file can contain different kinds of material: text, video and so forth. When the contents 
of a file are saved in a certain generally known format, it is called a file type. 
Photographs, for example, are often stored as JPEG image files, and word processing 
documents as DOCX or RTF document files. 
 
In Windows, the file type is evident from the file extension (usually consisting of three 
letters) that follows the dot in the file name. The file extension indicates the format in 
which the data in the file has been stored. 

FILE SIZE AND UNITS OF MEASUREMENT 

Understanding file sizes is very useful. Too big a file sent as e-mail may completely fill 
the recipient‘s mailbox or it may cause your message not to leave at all. Similarly, you 
may not be able to save several large files on a USB flash drive if you don‘t know how 
to estimate the total amount of space they need. 

Data is saved in binary form, i.e. as numbers consisting of ones and zeros. The 
smallest data storage unit – the bit (b) – can receive the value 1 or 0. When several bits 
are combined in a row, they form a byte (B). A byte may look like this, for example: 
―01011001‖. If you type the word ―data‖ on your computer, it consists of four bytes (each 
letter usually consists of one byte). 
 
The storage capacity is specified as the maximum number of bytes that the storage 
media can hold. The storage capacity is often so large that it is described as follows: 

 

https://blogs.helsinki.fi/opiskelijan-digitaidot-lisalukemisto/kayttojarjestelmat-ja-sovellusohjelmat/unix-ja-linux/tiedostojen-ja-hakemistojen-kasittely/
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Unit Abbreviation Size in bits or bytes 

byte B (Byte) 1 byte = 1 character = 8-bit string 

kilobyte kB 1024 bytes 

megabyte MB 1024 kilobytes 

gigabyte GB 1024 megabytes 

terabyte TB 1024 gigabytes 

 

he size of a file depends very much on the file type. A document of one page that only 
contains text may be as small as 3 kB, while a photograph may be 3 MB or much larger 
(the image size depends on the format the image is saved in). A whole movie can easily 
take several gigabytes of storage space. 

CREATION AND MODIFICATION DATES 

When the file window is set to display all of the details of the files, you will often see 
the Date Modified for each file. 
 

MANAGING FILE AND FOLDER VIEWS 

You can change the folder view in order to see the file and folder details in your 
preferred format (e.g. as thumbnails or with the dates visible). In Windows 10, you can 
change the view by clicking the buttons at the bottom right of the window (see the image 
below). 

The same options can be accessed via the View menu, which can be displayed by 
pressing the Alt key on the keyboard. 
 
You can sort files and folders by clicking the headings above the list. For example, to 
sort files by their date of modification, click the Date Modified heading (see the image 
above). You can reverse the order of the files by clicking the heading again. 
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Internal and External Commands 

Most Commonly Used Internal and External DOS Commands 

DOS Commands 

DOS Commands are instructions to perform tasks on files and directories very useful to 
Windows users. DOS commands are case insensitive. And as you already know, file is 
the area where we store group of information or data, and collection of group of files is 
called a directory. 

In MS-DOS the file name follow 8dot3 format and is divided into two parts – primary 
name and secondary name. Primary name is up to 8 characters long and secondary 
name is up to 4 characters with dot. For example, in the file-name Logo.jpg, Logo is the 
primary name and .jpg is the secondary name. Secondary names are fixed for particular 
type of file, meaning for system files the secondary name is designated as .sys, for text 
files it is .txt and so on. To name a file or directory special characters like < > , . / * ? | & 
Space are not allowed. Here is the list of some of the important types of files with their 
default secondary names: 
 

Text file .txt 

Command file .com 

System file .sys 

Programme file .prg 

Database file .dbm 

Library file .lib 

Batch file .bat 

Executable file .exe 

 
DOS Commands are divided into 2 types: 

1. Internal Commands 

These are for performing basic operations on files and directories and they do not 
need any external file support. 

2. External Commands 

These external commands are for performing advanced tasks and they do need 
some external file support as they are not stored in COMMAND.COM 

https://www.tech-wonders.com/2011/03/overview-of-disk-operating-system-dos.html
http://en.wikipedia.org/wiki/COMMAND.COM
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There are also Batch commands or Batch files which are text files that contain a list of 
internal and/or external commands which are executed in sequence when the batch file 
is executed. AUTOEXEC.BAT gets executed automatically on booting. 
In MS-DOS, keyboard shortcuts involving handy ones like Functional keys, arrows, pipe 
character (‖ | ―), asterisk (*), ?, [] and ESC are of great help for recalling to searching to 
clearing command line etc., Here are few of them: 

 UP (↑) and DOWN (↓) arrows recall previously entered commands. 
 

 ESC clears the present command line. It abandons the currently construct 
command and the next prompt appears. 
 

 F1 or → retypes one character at a time from the last command entry from the 
current cursor position. 
 

 F2 retypes all characters from the last command entry up to the one identical to 
your next keystroke. It asks you to enter char to copy up to and retypes the last 
command up to that char. 
 

 F3 retypes all remaining characters from the last command entry. 
 

 F4 stores all characters beginning at the first match with your next keystroke and 
ending with the last command entry. 
 

 F5 or F8 keys give all the previously typed commands. 
 

 F6 places a special end-of-file code at the end of the currently open file. 
Sometimes referred to as Ctrl+z or ^z. 
 

 F7 key displays command history and ALT+F7/ESC hides it. 
 

 F9 is used to select a command by number. Just enter the command number and 
it fetches the command line for you. 
 

 Pipe character (‖ | ―) combines several series of commands or programs inter-
dependent. 
 

 Name enclosed within [] indicate a sub-directory. 
 

 Asterisk (*) is used to represent zero or more any characters. 
 

 ? is used to present zero or single character. 
 

 

 

https://www.tech-wonders.com/2008/11/what-is-booting-process.html
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MS-DOS commands perform tasks like: 

 Manage files and directories 
 

 Maintain Disks 
 

 Configure Hardware and Networking 
 

 Optimize the use of memory 
 

 Customize MS-DOS 
 

Most Commonly Used Internal DOS Commands 

 

1. DATE 

This command is used to display the system current date setting and prompt you 
to enter a new date. The syntax is: DATE  [/T | date] 

 

                              

1. If you type DATE without parameters then it displays current date and prompts to 
enter new date. We should give new date in mm-dd-yy format. If you want to keep 
the same date just Press ENTER. DATE command with /T switch tells the 
command to just output the current system date, without prompting for a new date. 

2. TIME 

This command is used to displays or set the system time. 
The syntax is: TIME   [/T | time] 
 

 

Same as DATE command, typing TIME with no parameters displays the current 
time and a prompt for a new one. Press ENTER to keep the same time. TIME 

https://www.tech-wonders.com/2009/05/hardware-networking-certification-exam-points-to-remember.html
https://www.tech-wonders.com/2010/05/primary-memory-is-ram-and-rom.html
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command used with /T switch tells the command to just output the current system 
time, without prompting for a new time. 

1. COPY CON 

It is used to create a file in the existing directory. Here CON is a DOS reserved 
word which stands for console. 
Syntax is: COPY  CON filename after that press Enter and start typing your text 
and after you‘re done typing your text, to save and exit hit F6 key. 
 

2. TYPE 

This command is used to display the contents of a text file or files. The syntax 
is: TYPE   [drive:][path]filename 
Now, lets try to display the contents of the file named filename we‘ve created 
earlier using COPY CON command. 
 

 

3. CLS 

It is used to clear the screen. Syntax is CLS 
 

 

4. REN 

This command is used to change/modify the name of a file or files. 
Syntax is: REN   [drive:] [path] filename1   filename2. 
Here, filename1 is source file for which you wanted to change the name, and 
filename2 will obviously becomes your new file name. Also note that you cannot 
specify a new drive or path for your destination file. 

5. DIR 

This command displays a list of files and subdirectories in a directory. Syntax 
is: DIR   [drive:]  [path]  [filename] 

http://3.bp.blogspot.com/-pW45cmBe6rk/TZGZwwAQWlI/AAAAAAAAD9A/MV0TVCy1ToE/s1600/copy-con-command.png
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[/A[[:]attributes]]  [/B]  [/C]  [/D]  [/L]   [/N]  [/O[[:]sortorder]]  [/P]  [/Q] 
[/S]  [/T[[:]timefield]]  [/W]  [/X]  [/4] 
Here, 

[drive:][path][filename] Specifies drive, directory, and/or files to list. 

/A:attributes 

Displays files with specified attributes. The possible attributes 
are as follow: D → Directories, R → Read-only files, H → 
Hidden files, A → Files ready for archiving, S → System files, 
– Prefix meaning not 

/B 
display in bare format with no heading information or 
summary 

/C 
Using this attribute with dir by default displays the thousand 
separator in file sizes. To disable display or separator use /-C 

/D Displays file list sorted by column. 

/L Uses lowercase in listing file names and sub-directories. 

/N 
Display in new long list format where filenames are on the far 
right. 

/O:sortorder 

Displays list by files in sorted order. The sortorder attributes 
are as follow: N → By name (alphabetic), S → By size 
(smallest first), E → By extension (alphabetic), D → By 
date/time (oldest first), G → Group directories first, – Prefix to 
reverse order 

/P 
Display page wise pausing after each screenful of information 
and prompts to press any key to continue. 

/Q Displays the owner of a file or files. 

/S 

Displays files in specified directory and all subdirectories. 
Bear caution in using this in your root directory as you may 
end up in overflowing information. To stop the screen 
overflow at any point hit Pause-Break key. 

T:timefield 
This sorts and displays the list based on time field specified. 
C for Creation, A for Last Access, W for Last Written 

/W Displays list width wise or wide list format. 

/X 
This is used to display the short names generated for non-
8dot3 file names. 
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1. Note that switches may be different in the DIRCMD environment variable, in which 
case just override present switches by prefixing any switch with – (hyphen), for 
example instead of using /P use /-P 

2. PATH 

This command displays the path that how we have come to the present position or 
sets a search path for executable files. 
Its Syntax is PATH  [[drive:]path[;…][;%PATH%]] 
Typing PATH without any parameters displays the current path under current 
directory. Typing PATH ; clears all search-path settings and direct cmd.exe to 
search only in the current directory. And including %PATH% in the new path 
setting causes the old path to be appended to the new setting. 

3. VER 

This command displays the version of the Microsoft Windows running on your 
computer. 

4. VOL 

It displays the disk volume label and serial number, if they exist for the drive 
specified. If no drive is specified it displays for the active drive. 
Syntax is VOL  [drive:] 
 

 

5. DEL/ERASE 

Used to delete one or more files. 
Syntax is DEL   [/P]   [/F]   [/S]   [/Q]   [/A[[:]attributes]] names 
Here, 
tr> 

names 

Specifies a list of one or more files or directories. Wildcards * and ? 

may be used to delete multiple files. * indicates group of unknown 

characters whereas using wildcard ? in file-names is for single unknown 

character. And using this command if a directory is specified, all files 

within the directory will be deleted. 

http://1.bp.blogspot.com/-MVQhHQJ_grU/TZG5fSzwZcI/AAAAAAAAD9k/A2U8cQ9NzMo/s1600/VOL-dos-command.png
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/P 

Prompts for (Y)es/(N)o confirmation before deleting each file.

 

/F Used to force delete read-only files. 

/S 

Delete specified files from all subdirectories. If Command Extensions 

are enabled DEL and ERASE change while using /S switch such that it 

shows you only the files that are deleted, not the ones it could not find. 

/Q Delete in quite mode and do not ask if ok to delete on global wildcard 

/A:attributes 

Delete files based on specified attribute. The attributes are: R for Read-

only files, S for System files, H for Hidden files, A for files ready for 

archiving and – Prefix meaning not. 

 
6. COPY 

This command is useful in copying one or more files to another file or location. 
Syntax is COPY   [/D]   [/V]   [/N]   [/Y | /-Y]   [/Z]   [/A | /B ]   source [/A | /B]   [+ 
source [/A | /B] [+ …]]   [destination [/A | /B]] 
The different switches that can be used with this command as follow along with 
their use. 
 

source It specifies the file or files to be copied. 

/A Indicates an ASCII text file. 

/B This switch indicates a binary file. 

/D This allows the destination file to be created with decryption. 

destination This specifies the directory and/or filename for the new file or files. 

/V Helps to verify new files to be written correctly. 

http://1.bp.blogspot.com/-OUBEuPDDg9A/TZG-eAERQFI/AAAAAAAAD9w/69gRWJjI9s4/s1600/del-command-with-prompt-p.png
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/N 

Specifying this switch uses short filename, if available, when copying a 

file with a non-8dot3 file name. 

/Y 

If destination file already exists, this switch suppresses prompting to 

confirm you want to overwrite it and does it asap. 

/-Y 

Contrary to above switch, this causes prompting to confirm you want to 

overwrite an existing destination file. 

/Z Copies networked files in restartable mode. 

For appending multiple files for source use wildcard or file1+file2+file3 format and 
make sure to specify a single file for destination. 

6. MD, CD and RD 

 MD (or MKDIR) command stand for make directory and it is used to create a 
directory. Syntax is MD   [drive:]path 

 CD (or CHDIR) stands for create or change directory and it allows to display 
the name of or change the current directory or rather we can say come out 
of a directory. Syntax is CD   [/D]   [drive:][path] 
→ Typing CD drive: displays the current directory in the specified drive. This 
CD (or CHDIR) command does not treat spaces as delimiters due to which it 
allows to CD into a subdirectory name that contains a space without 
surrounding the name with quotes. 
For example: 
CHDIR program filesmozilla firefox 
is the same as: 
CHDIR ―program filesmozilla firefox‖ 
→ If you type CD without any parameters it displays current drive and 
directory. CD.. specifies that you want to change to the higher directory in 
the current path. Whereas, using CD you can directly change to parent/root 
directory from any location in the current drive. 
→Using /D switch changes current drive in addition to current directory for a 
drive. 

 

 RD (or RMDIR) command removes or deletes a directory. There are two 
conditions to remove any directory – (1) Directory to be removed should be 
empty. and (2) We should be outside the directory we are commanding to 
delete. 

http://2.bp.blogspot.com/-opCcCa7QNK0/TZHNsHh2fJI/AAAAAAAAD98/HdumR61Dp9o/s1600/chdir-command-with-D-switch.png
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Syntax is RD   [/S]   [/Q]   [drive:]path 
Here, using the switch /S removes a directory tree meaning it removes all 
directories and files in the specified directory in addition to the directory 
itself. And using /Q is the quiet mode that doesn‘t asks for ok approval to 
remove a directory tree. 
 

7. PROMPT 

This changes the cmd.exe command prompt. By default the prompt is always set 
to the name of current drive followed by > sign. 

Customize the Prompt 

To customize the prompt to display any text of your choice, use the syntax 
prompt anytext and this will change the prompt to new command prompt anytext. 
Prompt with Options (or Special Codes) 

You can use prompt with options. To let the prompt display the current working 
directory use prompt $p$g 
 
$p in the above signifies the current drive and path. 
$g signifies the greater than sign > 
 

 

The other options used with prompt command are as follows. 
Any combination of these can be used with prompt command. 
$A & (Ampersand) 

$B | (pipe character) 

$C ( (Left parenthesis) 

$D Current date 

$E Escape code (ASCII code 27) 

http://3.bp.blogspot.com/-rL80YWABpVc/UgF2jVM-dHI/AAAAAAAAFcM/3_9gjZITZp8/s1600/prompt-command.PNG
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$F ) (Right parenthesis) 

$H Backspace (erases previous character) 

$L < (less-than sign) $N Current drive $Q = (equal sign) $T Current time $V 
Windows XP version number $_ Carriage return and linefeed $$ $ (dollar sign) 

 

Most Commonly Used External DOS Commands 

1. EDIT 

This command is used to modify or change the data of a file. 
Syntax is EDIT  [/B]  [/H]  [/R]  [/S]  [filename(s)] 
Using switch /B you can force the edit in monochrome mode. /H displays the 
maximum number of lines possible for your system hardware. Whereas using /R 
and /S one can load files in read-only mode and force the use of short filenames 
respectively. [filename(s)] is used to specify file(s) to go edit. You can use 
wildcards (* and ?) to specify multiple files. 

2. XCOPY 

This command is used to copy files and directory trees from one disk to another 
disk. 
 
Syntax is XCOPY   source   [destination]   [/A | /M]   [/D[:date]]   [/P]   [/S 
[/E]]   [/V]   [/W]   [/C]   [/I]   [/Q]   [/F]   [/L]   [/G]   [/H]   [/R]   [/T]   [/U]  [/K]   [/N]  [/O
]   [/X]   [/Y]   [/-Y]   [/Z]  [/EXCLUDE:file1[+file2][+file3]…] 
 

3. LABEL 

It is used to create, change, or delete the volume label of a disk. 
Syntax is LABEL    [drive:]  [label] 
LABEL  [/MP]   [volume]   [label] 

http://4.bp.blogspot.com/-AeDXgZwfQ-w/UgF5EKgi4_I/AAAAAAAAFcc/IMBzIVrRYHg/s1600/prompt-command-special-codes.PNG
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Here, [drive:] is for secifying the drive letter of a drive to be labelled and [label] 
specifies the label of the volume disk. [/MP] is used to specify that the volume 
should be created as a mount point and [volume] is used to specify volume name, 
usually mentioned after drive letter followed by colon and then giving volume 
name required. 

4. DISKCOPY 

This command copies the contents of one floppy from the source drive to a 
formatted or un-formatted floppy disk in the destination drive. This command 
copies the data from particular position on the source disk to exactly the same 
position on the destination disk. Syntax Diskcopy  A:  B: 
copies contents of A: to B: drive. This command can be used with /V switch which 
verifies that the disk is copied correctly. 
 

5. CHKDSK 

This command is used to check a disk and display a status report with properties 
of disk like serial number, volume label, memory and other properties along with 
errors on the disk if any. 
 
Syntax is CHKDSK   [volume path]   [/F]   [/V]   [/R]   [/X]   [/I]   [/C]   [/L[:size]] 
[volume path] is where you specify the drive letter followed by a colon and volume 
name to be checked. using /F switch allows you to fix errors on the disk. /V display 
full path and/or cleanup message if any. /R is used in tandem with /F and used to 
locate bad sectors and recover readable information. If you wanted to perform a 
less vigorous check of index entries on the disk then the right option is to use /I or 
/C rather then /R as they skip checking of cycles on the volume and helps in 
reducing the amount of time required to run chkdsk. Using /X forces the volume to 
dismount first before checking is performed. /L:size is all about specifying the log 
file size in kilobytes. 
 

6. TREE 

This command is very useful to view the list of directories and subdirectories 
present on the disk in graphical form. If you wanted to include files also with 
directories and subdirectories, then you‘ll have to give the command line as tree/f 
which presents the tree view of all the content on your disk. Here is the syntax for 
this command with allowed switches: 
 
TREE   [drive:path]  [/F]  [/A] 
 
In case you wanted use ASCII instead of extended characters, then go ahead 
include /A in the command line. 
 
 
 

https://www.tech-wonders.com/2009/07/fix-computer-problems-for-free-pc-fixer.html
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7. DELTREE 

This command is used to remove a directory along with its contents. 
Syntax is deltree [drive:path] 
 
here, [drive:path] specifies the directory name to be deleted. All the subdirectories 
and files in this directory will be deleted without prompt and there‘s not getting 
back. So, keep caution while using this command. 
 

8. DOSKEY 

This command is generally used to edits command lines and recalls commands. 
Syntax is DOSKEY  [/REINSTALL]  [/HISTORY] [text] 
 
Here, /REINSTALL installs new copy of doskey, /HISTORY is used to display all 
previously given commands stored in memory. And [text] specifies the commands 
you want to record. 
 

9. FIND 

This command searches for a specific text string in a file or files. Syntax 
is FIND   [/V]  [/C]  [/N]  [/I]  [/OFF]  ―string‖ [[drive:][path]filename[ …]] 
The basic essential elements in the command line for find are – the string 
enclosed in ‖ ‖ and [[drive:][path]filename(s)]. String specifies the text string to find 
in the file and [[drive:][path]filename(s)] specifies the file or files where the text 
string search is to be done. If a path is not specified, FIND searches the text typed 
at the prompt or piped from another command. When you append /OFF in the 
command line, it searches and finds even those files with offline attribute set. 
Apart from searching the text string, this command is useful in: 

 Displaying all lines not containing the specified string @ /V 
 

 Displaying only the number count of lines containing the text string @ /C 
 

 Displaying line numbers with the displayed lines @ /N 
 

10. SORT 

This command is used to arrange the data of a file in alphabetical order (A-Z, 0-9) 
or reverse alphabetical order. 

Syntax is SORT   [/R]   [[drive1:][path1]filename1]   [/T [drive2:][path2]]  [/O 
[drive3:][path3]filename3] 
 
/R in command line reverses the sort order; that is, the data of the specified file 
sorts sorts Z to A, then 9 to 0. [drive1:][path1]filename1 specifies the file to be 
sorted. /T [drive2:][path2] is used in cases of data overflow in main memory and it 
specifies the path of the directory to hold the sort‘s working storage. And 

https://www.tech-wonders.com/2010/08/units-of-measure-for-digital.html
https://www.tech-wonders.com/2011/07/data-backup-dont-take-risk.html
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/O [drive3:][path3]filename3 specifies the file where the sorted input is to be 
stored. 
 

11. FORMAT 

This command creates a new root directory and a File Allocation Table (FAT) for 
the disk. In order for MS-DOS to be able to use a new disk you must use this 
command to format the disk. 

FORMAT with /S switch 

When the disk is formatted with /s option, the disk can be used as a booting 
disk. C:>DOS>Format A: /s 
 
The above command copies the OS files MSDOS.SYS, IO.SYS and 
COMMAND.COM which are required for booting the machine from your system 
startup drive to the newly formatted disk. The disk can then be used for booting. 
FORMAT with /U switch 

Here‘s the command C:DOS>Format A: /U 
 
This command specifies an Unconditional Format which destroys all existing data 
and prevents you from later unformatting the disk. 
 
FORMAT with /Q switch 

This can be used only with the previously formatted disk. This deletes FAT, Root 
directory and data of disk but doesn‘t scan for the bad errors. This is generally 
used for Quick formatting. 
 
Warning As Format command deletes all existing data, use this command with 
extreme caution. Any disk formatted (except with /U switch) may be later 
unformatted using the UNFORMAT command. 
 

12. BACKUP 

The Backup command backs up one or more files from one disk to another. You 
can backup files onto either a hard disk or on a floppy disk. Syntax is 
BACKUP   Source   Destination 
 
Here source specifies the location of files to be backed up and destination drive 
specifies the drive on which you want to store the backup files. The backed-up 
files are stored in backup.nnn and control.nnn files where nnn represents the 
backup disk number. 

https://www.tech-wonders.com/2008/11/what-is-booting-process.html
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Backup with Switches 

 The /S switch can be used to backup the contents of all files in the source 
including the contents of sub-directories. 
 

 The /N switch can be used to backup only those files that have changed 
since the last backup. 
 

 Backup command with /D:mm-dd-yyyy switch will backup files that have 
changed since the data specified. 
 

13. RESTORE 

The RESTORE command restores files that were backed up by using BACKUP 
command. Syntax: RESTORE   drive1  drive2:path 
Here drive1 specifies the drive on which backup files are stored. 
drive2:path specifies the path to which those backup files will be restored. 
► Using backup command with /S switch is used to restore all backup files to their 
original directories and sub-directories. 
 

Batch Files 
 

A batch file is a text file containing a series of commands that the operating system will 
carry out for you, one at a time. A batch file is a batches (bundles or packages) of DOS 
commands into a single file. MS-DOS batch files consist of the normal operating 
system commands (e.g. DIR, DEL, COPY and MKDIR) together with some extra 
commands such as IF, FOR, GOTO, SHIFT and PAUSE that provide conditional 
control of execution and enable PARAMETERS to be passed so that the same batch 
file can be used in many different contexts. Under UNIX, batch files are called SHELL 
SCRIPTS, and are written in a c-like scripting language. 

A batch file, such as WP.BAT, ends with the letters .BAT. When the user types in the 
name of a batch file and presses Enter at the DOS prompt, the commands in that batch 
file are performed one at a time-with no additional instructions from the user. For 
example, if the user typed WP and pressed Enter, WordPerfect (a popular word 
processing program) would start. 

Batch files are great when you use a given set of commands repeatedly-instead of 
activating each command separately every time you want to carry out that set of 
commands, you can accomplish the same thing in one step. 

A user can create a batch file to perform any routine task. For example, a batch file 
could be created to prepare a disk for use (a process called formatting). Because the 
commands are in a batch file, the user doesn‘t have to type them herself, or even 
remember what they are-all the user would have to do is type the name of this batch 
file to format a disk. 

 

https://ecomputernotes.com/fundamental/disk-operating-system/what-is-operating-system
https://ecomputernotes.com/fundamental/disk-operating-system/what-is-operating-system
https://ecomputernotes.com/fundamental/disk-operating-system/what-is-operating-system
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The most important batch file is the AUTOEXEC BAT.  

This file contains commands that are performed automatically each time the PC is 
turned on or restarted. Typical AUTOEXEC BAT commands include those which 
change the system prompt, display the current date and time, and set the directories in 
which DOS looks for files. 

Batch files were very important before Windows came along, when everyone had to 
deal with DOS (the PC‘s operating system). DOS required the user to type everything 
in-which made each task tedious and easy to make mistakes. Batch files eliminated 
mistakes because the user no longer typed in the command, just the name of the batch 
file. With Windows, there is little typing involved in issuing commands. 

Instead, the user selects commands from a list called a menu, or he selects an icon 
that represents the command he wants performed. Automation is still desirable in 
Windows, but instead of saving a list of typed commands, the user records his actions 
and saves them in a macro. A macro is like a batch file; when it‘s activated, the actions 
recorded in the macro are carried out. 

Batch processing:  

The grouping together of several processing jobs to be executed one after another by 
a computer, without any user interaction. This is achieved by placing a list of the 
commands to start the required jobs into a BATCH FILE that can be executed as if it 
were a single program: hence batch processing is most often used in operating 
systems that have a COMMAND LINE user interface. Indeed, batch processing was 
the normal mode of working in the early days of mainframe computers, but 
modern personal computer applications typically require frequent user interaction, 
making them unsuitable for batch execution. 

Running a batch file is one example of batch processing, but there are plenty of others. 
When you select several documents from the same application and print them all in 
one step (if the application allows you to do that), you are ―batch printing,‖ which is a 
form of batch processing. Or let‘s say that you want to send a whole group of files to 
someone else via your modem-if your communications software permits batch 
processing, you can choose all the files you want to send, and have the software send 
them off in a batch while you go to the kitchen for a snack. Batch processing is a good 
feature to have in most applications. 

What is Batch Processing Operating System? 

To avoid the problems of early systems the batch processing systems were introduced. 
The problem of early systems was more setup time. So the problem of more set up 
time was reduced by processing the jobs in batches, known as batch processing 
system. In this approach similar jobs were submitted to the CPU for processing and 
were run together. 

The main function of a batch processing system is to automatically keep executing the 
jobs in a batch. This is the important task of a batch processing system i.e. performed 
by the ‗Batch Monitor‘ resided in the low end of main memory. 
 

https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-computer
https://ecomputernotes.com/fundamental/introduction-to-computer/mainframe
https://ecomputernotes.com/fundamental/introduction-to-computer/personal-computer
https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-cpu
https://ecomputernotes.com/fundamental/input-output-and-memory/memory
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This technique was possible due to the invention of hard-disk drives and card readers. 
Now the jobs could be stored on the disk to create the pool of jobs for its execution as 
a batch. First the pooled jobs are read and executed by the batch monitor, and then 
these jobs are grouped; placing the identical jobs (jobs with the similar needs) in the 
same batch, So, in the batch processing system, the batched jobs were executed 
automatically one after another saving its time by performing the activities (like loading 
of compiler) only for once. It resulted in improved system utilization due to reduced turn 
around time. 

In the early job processing systems, the jobs were placed in a job queue and 
the memory allocate or managed the primary memory space, when space was 
available in the main memory, a job was selected from the job queue and was loaded 
into memory. 
 

Once the job loaded into primary memory, it competes for the processor. When the 
processor became available, the processor scheduler selects job that was loaded in 
the memory and execute it. 

In batch strategy is implemented to provide a batch file processing. So in this approach 
files of the similar batch are processed to speed up the task. 

 

 

https://ecomputernotes.com/fundamental/input-output-and-memory/memory
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Batch File Processing 

In batch processing the user were supposed to prepare a program as a deck of 
punched cards. The header cards in the deck were the ―job control‖ cards which would 
indicate that which compiler was to be used (like FORTRAN, COBOL compilers etc). 
The deck of cards would be handed in to an operator who would collect such jobs from 
various users. Then the submitted jobs were ‗grouped as FORTRAN jobs, COBOL jobs 
etc. In addition, these jobs were classified as ‗long jobs‘ that required more processing 
time or short jobs which required a short processing time. Each set of jobs was 
considered as a batch and the processing would be done for a batch. For instance, 
there maybe a batch of short FORTRAN jobs. The output for each job would be 
separated and turned over to users in a collection area. So in this approach, files of the 
similar batch were processed to speed up the task. 
 

In this environment there was no interactivity and the users had no direct control. In 
this system, only one job could engage the processor at a time and if there was any 
input/ output operation the processor had to sit idle till the completion of I/O job. So it 
resulted to the under utilization of CPU time. 
 

In batch processing system, earlier; the jobs were scheduled in the order of their arrival 
i.e. First Come First Served (FCFS). Even though this scheduling method was easy 
and simple to implement but unfair for the situations where long jobs are queued ahead 
of the short jobs. To overcome this problem, another scheduling method named as 
‗Shortest Job First‘ was used. As memory management is concerned, the main 
memory was partitioned into two fixed partitions. The lower end of this partition was 
assigned to the resident portion of the OS i.e. named as Batch Monitor. Whereas, the 
other partition (higher end) was assigned to the user programs. 
 

Though, it was an improved technique in reducing the system setup time but still there 
were some limitations with this technique like as under-utilization of CPU time, non-
interactivity of user with the running jobs etc. In batch processing system, the jobs of a 
batch were executed one after another. But while these jobs were performing I/O 
operations; meantime the CPU was sitting idle resulting to low degree of resource 
utilization. 

 

 

 

 

 

 

 

https://ecomputernotes.com/fundamental/introduction-to-computer/what-is-cpu
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Types of O.S. 

Following are some of the most widely used types of Operating system. 

1. Simple Batch System 

2. Multiprogramming Batch System 

3. Multiprocessor System 

4. Desktop System 

5. Distributed Operating System 

6. Clustered System 

7. Realtime Operating System 

8. Handheld System 

Simple Batch Systems 

 In this type of system, there is no direct interaction between user and the 

computer. 

 The user has to submit a job (written on cards or tape) to a computer operator. 

 Then computer operator places a batch of several jobs on an input device. 

 Jobs are batched together by type of languages and requirement. 

 Then a special program, the monitor, manages the execution of each program in 

the batch. 

 The monitor is always in the main memory and available for execution. 

 
Advantages of Simple Batch Systems 

1. No interaction between user and computer. 

2. No mechanism to prioritise the processes. 
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Multiprogramming Batch Systems 

 In this the operating system picks up and begins to execute one of the jobs from 

memory. 

 Once this job needs an I/O operation operating system switches to another job 

(CPU and OS always busy). 

 Jobs in the memory are always less than the number of jobs on disk(Job Pool). 

 If several jobs are ready to run at the same time, then the system chooses which 

one to run through the process of CPU Scheduling. 

 In Non-multiprogrammed system, there are moments when CPU sits idle and 

does not do any work. 

 In Multiprogramming system, CPU will never be idle and keeps on processing. 

Time Sharing Systems are very similar to Multiprogramming batch systems. In fact time 
sharing systems are an extension of multiprogramming systems. 

In Time sharing systems the prime focus is on minimizing the response time, while in 
multiprogramming the prime focus is to maximize the CPU usage. 
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Multiprocessor Systems 

A Multiprocessor system consists of several processors that share a common physical 
memory. Multiprocessor system provides higher computing power and speed. In 
multiprocessor system all processors operate under single operating system. Multiplicity 
of the processors and how they do act together are transparent to the others. 

 

Advantages of Multiprocessor Systems 

1. Enhanced performance 

2. Execution of several tasks by different processors concurrently, increases the 

system's throughput without speeding up the execution of a single task. 

3. If possible, system divides task into many subtasks and then these subtasks can 

be executed in parallel in different processors. Thereby speeding up the 

execution of single tasks. 

Desktop Systems 

Earlier, CPUs and PCs lacked the features needed to protect an operating system from 
user programs. PC operating systems therefore were neither multiuser nor multitasking. 
However, the goals of these operating systems have changed with time; instead of 
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maximizing CPU and peripheral utilization, the systems opt for maximizing user 
convenience and responsiveness. These systems are called Desktop Systems and 
include PCs running Microsoft Windows and the Apple Macintosh. Operating systems 
for these computers have benefited in several ways from the development of operating 
systems for mainframes. 

Microcomputers were immediately able to adopt some of the technology developed for 
larger operating systems. On the other hand, the hardware costs for microcomputers 
are sufficiently low that individuals have sole use of the computer, and CPU utilization is 
no longer a prime concern. Thus, some of the design decisions made in operating 
systems for mainframes may not be appropriate for smaller systems. 

Distributed Operating System 

The motivation behind developing distributed operating systems is the availability of 
powerful and inexpensive microprocessors and advances in communication technology. 

These advancements in technology have made it possible to design and develop 
distributed systems comprising of many computers that are inter connected by 
communication networks. The main benefit of distributed systems is its low 
price/performance ratio. 

 

Advantages Distributed Operating System 

1. As there are multiple systems involved, user at one site can utilize the resources 

of systems at other sites for resource-intensive tasks. 

2. Fast processing. 

3. Less load on the Host Machine. 

 

Types of Distributed Operating Systems 

Following are the two types of distributed operating systems used: 

1. Client-Server Systems 

2. Peer-to-Peer Systems 
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Client-Server Systems 
Centralized systems today act as server systems to satisfy requests generated by client 
systems. The general structure of a client-server system is depicted in the figure below: 

 

 

 

Server Systems can be broadly categorized as: Compute Servers and File Servers. 

 Compute Server systems, provide an interface to which clients can send 

requests to perform an action, in response to which they execute the action and 

send back results to the client. 

 File Server systems, provide a file-system interface where clients can create, 

update, read, and delete files. 

 
Peer-to-Peer Systems 
The growth of computer networks - especially the Internet and World Wide Web (WWW) 
– has had a profound influence on the recent development of operating systems. When 
PCs were introduced in the 1970s, they were designed for personal use and were 
generally considered standalone computers. With the beginning of widespread public 
use of the Internet in the 1990s for electronic mail and FTP, many PCs became 
connected to computer networks. 

In contrast to the Tightly Coupled systems, the computer networks used in these 
applications consist of a collection of processors that do not share memory or a clock. 
Instead, each processor has its own local memory. The processors communicate with 
one another through various communication lines, such as high-speed buses or 
telephone lines. These systems are usually referred to as loosely coupled systems ( or 
distributed systems). The general structure of a client-server system is depicted in the 
figure below: 
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Clustered Systems 

 Like parallel systems, clustered systems gather together multiple CPUs to 

accomplish computational work. 

 Clustered systems differ from parallel systems, however, in that they are 

composed of two or more individual systems coupled together. 

 The definition of the term clustered is not concrete; the general accepted 

definition is that clustered computers share storage and are closely linked via 

LAN networking. 

 Clustering is usually performed to provide high availability. 

 A layer of cluster software runs on the cluster nodes. Each node can monitor one 

or more of the others. If the monitored machine fails, the monitoring machine can 

take ownership of its storage, and restart the application(s) that were running on 

the failed machine. The failed machine can remain down, but the users and 

clients of the application would only see a brief interruption of service. 

 Asymmetric Clustering - In this, one machine is in hot standby mode while the 

other is running the applications. The hot standby host (machine) does nothing 

but monitor the active server. If that server fails, the hot standby host becomes 

the active server. 
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 Symmetric Clustering - In this, two or more hosts are running applications, and 

they are monitoring each other. This mode is obviously more efficient, as it uses 

all of the available hardware. 

 Parallel Clustering - Parallel clusters allow multiple hosts to access the same 

data on the shared storage. Because most operating systems lack support for 

this simultaneous data access by multiple hosts, parallel clusters are usually 

accomplished by special versions of software and special releases of 

applications. 

Clustered technology is rapidly changing. Clustered system's usage and it's features 
should expand greatly as Storage Area Networks(SANs). SANs allow easy attachment 
of multiple hosts to multiple storage units. Current clusters are usually limited to two or 
four hosts due to the complexity of connecting the hosts to shared storage. 

Real Time Operating System 

It is defined as an operating system known to give maximum time for each of the critical 
operations that it performs, like OS calls and interrupt handling. 

The Real-Time Operating system which guarantees the maximum time for critical 
operations and complete them on time are referred to as Hard Real-Time Operating 
Systems. 

While the real-time operating systems that can only guarantee a maximum of the time, 
i.e. the critical task will get priority over other tasks, but no assurity of completeing it in a 
defined time. These systems are referred to as Soft Real-Time Operating Systems. 

Handheld Systems 

Handheld systems include Personal Digital Assistants(PDAs), such as Palm-
Pilots or Cellular Telephones with connectivity to a network such as the Internet. They 
are usually of limited size due to which most handheld devices have a small amount of 
memory, include slow processors, and feature small display screens. 

 Many handheld devices have between 512 KB and 8 MB of memory. As a result, 

the operating system and applications must manage memory efficiently. This 

includes returning all allocated memory back to the memory manager once the 

memory is no longer being used. 
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 Currently, many handheld devices do not use virtual memory techniques, thus 

forcing program developers to work within the confines of limited physical 

memory. 

 Processors for most handheld devices often run at a fraction of the speed of a 

processor in a PC. Faster processors require more power. To include a faster 

processor in a handheld device would require a larger battery that would have to 

be replaced more frequently. 

 The last issue confronting program designers for handheld devices is the small 

display screens typically available. One approach for displaying the content in 

web pages is web clipping, where only a small subset of a web page is delivered 

and displayed on the handheld device. 

Some handheld devices may use wireless technology such as BlueTooth, allowing 
remote access to e-mail and web browsing. Cellular telephones with connectivity to the 
Internet fall into this category. Their use continues to expand as network connections 
become more available and other options such as cameras and MP3 players, expand 
their utility. 

What is a Process? 

A process is a program in execution. Process is not as same as program code but a lot 
more than it. A process is an 'active' entity as opposed to program which is considered 
to be a 'passive' entity. Attributes held by process include hardware state, memory, 
CPU etc. 

Process memory is divided into four sections for efficient working : 

 The Text section is made up of the compiled program code, read in from non-

volatile storage when the program is launched. 

 The Data section is made up the global and static variables, allocated and 

initialized prior to executing the main. 

 The Heap is used for the dynamic memory allocation, and is managed via calls to 

new, delete, malloc, free, etc. 

 The Stack is used for local variables. Space on the stack is reserved for local 

variables when they are declared. 
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Different Process States 

Processes in the operating system can be in any of the following states: 

 NEW- The process is being created. 

 READY- The process is waiting to be assigned to a processor. 

 RUNNING- Instructions are being executed. 

 WAITING- The process is waiting for some event to occur(such as an I/O 

completion or reception of a signal). 

 TERMINATED- The process has finished execution. 

 

 

                                                    Process Control Block 

There is a Process Control Block for each process, enclosing all the information about 
the process. It is a data structure, which contains the following: 

 Process State: It can be running, waiting etc. 

 Process ID and the parent process ID. 

 CPU registers and Program Counter. Program Counter holds the address of the 

next instruction to be executed for that process. 

 CPU Scheduling information: Such as priority information and pointers to 

scheduling queues. 
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 Memory Management information: For example, page tables or segment tables. 

 Accounting information: The User and kernel CPU time consumed, account 

numbers, limits, etc. 

 I/O Status information: Devices allocated, open file tables, etc. 

  

 

 

What is Process Scheduling? 

he act of determining which process is in the ready state, and should be moved to 
the running state is known as Process Scheduling. 

The prime aim of the process scheduling system is to keep the CPU busy all the time 
and to deliver minimum response time for all programs. For achieving this, the 
scheduler must apply appropriate rules for swapping processes IN and OUT of CPU. 

Scheduling fell into one of the two general categories: 

 Non Pre-emptive Scheduling: When the currently executing process gives up the 

CPU voluntarily. 
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 Pre-emptive Scheduling: When the operating system decides to favour another 

process, pre-empting the currently executing process. 

What are Scheduling Queues? 

 All processes, upon entering into the system, are stored in the Job Queue. 

 Processes in the Ready state are placed in the Ready Queue. 

 Processes waiting for a device to become available are placed in Device 

Queues. There are unique device queues available for each I/O device. 

A new process is initially put in the Ready queue. It waits in the ready queue until it is 
selected for execution(or dispatched). Once the process is assigned to the CPU and is 
executing, one of the following several events can occur: 

 The process could issue an I/O request, and then be placed in the I/O queue. 

 The process could create a new subprocess and wait for its termination. 

 The process could be removed forcibly from the CPU, as a result of an interrupt, 

and be put back in the ready queue. 

 



86 
 

In the first two cases, the process eventually switches from the waiting state to the 
ready state, and is then put back in the ready queue. A process continues this cycle 
until it terminates, at which time it is removed from all queues and has its PCB and 
resources deallocated. 

Types of Schedulers 

There are three types of schedulers available: 

1. Long Term Scheduler 

2. Short Term Scheduler 

3. Medium Term Scheduler 

Let's discuss about all the different types of Schedulers in detail: 

Long Term Scheduler 

Long term scheduler runs less frequently. Long Term Schedulers decide which program 
must get into the job queue. From the job queue, the Job Processor, selects processes 
and loads them into the memory for execution. Primary aim of the Job Scheduler is to 
maintain a good degree of Multiprogramming. An optimal degree of Multiprogramming 
means the average rate of process creation is equal to the average departure rate of 
processes from the execution memory. 

 

Short Term Scheduler 

This is also known as CPU Scheduler and runs very frequently. The primary aim of this 
scheduler is to enhance CPU performance and increase process execution rate. 

 

Medium Term Scheduler 

This scheduler removes the processes from memory (and from active contention for the 
CPU), and thus reduces the degree of multiprogramming. At some later time, the 
process can be reintroduced into memory and its execution van be continued where it 
left off. This scheme is called swapping. The process is swapped out, and is later 
swapped in, by the medium term scheduler. 

Swapping may be necessary to improve the process mix, or because a change in 
memory requirements has overcommitted available memory, requiring memory to be 
freed up. This complete process is descripted in the below diagram: 
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                     Addition of Medium-term scheduling to the queueing diagram. 

What is Context Switch? 

1. Switching the CPU to another process requires saving the state of the old 

process and loading the saved state for the new process. This task is known as 

a Context Switch. 

2. The context of a process is represented in the Process Control Block(PCB) of a 

process; it includes the value of the CPU registers, the process state and 

memory-management information. When a context switch occurs, the Kernel 

saves the context of the old process in its PCB and loads the saved context of 

the new process scheduled to run. 

3. Context switch time is pure overhead, because the system does no useful work 

while switching. Its speed varies from machine to machine, depending on the 

memory speed, the number of registers that must be copied, and the existence of 

special instructions(such as a single instruction to load or store all registers). 

Typical speeds range from 1 to 1000 microseconds. 

4. Context Switching has become such a performance bottleneck that programmers 

are using new structures(threads) to avoid it whenever and wherever possible. 
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Operations on Process 

Below we have discussed the two major operation Process Creation and Process 
Termination. 

Process Creation 

Through appropriate system calls, such as fork or spawn, processes may create other 
processes. The process which creates other process, is termed the parent of the other 
process, while the created sub-process is termed its child. 

Each process is given an integer identifier, termed as process identifier, or PID. The 
parent PID (PPID) is also stored for each process. 

On a typical UNIX systems the process scheduler is termed as sched, and is given PID 
0. The first thing done by it at system start-up time is to launch init, which gives that 
process PID 1. Further Init launches all the system daemons and user logins, and 
becomes the ultimate parent of all other processes. 

 

 

 

A child process may receive some amount of shared resources with its parent 
depending on system implementation. To prevent runaway children from consuming all 
of a certain system resource, child processes may or may not be limited to a subset of 
the resources originally allocated to the parent. 
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There are two options for the parent process after creating the child : 

 Wait for the child process to terminate before proceeding. Parent process makes 

a wait() system call, for either a specific child process or for any particular child 

process, which causes the parent process to block until the wait() returns. UNIX 

shells normally wait for their children to complete before issuing a new prompt. 

 Run concurrently with the child, continuing to process without waiting. When a 

UNIX shell runs a process as a background task, this is the operation seen. It is 

also possible for the parent to run for a while, and then wait for the child later, 

which might occur in a sort of a parallel processing operation. 

There are also two possibilities in terms of the address space of the new process: 

1. The child process is a duplicate of the parent process. 

2. The child process has a program loaded into it. 

To illustrate these different implementations, let us consider the UNIX operating system. 
In UNIX, each process is identified by its process identifier, which is a unique integer. A 
new process is created by the fork system call. The new process consists of a copy of 
the address space of the original process. This mechanism allows the parent process to 
communicate easily with its child process. Both processes (the parent and the child) 
continue execution at the instruction after the fork system call, with one difference: The 
return code for the fork system call is zero for the new(child) process, whereas the(non 
zero) process identifier of the child is returned to the parent. 

Typically, the execlp system call is used after the fork system call by one of the two 
processes to replace the process memory space with a new program. The execlp 
system call loads a binary file into memory - destroying the memory image of the 
program containing the execlp system call – and starts its execution. In this manner the 
two processes are able to communicate, and then to go their separate ways. 

Below is a C program to illustrate forking a separate process using UNIX(made using 
Ubuntu): 
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#include<stdio.h> 

 

void main(int argc, char *argv[]) 

{ 

    int pid; 

 

    /* Fork another process */ 

    pid = fork(); 

 

    if(pid < 0) 

    { 

        //Error occurred 

        fprintf(stderr, "Fork Failed"); 

        exit(-1); 

    } 

    else if (pid == 0) 

    { 

        //Child process 

        execlp("/bin/ls","ls",NULL); 

    } 

    else 

    { 

        //Parent process 

        //Parent will wait for the child to complete 

        wait(NULL); 

        printf("Child complete"); 
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        exit(0); 

    } 

} 

GATE Numerical Tip: If fork is called for n times, the number of child processes or 

new processes created will be: 2n – 1. 

Process Termination 

By making the exit(system call), typically returning an int, processes may request their 
own termination. This int is passed along to the parent if it is doing a wait(), and is 
typically zero on successful completion and some non-zero code in the event of any 
problem. 

Processes may also be terminated by the system for a variety of reasons, including : 

 The inability of the system to deliver the necessary system resources. 

 In response to a KILL command or other unhandled process interrupts. 

 A parent may kill its children if the task assigned to them is no longer needed i.e. 

if the need of having a child terminates. 

 If the parent exits, the system may or may not allow the child to continue without 

a parent (In UNIX systems, orphaned processes are generally inherited by init, 

which then proceeds to kill them.) 

When a process ends, all of its system resources are freed up, open files flushed and 
closed, etc. The process termination status and execution times are returned to the 
parent if the parent is waiting for the child to terminate, or eventually returned to init if 
the process already became an orphan. 

The processes which are trying to terminate but cannot do so because their parent is 
not waiting for them are termed zombies. These are eventually inherited by init as 
orphans and killed off. 
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What is CPU Scheduling? 

CPU scheduling is a process which allows one process to use the CPU while the 
execution of another process is on hold(in waiting state) due to unavailability of any 
resource like I/O etc, thereby making full use of CPU. The aim of CPU scheduling is to 
make the system efficient, fast and fair. 

Whenever the CPU becomes idle, the operating system must select one of the 
processes in the ready queue to be executed. The selection process is carried out by 
the short-term scheduler (or CPU scheduler). The scheduler selects from among the 
processes in memory that are ready to execute, and allocates the CPU to one of them. 

CPU Scheduling: Dispatcher 

Another component involved in the CPU scheduling function is the Dispatcher. The 
dispatcher is the module that gives control of the CPU to the process selected by 
the short-term scheduler. This function involves: 

 Switching context 

 Switching to user mode 

 Jumping to the proper location in the user program to restart that program from 

where it left last time. 

The dispatcher should be as fast as possible, given that it is invoked during every 
process switch. The time taken by the dispatcher to stop one process and start another 
process is known as the Dispatch Latency. Dispatch Latency can be explained using 
the below figure: 
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Types of CPU Scheduling 

CPU scheduling decisions may take place under the following four circumstances: 

1. When a process switches from the running state to the waiting state(for I/O 

request or invocation of wait for the termination of one of the child processes). 

2. When a process switches from the running state to the ready state (for example, 

when an interrupt occurs). 

3. When a process switches from the waiting state to the ready state(for example, 

completion of I/O). 

4. When a process terminates. 

In circumstances 1 and 4, there is no choice in terms of scheduling. A new process(if 
one exists in the ready queue) must be selected for execution. There is a choice, 
however in circumstances 2 and 3. 

When Scheduling takes place only under circumstances 1 and 4, we say the scheduling 
scheme is non-preemptive; otherwise the scheduling scheme is preemptive. 

Non-Preemptive Scheduling 

Under non-preemptive scheduling, once the CPU has been allocated to a process, the 
process keeps the CPU until it releases the CPU either by terminating or by switching to 
the waiting state. 

This scheduling method is used by the Microsoft Windows 3.1 and by the Apple 
Macintosh operating systems. 

It is the only method that can be used on certain hardware platforms, because It does 
not require the special hardware(for example: a timer) needed for preemptive 
scheduling. 

Preemptive Scheduling 

In this type of Scheduling, the tasks are usually assigned with priorities. At times it is 
necessary to run a certain task that has a higher priority before another task although it 
is running. Therefore, the running task is interrupted for some time and resumed later 
when the priority task has finished its execution. 
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CPU Scheduling: Scheduling Criteria 

There are many different criterias to check when considering the "best" scheduling 
algorithm, they are: 

CPU Utilization 

To make out the best use of CPU and not to waste any CPU cycle, CPU would be 
working most of the time(Ideally 100% of the time). Considering a real system, CPU 
usage should range from 40% (lightly loaded) to 90% (heavily loaded.) 

Throughput 

It is the total number of processes completed per unit time or rather say total amount of 
work done in a unit of time. This may range from 10/second to 1/hour depending on the 
specific processes. 

Turnaround Time 

It is the amount of time taken to execute a particular process, i.e. The interval from time 
of submission of the process to the time of completion of the process(Wall clock time). 

Waiting Time 

The sum of the periods spent waiting in the ready queue amount of time a process has 
been waiting in the ready queue to acquire get control on the CPU. 

Load Average 

It is the average number of processes residing in the ready queue waiting for their turn 
to get into the CPU. 

Response Time 

Amount of time it takes from when a request was submitted until the first response is 
produced. Remember, it is the time till the first response and not the completion of 
process execution(final response). 

In general CPU utilization and Throughput are maximized and other factors are reduced 
for proper optimization. 

Scheduling Algorithms 

To decide which process to execute first and which process to execute last to achieve 
maximum CPU utilisation, computer scientists have defined some algorithms, they are: 

1. First Come First Serve(FCFS) Scheduling 

2. Shortest-Job-First(SJF) Scheduling 

3. Priority Scheduling 

https://www.studytonight.com/operating-system/first-come-first-serve
https://www.studytonight.com/operating-system/shortest-job-first
https://www.studytonight.com/operating-system/priority-scheduling
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4. Round Robin(RR) Scheduling 

5. Multilevel Queue Scheduling 

6. Multilevel Feedback Queue Scheduling 

We will be discussing all the scheduling algorithms, one by one, in detail in the next 
tutorials. 

 

First Come First Serve Scheduling 

In the "First come first serve" scheduling algorithm, as the name suggests, the process 
which arrives first, gets executed first, or we can say that the process which requests 
the CPU first, gets the CPU allocated first. 

 First Come First Serve, is just like FIFO(First in First out) Queue data structure, 

where the data element which is added to the queue first, is the one who leaves 

the queue first. 

 This is used in Batch Systems. 

 It's easy to understand and implement programmatically, using a Queue data 

structure, where a new process enters through the tail of the queue, and the 

scheduler selects process from the head of the queue. 

 A perfect real life example of FCFS scheduling is buying tickets at ticket counter. 

Calculating Average Waiting Time 

For every scheduling algorithm, Average waiting time is a crucial parameter to judge it's 
performance. 

AWT or Average waiting time is the average of the waiting times of the processes in the 
queue, waiting for the scheduler to pick them for execution. 

Lower the Average Waiting Time, better the scheduling algorithm. 

Consider the processes P1, P2, P3, P4 given in the below table, arrives for execution in 
the same order, with Arrival Time 0, and given Burst Time, let's find the average waiting 
time using the FCFS scheduling algorithm. 

https://www.studytonight.com/operating-system/round-robin-scheduling
https://www.studytonight.com/operating-system/multilevel-queue-scheduling
https://www.studytonight.com/operating-system/multilevel-feedback-queue-scheduling
https://www.studytonight.com/operating-system/types-of-os
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The average waiting time will be 18.75 ms 

For the above given proccesses, first P1 will be provided with the CPU resources, 

 Hence, waiting time for P1 will be 0 

 P1 requires 21 ms for completion, hence waiting time for P2 will be 21 ms 

 Similarly, waiting time for process P3 will be execution time of P1 + execution 

time for P2, which will be (21 + 3) ms = 24 ms. 

 For process P4 it will be the sum of execution times of P1, P2 and P3. 

The GANTT chart above perfectly represents the waiting time for each process. 
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Problems with FCFS Scheduling 

Below we have a few shortcomings or problems with the FCFS scheduling algorithm: 

1. It is Non Pre-emptive algorithm, which means the process priority doesn't matter. 

If a process with very least priority is being executed, more like daily routine 

backup process, which takes more time, and all of a sudden some other high 

priority process arrives, like interrupt to avoid system crash, the high priority 

process will have to wait, and hence in this case, the system will crash, just 

because of improper process scheduling. 

2. Not optimal Average Waiting Time. 

3. Resources utilization in parallel is not possible, which leads to Convoy Effect, 

and hence poor resource(CPU, I/O etc) utilization. 

 
 

What is Convoy Effect? 

Convoy Effect is a situation where many processes, who need to use a resource for 
short time are blocked by one process holding that resource for a long time. 

This essentially leads to poort utilization of resources and hence poor performance. 

Program for FCFS Scheduling 

Here we have a simple C++ program for processes with arrival time as 0. 

In the program, we will be calculating the Average waiting time and Average turn around 
time for a given array of Burst times for the list of processes. 

/* Simple C++ program for implementation  

of FCFS scheduling */ 

 

#include<iostream> 

 

using namespace std; 
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// function to find the waiting time for all processes 

void findWaitingTime(int processes[], int n, int bt[], int wt[]) 

{ 

    // waiting time for first process will be 0 

    wt[0] = 0; 

  

    // calculating waiting time 

    for (int i = 1; i < n ; i++) 

    { 

        wt[i] =  bt[i-1] + wt[i-1]; 

    } 

} 

  

// function to calculate turn around time 

void findTurnAroundTime( int processes[], int n, int bt[], int wt[], int tat[]) 

{ 

    // calculating turnaround time by adding 

    // bt[i] + wt[i] 

    for (int i = 0; i < n ; i++) 

    { 

        tat[i] = bt[i] + wt[i]; 

    } 

} 

  

// function to calculate average time 
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void findAverageTime( int processes[], int n, int bt[]) 

{ 

    int wt[n], tat[n], total_wt = 0, total_tat = 0; 

  

    // function to find waiting time of all processes 

    findWaitingTime(processes, n, bt, wt); 

  

    // function to find turn around time for all processes 

    findTurnAroundTime(processes, n, bt, wt, tat); 

  

    // display processes along with all details 

    cout << "Processes  "<< " Burst time  "<< " Waiting time  " << " Turn around time\n"; 

  

    // calculate total waiting time and total turn around time 

    for (int i = 0; i < n; i++) 

    { 

        total_wt = total_wt + wt[i]; 

        total_tat = total_tat + tat[i]; 

        cout << "   " << i+1 << "\t\t" << bt[i] <<"\t    "<< wt[i] <<"\t\t  " << tat[i] <<endl; 

    } 

  

    cout << "Average waiting time = "<< (float)total_wt / (float)n; 

    cout << "\nAverage turn around time = "<< (float)total_tat / (float)n; 

} 

  

// main function 
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int main() 

{ 

    // process ids 

    int processes[] = { 1, 2, 3, 4}; 

    int n = sizeof processes / sizeof processes[0]; 

  

    // burst time of all processes 

    int  burst_time[] = {21, 3, 6, 2}; 

  

    findAverageTime(processes, n,  burst_time); 

     

    return 0; 

} 

 

Processes Burst time Waiting time Turn around time 

1 21 0 21 

2 3 21 24 

3 6 24 30 

4 2 30 32 

Average waiting time = 18.75 

Average turn around time = 26.75 

 

Here we have simple formulae for calculating various times for given processes: 

Completion Time: Time taken for the execution to complete, starting from arrival time. 

Turn Around Time: Time taken to complete after arrival. In simple words, it is the 
difference between the Completion time and the Arrival time. 
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Waiting Time: Total time the process has to wait before it's execution begins. It is the 
difference between the Turn Around time and the Burst time of the process. 

 

For the program above, we have considered the arrival time to be 0 for all the 

processes, try to implement a program with variable arrival times. 

Shortest Job First(SJF) Scheduling 

Shortest Job First scheduling works on the process with the shortest burst 
time or duration first. 

 This is the best approach to minimize waiting time. 

 This is used in Batch Systems. 

 It is of two types: 

1. Non Pre-emptive 

2. Pre-emptive 

 To successfully implement it, the burst time/duration time of the processes 

should be known to the processor in advance, which is practically not feasible all 

the time. 

 This scheduling algorithm is optimal if all the jobs/processes are available at the 

same time. (either Arrival time is 0 for all, or Arrival time is same for all) 

Non Pre-emptive Shortest Job First 

Consider the below processes available in the ready queue for execution, with arrival 
time as 0 for all and given burst times. 

 

https://www.studytonight.com/operating-system/types-of-os
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As you can see in the GANTT chart above, the process P4 will be picked up first as it 
has the shortest burst time, then P2, followed by P3 and at last P1. 

We scheduled the same set of processes using the First come first serve algorithm in 
the previous tutorial, and got average waiting time to be 18.75 ms, whereas with SJF, 
the average waiting time comes out 4.5 ms. 

Problem with Non Pre-emptive SJF 

If the arrival time for processes are different, which means all the processes are not 
available in the ready queue at time 0, and some jobs arrive after some time, in such 
situation, sometimes process with short burst time have to wait for the current process's 
execution to finish, because in Non Pre-emptive SJF, on arrival of a process with short 
duration, the existing job/process's execution is not halted/stopped to execute the short 
job first. 

This leads to the problem of Starvation, where a shorter process has to wait for a long 
time until the current longer process gets executed. This happens if shorter jobs keep 
coming, but this can be solved using the concept of aging. 

Pre-emptive Shortest Job First 

In Preemptive Shortest Job First Scheduling, jobs are put into ready queue as they 
arrive, but as a process with short burst time arrives, the existing process is 
preempted or removed from execution, and the shorter job is executed first. 

 

The average waiting time will be,((5-3)+(6-2)+(12-1))/4=8.75 

The average waiting time for preemptive shortest job first scheduling is less than 
both,non preemptive SJF scheduling and FCFS scheduling 

https://www.studytonight.com/operating-system/first-come-first-serve
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As you can see in the GANTT chart above, as P1 arrives first, hence it's execution 
starts immediately, but just after 1 ms, process P2 arrives with a burst time of 3 
ms which is less than the burst time of P1, hence the process P1(1 ms done, 20 ms left) 
is preemptied and process P2 is executed. 

As P2 is getting executed, after 1 ms, P3 arrives, but it has a burst time greater than 
that of P2, hence execution of P2 continues. But after another millisecond, P4 arrives 
with a burst time of 2 ms, as a result P2(2 ms done, 1 ms left) is preemptied and P4 is 
executed. 

After the completion of P4, process P2 is picked up and finishes, then P2 will get 
executed and at last P1. 

The Pre-emptive SJF is also known as Shortest Remaining Time First, because at any 
given point of time, the job with the shortest remaining time is executed first. 

Program for SJF Scheduling 

In the below program, we consider the arrival time of all the jobs to be 0. 

Also, in the program, we will sort all the jobs based on their burst time and then execute 
them one by one, just like we did in FCFS scheduling program. 

// c++ program to implement Shortest Job first 

 

#include<bits/stdc++.h> 

 

using namespace std; 

  

struct Process 

{ 

   int pid;     // process ID 

   int bt;      // burst Time 

}; 

  

/*  

    this function is used for sorting all 
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    processes in increasing order of burst time 

*/ 

bool comparison(Process a, Process b) 

{ 

    return (a.bt < b.bt); 

} 

  

// function to find the waiting time for all processes 

void findWaitingTime(Process proc[], int n, int wt[]) 

{ 

    // waiting time for first process is 0 

    wt[0] = 0; 

  

    // calculating waiting time 

    for (int i = 1; i < n ; i++) 

    { 

        wt[i] = proc[i-1].bt + wt[i-1] ; 

    } 

} 

  

// function to calculate turn around time 

void findTurnAroundTime(Process proc[], int n, int wt[], int tat[]) 

{ 

    // calculating turnaround time by adding bt[i] + wt[i] 

    for (int i = 0; i < n ; i++) 

    { 
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        tat[i] = proc[i].bt + wt[i]; 

    } 

} 

  

// function to calculate average time 

void findAverageTime(Process proc[], int n) 

{ 

    int wt[n], tat[n], total_wt = 0, total_tat = 0; 

  

    // function to find waiting time of all processes 

    findWaitingTime(proc, n, wt); 

  

    // function to find turn around time for all processes 

    findTurnAroundTime(proc, n, wt, tat); 

  

    // display processes along with all details 

    cout << "\nProcesses "<< " Burst time " 

         << " Waiting time " << " Turn around time\n"; 

  

    // calculate total waiting time and total turn around time 

    for (int i = 0; i < n; i++) 

    { 

        total_wt = total_wt + wt[i]; 

        total_tat = total_tat + tat[i]; 

        cout << " " << proc[i].pid << "\t\t" 

             << proc[i].bt << "\t " << wt[i] 
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             << "\t\t " << tat[i] <<endl; 

    } 

  

    cout << "Average waiting time = " 

         << (float)total_wt / (float)n; 

    cout << "\nAverage turn around time = " 

         << (float)total_tat / (float)n; 

} 

  

// main function 

int main() 

{ 

    Process proc[] = {{1, 21}, {2, 3}, {3, 6}, {4, 2}}; 

    int n = sizeof proc / sizeof proc[0]; 

  

    // sorting processes by burst time. 

    sort(proc, proc + n, comparison); 

  

    cout << "Order in which process gets executed\n"; 

    for (int i = 0 ; i < n; i++) 

    { 

        cout << proc[i].pid <<" "; 

    } 

  

    findAverageTime(proc, n); 
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    return 0; 

} 

 

Order in which process gets executed 

4 2 3 1 

Processes Burst time Waiting time Turn around time 

4 2 0 2 

2 3 2 5 

3 6 5 11 

1 21 11 32 

Average waiting time = 4.5 

Average turn around time = 12.5 

Try implementing the program for SJF with variable arrival time for different jobs, 
yourself. 

 

Priority CPU Scheduling 

In this tutorial we will understand the priority scheduling algorithm, how it works and its 
advantages and disadvantages. 

In the Shortest Job First scheduling algorithm, the priority of a process is generally the 
inverse of the CPU burst time, i.e. the larger the burst time the lower is the priority of 
that process. 

In case of priority scheduling the priority is not always set as the inverse of the CPU 
burst time, rather it can be internally or externally set, but yes the scheduling is done on 
the basis of priority of the process where the process which is most urgent is processed 
first, followed by the ones with lesser priority in order. 

Processes with same priority are executed in FCFS manner. 

The priority of process, when internally defined, can be decided based on memory 
requirements, time limits ,number of open files, ratio of I/O burst to CPU burst etc. 

Whereas, external priorities are set based on criteria outside the operating system, like 
the importance of the process, funds paid for the computer resource use, makrte factor 
etc. 

https://www.studytonight.com/operating-system/shortest-job-first
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Types of Priority Scheduling Algorithm 

Priority scheduling can be of two types: 

1. Preemptive Priority Scheduling: If the new process arrived at the ready queue 

has a higher priority than the currently running process, the CPU is preempted, 

which means the processing of the current process is stoped and the incoming 

new process with higher priority gets the CPU for its execution. 

2. Non-Preemptive Priority Scheduling: In case of non-preemptive priority 

scheduling algorithm if a new process arrives with a higher priority than the 

current running process, the incoming process is put at the head of the ready 

queue, which means after the execution of the current process it will be 

processed. 

Example of Priority Scheduling Algorithm 

Consider the below table fo processes with their respective CPU burst times and the 
priorities. 
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As you can see in the GANTT chart that the processes are given CPU time just on the 
basis of the priorities. 

Problem with Priority Scheduling Algorithm 

In priority scheduling algorithm, the chances of indefinite blocking or starvation. 

A process is considered blocked when it is ready to run but has to wait for the CPU as 
some other process is running currently. 

But in case of priority scheduling if new higher priority processes keeps coming in the 
ready queue then the processes waiting in the ready queue with lower priority may have 
to wait for long durations before getting the CPU for execution. 

In 1973, when the IBM 7904 machine was shut down at MIT, a low-priority process was 

found which was submitted in 1967 and had not yet been run. 

Using Aging Technique with Priority Scheduling 

To prevent starvation of any process, we can use the concept of aging where we keep 
on increasing the priority of low-priority process based on the its waiting time. 

For example, if we decide the aging factor to be 0.5 for each day of waiting, then if a 
process with priority 20(which is comparitively low priority) comes in the ready queue. 
After one day of waiting, its priority is increased to 19.5 and so on. 

Doing so, we can ensure that no process will have to wait for indefinite time for getting 
CPU time for processing. 

Implementing Priority Scheduling Algorithm in C++ 

Implementing priority scheduling algorithm is easy. All we have to do is to sort the 
processes based on their priority and CPU burst time, and then apply FCFS 
Algorithm on it. 

Here is the C++ code for priority scheduling algorithm: 

// Implementation of Priority scheduling algorithm 

#include<bits/stdc++.h>  

using namespace std;  

   

struct Process  

{  

https://www.studytonight.com/operating-system/priority-scheduling
https://www.studytonight.com/operating-system/priority-scheduling
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 // this is the process ID  

    int pid;   

    // the CPU burst time  

    int bt;    

    // priority of the process  

    int priority;  

};  

   

// sort the processes based on priority 

bool sortProcesses(Process a, Process b)  

{  

    return (a.priority > b.priority);  

}  

   

// Function to find the waiting time for all processes  

void findWaitingTime(Process proc[], int n,  

                     int wt[])  

{  

    // waiting time for first process is 0  

    wt[0] = 0;  

   

    // calculating waiting time  

    for (int  i = 1; i < n ; i++ )  

        wt[i] =  proc[i-1].bt + wt[i-1] ;  

}  
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// Function to calculate turn around time  

void findTurnAroundTime( Process proc[], int n,  

                         int wt[], int tat[])  

{  

    // calculating turnaround time by adding  

    // bt[i] + wt[i]  

    for (int  i = 0; i < n ; i++)  

        tat[i] = proc[i].bt + wt[i];  

}  

   

//Function to calculate average time  

void findavgTime(Process proc[], int n)  

{  

    int wt[n], tat[n], total_wt = 0, total_tat = 0;  

   

    //Function to find waiting time of all processes  

    findWaitingTime(proc, n, wt);  

   

    //Function to find turn around time for all processes  

    findTurnAroundTime(proc, n, wt, tat);  

   

    //Display processes along with all details  

    cout << "\nProcesses  "<< " Burst time  " 

         << " Waiting time  " << " Turn around time\n";  

   

    // Calculate total waiting time and total turn  
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    // around time  

    for (int  i=0; i<n; i++)  

    {  

        total_wt = total_wt + wt[i];  

        total_tat = total_tat + tat[i];  

        cout << "   " << proc[i].pid << "\t\t" 

             << proc[i].bt << "\t    " << wt[i]  

             << "\t\t  " << tat[i] <<endl;  

    }  

   

    cout << "\nAverage waiting time = " 

         << (float)total_wt / (float)n;  

    cout << "\nAverage turn around time = " 

         << (float)total_tat / (float)n;  

}  

   

void priorityScheduling(Process proc[], int n)  

{  

    // Sort processes by priority  

    sort(proc, proc + n, sortProcesses);  

   

    cout<< "Order in which processes gets executed \n";  

    for (int  i = 0 ; i <  n; i++)  

        cout << proc[i].pid <<" " ;  

   

    findavgTime(proc, n);  
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}  

   

// Driver code  

int main()  

{  

    Process proc[] = {{1, 10, 2}, {2, 5, 0}, {3, 8, 1}};  

    int n = sizeof proc / sizeof proc[0];  

    priorityScheduling(proc, n);  

    return 0;  

} 
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UNIT-IV 

 

Windows Operating Environment 

Features of MS – Windows 

Microsoft Windows includes a wide array of features, 
tools, and applications to help get the most out of 
Windows and your computer. 
 
To learn more about the features included in Microsoft 
Windows, click a link below. 

• Control Panel 

• Cortana 

• Desktop 

• Device Manager 

• Disk Cleanup 

• Event Viewer 

• File Explorer 

• Internet browser 

• Microsoft Paint 

• Notepad 

 

• Notification area 

• Power User Tasks Menu 

• Registry Editor 

• Settings 

• Start and Start menu 

• System Information 

• Taskbar 

• Task Manager 

• Windows search box 

Control Panel 
 
The Control Panel is a collection of tools to help you configure and manage the 

resources on your computer. You can change settings for printers, video, audio, mouse, 

keyboard, date and time, user accounts, installed applications, network connections, 

power saving options, and more. 

https://www.computerhope.com/issues/ch001967.htm#controlpanel
https://www.computerhope.com/issues/ch001967.htm#cortana
https://www.computerhope.com/issues/ch001967.htm#desktop
https://www.computerhope.com/issues/ch001967.htm#devicemgr
https://www.computerhope.com/issues/ch001967.htm#diskclean
https://www.computerhope.com/issues/ch001967.htm#eventviewer
https://www.computerhope.com/issues/ch001967.htm#explorer
https://www.computerhope.com/issues/ch001967.htm#browser
https://www.computerhope.com/issues/ch001967.htm#mspaint
https://www.computerhope.com/issues/ch001967.htm#notepad
https://www.computerhope.com/issues/ch001967.htm#notifarea
https://www.computerhope.com/issues/ch001967.htm#poweruser
https://www.computerhope.com/issues/ch001967.htm#regedit
https://www.computerhope.com/issues/ch001967.htm#settings
https://www.computerhope.com/issues/ch001967.htm#startmenu
https://www.computerhope.com/issues/ch001967.htm#sysinfo
https://www.computerhope.com/issues/ch001967.htm#taskbar
https://www.computerhope.com/issues/ch001967.htm#taskmgr
https://www.computerhope.com/issues/ch001967.htm#searchbox
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In Windows 10, the Control Panel is located in the Start menu, under Windows System. 
 
You can also start the Control Panel from the Run box. Press Win+R, type control, and 
press Enter. Or, you may press the Windows key, type Control Panel, and then 
press Enter. 
 

Many of the Control Panel settings are also accessible 

in the Windows 10 Settings menu. 

 

 

 

What is the Control Panel? 

Cortana 
 
Cortana is a virtual assistant introduced in Windows 10 that accepts voice commands. 

Cortana can answer questions, search your computer or Internet, set appointments and 

reminders, perform online purchases, and more. Cortana has similarities to other voice-

activated services, such as Siri, Alexa, or Google Assistant, with the added benefit that 

it can search the information on your computer. 

https://www.computerhope.com/issues/ch001967.htm#startmenu
https://www.computerhope.com/jargon/r/run.htm
https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/w/winkey.htm
https://www.computerhope.com/issues/ch001967.htm#settings
https://www.computerhope.com/jargon/c/controlp.htm
https://www.computerhope.com/jargon/v/virtual-assistant.htm
https://www.computerhope.com/jargon/w/windows-10.htm
https://www.computerhope.com/jargon/i/internet.htm
https://www.computerhope.com/jargon/s/siri.htm
https://www.computerhope.com/jargon/a/alexa.htm
https://www.computerhope.com/jargon/g/google-assistant.htm
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To access Cortana in Windows 10, press Win+S. 

 What is Cortana? 

 How to enable voice activation for Cortana. 

 How do I turn off Cortana? 

Desktop 
The desktop is a fundamental part of the default GUI (graphical user interface) in 

Windows. It is a space where you can organize applications, folders, and documents, 

which appear as icons. Your desktop is always in the background, behind any other 

applications you're running. 

When you power on your computer and log in to Windows, the first thing you see is your 

desktop background, icons, and the taskbar. From here, you can access the installed 

programs on your computer from the Start menu, or by double-clicking any 

application shortcuts you may have on your desktop. 

https://www.computerhope.com/jargon/c/cortana.htm
https://www.computerhope.com/issues/ch001843.htm
https://www.computerhope.com/issues/ch001821.htm
https://www.computerhope.com/jargon/g/gui.htm
https://www.computerhope.com/jargon/i/icon.htm
https://www.computerhope.com/jargon/b/backgrou.htm#wallpaper
https://www.computerhope.com/jargon/i/icon.htm
https://www.computerhope.com/issues/ch001967.htm#taskbar
https://www.computerhope.com/issues/ch001967.htm#startmenu
https://www.computerhope.com/jargon/s/shortcut.htm
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You can access your desktop at any time by 

pressing Win+D to minimize any running applications. 

Device Manager 
 
The Device Manager lists the hardware devices installed in a computer. It allows users 

to see what hardware is installed, view and update hardware drivers, and uninstall 

hardware through the Device Manager. 

 

You can open the Device Manager from the Power User Tasks Menu (Win+X, then 

press M). 

https://www.computerhope.com/jargon/m/minimize.htm
https://www.computerhope.com/issues/ch001967.htm#poweruser
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 What is the Device Manager? 

 Device Manager help index. 

Disk Cleanup 
 
The Disk Cleanup utility helps increase free disk space on your computer by removing 

temporary or unnecessary files. Running Disk Cleanup helps improve your computer's 

performance, and create additional space to store your downloads, documents, 

and programs. 

 

You can access Disk Cleanup from the File Explorer. 

1. Press Win+E to open an Explorer window. 

 

2. On the left side of the window, find This  PC or My Computer, and select 

it by clicking once. 

 

3. Then, on the right side, right-click any disk drive on your computer (C:, for 

example). 

 

4. Select Properties. 

 

5. Under the General tab, click Disk Cleanup. 

 What is Disk Cleanup? 

 My computer is running slow, what steps can I do to fix it? 

https://www.computerhope.com/jargon/d/devicema.htm
https://www.computerhope.com/win95er.htm
https://www.computerhope.com/jargon/d/download.htm
https://www.computerhope.com/jargon/d/document.htm
https://www.computerhope.com/jargon/p/program.htm
https://www.computerhope.com/issues/ch001967.htm#explorer
https://www.computerhope.com/jargon/d/diskclea.htm
https://www.computerhope.com/issues/ch000179.htm
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 How to regain computer hard drive space. 

Event Viewer 
 
The Event Viewer is an administrator tool displays errors and important events that 

happen on your computer. It helps troubleshoot advanced problems in your Windows 

system. 

 

Event Viewer can be accessed from the Power User Tasks Menu (press Win+X, then 

press V). 

 What is the Event Viewer? 

 How to fix Windows blue screen errors. 

File Explorer 
 
The File Explorer, also called Windows Explorer, provides you with a view of the files 

and folders on the computer. You can browse the contents of your SSD, hard drive, and 

attached removable disks. You can search for files and folders, and open, rename, or 

delete them from the File Explorer. 

 

https://www.computerhope.com/issues/ch000528.htm
https://www.computerhope.com/jargon/a/admin.htm
https://www.computerhope.com/issues/ch001967.htm#poweruser
https://www.computerhope.com/jargon/e/evenview.htm
https://www.computerhope.com/issues/ch001141.htm
https://www.computerhope.com/jargon/s/ssd.htm
https://www.computerhope.com/jargon/h/harddriv.htm
https://www.computerhope.com/jargon/r/remodisk.htm
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To open a new File Explorer window, press Win+E. You can open more than one 

Explorer window at the same time, which helps with viewing multiple folders at once, or 

copying/moving files from one to the other. 

 What is File Explorer? 

 How to change how files are displayed in Windows Explorer. 

Internet browser 
 
Your Internet browser is one of the most important applications on your computer. You 

can use it to find information on the Internet, view web pages, shop and buy 

merchandise, watch movies, play games, and more. Microsoft Edge is the default 

browser in Windows 10. Internet Explorer is included as the default browser in previous 

versions of Windows, from Windows 95 to Windows 8.1. 

 

To open a new Edge browser window in Windows 10, open the Start menu and scroll 

down to Microsoft Edge. 

 What is an Internet browser? 

 

 How to find version of installed Internet browser. 

 

 How do I update my browser? 

 

 Can I have more than one Internet browser installed? 

Microsoft Paint 
 
Included in Windows since November 1985, Microsoft Paint is a simple image editor 

that you can use to create, view, and edit digital images. It provides basic functionality 

to draw and paint pictures, resize and rotate photographs, and save pictures as 

different file types. 

https://www.computerhope.com/jargon/e/explorer.htm
https://www.computerhope.com/issues/ch001015.htm
https://www.computerhope.com/jargon/m/microsoft-edge.htm
https://www.computerhope.com/jargon/m/msie.htm
https://www.computerhope.com/jargon/b/browser.htm
https://www.computerhope.com/issues/ch001329.htm
https://www.computerhope.com/issues/ch001388.htm
https://www.computerhope.com/issues/ch001186.htm
https://www.computerhope.com/history/1985.htm
https://www.computerhope.com/jargon/f/file.htm#file-extensions
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To open Microsoft Paint in all versions of Windows, press the Windows key, 

type mspaint, and press Enter. It's also available in your Start menu: in Windows 10, it's 

listed under Windows Accessories, Paint. 

 What is Microsoft Paint? 

 Microsoft Paint help index. 

Notepad 
 
Notepad is a simple text editor. You can use it to create, view, and edit text files. For 

instance, you can use Notepad to write a batch file, or a web page written in HTML. 

 

https://www.computerhope.com/jargon/w/winkey.htm
https://www.computerhope.com/jargon/p/paint.htm
https://www.computerhope.com/software/mspaint.htm
https://www.computerhope.com/jargon/e/editor.htm
https://www.computerhope.com/jargon/t/textfile.htm
https://www.computerhope.com/jargon/b/batchfil.htm
https://www.computerhope.com/jargon/w/webpage.htm
https://www.computerhope.com/jargon/h/html.htm
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In Windows 10, Notepad is located in your Start menu under Windows accessories. In 

all versions of Windows, you can start Notepad from the Run box: press Win+R, 

type notepad, and press Enter. 

 What is Notepad? 

 How to create a text file. 

Notification area 
 
The notification area, also known as the system tray, displays the date and time, and 

shows icons of programs that are started with Windows. It also provides your Internet 

connection's status and a speaker icon for adjusting sound volume. 

 

 What is the Notification Area? 

 

 Information about the Windows notification area (systray). 

Power User Tasks Menu 
 
Available in Windows 8 and Windows 10, the Power User Tasks Menu provides quick 

access to helpful and important Windows utilities. From this menu, you can open 

the Control Panel, Device Manager, File Explorer, Task Manager, and more. 

https://www.computerhope.com/jargon/n/notepad.htm
https://www.computerhope.com/issues/ch001359.htm
https://www.computerhope.com/jargon/n/notiarea.htm
https://www.computerhope.com/issues/chsys.htm
https://www.computerhope.com/issues/ch001967.htm#controlpanel
https://www.computerhope.com/issues/ch001967.htm#devicemgr
https://www.computerhope.com/issues/ch001967.htm#explorer
https://www.computerhope.com/issues/ch001967.htm#taskmgr
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To open the Power User Tasks Menu, press Win+X, or right-click the Start menu icon. 

 What is the Power User Tasks Menu? 

Registry Editor 
 
The Registry Editor allows you to view the Windows system registry, and edit registry 

keys. Computer technicians may use the Registry Editor to fix problems with the 

Windows operating system or installed software. 

 

https://www.computerhope.com/jargon/p/putm.htm
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In Windows 10, the Registry Editor is located in the Start menu under Windows 

Administrative Tools. You can also start it by pressing the Windows key, typing regedit, 

and then pressing Enter. 

Settings 

Available in Windows 8 and Windows 10, Settings allows you to change many aspects 

of Windows. You can change the desktop background, adjust power settings, review 

options for external devices, and more. 

 

To open Settings in Windows 10, press Win+I. Or, open the Start menu, and click the 

gear icon ( ). 

 

https://www.computerhope.com/jargon/w/winkey.htm
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 What is Windows Settings? 

 

 How to adjust power, standby, and sleep settings. 

Start and Start menu 

The Start menu is a list of applications and utilities installed on your computer. You can 

open it by pressing Start, on the left side of your taskbar. 

 

 

 

From the keyboard, you can open the Start menu by pressing the Windows key. 

 What is the Start button? 

 

 What is the Start menu? 

 

 How do I get the start button back in Windows 8? 

System Information 

The System Information utility provides information about the computer, including 

hardware and Windows details. You can find out details about your computer's 

hardware, including processor, memory, video card, and sound card. You can also view 

and configure environment variables, device drivers, services, and more. 

 

https://www.computerhope.com/jargon/s/settings.htm
https://www.computerhope.com/issues/ch000338.htm
https://www.computerhope.com/jargon/s/start.htm
https://www.computerhope.com/issues/ch001967.htm#taskbar
https://www.computerhope.com/jargon/s/start.htm
https://www.computerhope.com/jargon/s/startmen.htm
https://www.computerhope.com/issues/ch001374.htm
https://www.computerhope.com/jargon/e/envivari.htm
https://www.computerhope.com/jargon/d/driver.htm
https://www.computerhope.com/jargon/s/service.htm
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In Windows 10, System Information is located in the Start menu, under Windows 

Administrative Tools. You can also open it from the Run box: press Win R, 

type msinfo32, and press Enter. 

 What is System Information? 

 How to find hardware and other computer specifications. 

Taskbar 

The Windows taskbar shows programs that are currently open, and a Quick 

Launch area that allows quick access to launch specific programs. The notification 

area is on the right side of the taskbar, showing the date and time, and programs 

running in the background. 

 

 What is the taskbar? 

 How to keep the Windows taskbar hidden. 

Task Manager 

The Task Manager gives you an overview of what's running on your computer. You can 

see how much of your system resources is used by each application (task), sorting by 

CPU, RAM, and disk I/O usage. If a program is frozen or not responding, you can right-

click it in Task Manager and end the task, forcing it to quit. 

To open the Task Manager at any time, press Ctrl+Shift+Esc. 

 

https://www.computerhope.com/jargon/s/sysinfo.htm
https://www.computerhope.com/issues/ch000017.htm
https://www.computerhope.com/jargon/q/quiclaun.htm
https://www.computerhope.com/jargon/q/quiclaun.htm
https://www.computerhope.com/jargon/n/notiarea.htm
https://www.computerhope.com/jargon/n/notiarea.htm
https://www.computerhope.com/jargon/t/taskbar.htm
https://www.computerhope.com/issues/ch000479.htm
https://www.computerhope.com/jargon/e/endtask.htm
https://www.computerhope.com/jargon/c/ctrl-shift-esc.htm
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Windows search box 

The Windows search box is a convenient way to search for documents, pictures, 

videos, applications, and more. In Windows 10, the search box is also integrated with 

Cortana. The feature first appeared in Windows Vista. 

 

The search box is on your taskbar by default. In Windows 10, if you don't see the search 

box, right-click the taskbar and select Taskbar settings. Make sure Use small taskbar 

buttons is Off. Then, right-click the taskbar again, and select Cortana, Show search box. 

Windows 

Windows is a collection of programs known as an operating system (OS) that controls a 
PC (personal computer). First produced by Microsoft in November 1985, it has been 
frequently updated since, as computer memory has got bigger, as processing chips 
have got faster and, of course, when the internet was invented. Prior to Windows, PCs 
were operated by a series of text commands. 

Windows' key benefits and features 

 Allows the user to interact with the computer (through the keyboard, mouse, 
microphone, etc.). 
 

 Controls the storage of data (images, files, music). 
 

 Controls hardware attached to the computer such as webcams, scanners and 
printers. 
 

 Helps to open and close programs (word processors, games, photo editors, etc.), 
and gives them part of the computer‘s memory to allow them to work. 
 

 Controls what access to a computer different users have and the computer's 
security. 
 

 Deals with errors and user instructions, and issues simple error messages. 
 

 Promotes multitasking by allowing the user to do several things on the computer at 
once – for example, watch a video while writing a letter. 

Other operating systems are available, notably the Apple OS X used in Mac computers. 
In addition, with the increased use of smartphones, notepads and tablets, there are 
systems aimed directly at mobile devices. However, most people who learn to use 
computers do so on a system running Windows. 
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In this topic, we are going to learn about the Introduction to Windows. Microsoft 

Windows is a multitasking operating system developed by Microsoft Corporation which 

uses Graphical User Interface to interact with the users. Microsoft was originally named 

―Traf-O-Data‖ in 1972, was renamed as ―Micro-soft‖ in November 1975, then ―Microsoft‖ 

on November 26, 1976. Microsoft entered the marketplace in August 1981 by releasing 

version 1.0 of the operating system Microsoft DOS (MS-DOS), a 16-bit command-line 

operating system. Bill Gates and Paul Allen founded Microsoft and windows operating 

system has been its primary product. 

In this Introduction to Windows, we will also clear you about the latest OS release of 

Windows is ―Windows 10‖ which was launched in the year 2015. 

In a nutshell, below is how Microsoft windows evolved over time: 

Windows 1.0 – Nov 1985 

Windows 2.0 – Dec 1987 

Windows 3.0 – May 1990 

Windows 95 – Aug 1995 

Windows 98 – June 1998 

Windows ME – Sep 2000 

Windows XP – Oct 2001 

Windows Vista – Nov 2006 

Windows 7 – July 2009 

Windows 8.0 – Oct 2012 

Windows 8.1 – Oct 2013 

Windows 10 – July 2015 

Main Components of Windows 

After learning about the Introduction to Windows, we are now going to study about the 

main components of Windows. The main components of the Windows Operating 

System are the following: 

 Configuration and maintenance 

 User interface 

 Applications and utilities 
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 Windows Server components 

 File systems 

 Core components 

 Services 

 DirectX 

 Networking 

 Scripting and command-line 

 Kernel 

 NET Framework 

 Security 

 Deprecated components and apps 

 APIs 

Source Link: https://en.wikipedia.org/wiki/List_of_Microsoft_Windows_components 

 

Application 

Introduction: 

The term Application refers to Software which is a set of instructions or code written in a 
program for executing a task or an operation in a Computer. Applications play a vital 
role in a Computer as it is an end-user program that enables the users to do many 
things in a system. The application programs are designed and developed to run in a 
System Software which is an Operating system. An Operating System is system 
software that enables al the applications programs to run and execute various tasks in a 
Computer system. The GUI based applications carries out various tasks in a Computer 
like creating documents, playing games, browsing and many more. 

Application Software Overview: 

Application software‘s are the end-user programs designed to enhance the productivity 
in various fields of work. The applications are used for creating documents, 
spreadsheets, databases, and publications, doing online research, sending email, 
designing graphics, running businesses, and also playing games. Application software‘s 
are designed to perform a specific task and can be as simple as a calculator application 
or as complex as a word processing application. The applications are designed with 
built-in functions and properties so to easily carry out all the operations. One of the most 
popular and widely used applications is Microsoft word processor where you can do 
calculations, copy, paste, delete, and add colors and pictures, change the appearance 
by using its built-in properties. Not only Word processor applications but there are 
several other productivity programs like Graphical software, Photo studio, Antivirus and 
many more that are packed as an Application software. 

https://en.wikipedia.org/wiki/List_of_Microsoft_Windows_components
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hen installed on a computer that can be used. But there are several applications like 
Microsoft Office which is a complete suite of programs that includes Excel, Power point, 
Access etc, Graphic suites like Adobe Creative suite with various applications for 
creating and editing images, Audio master suite for sound production, Video editing 
applications, Security software‘s and most importantly Web-browser which is also 
application software. 

Application Software can be divided into two broad categories are System Software and 
Applications Software. 

 System Software is a program designed to manage all the hardware resources 
and also runs the applications programs in a Computer. It is mainly of two types 
are the Operating system and utility software that is installed with the Operating 
system. The Operating system and utility programs are written in such a way to 
function independently because they are not user oriented. It always runs in the 
background and executes all the operations in a Computer. But there are some 
system software‘s that are used by the end-users like a Device manager which is 
found on Control panel. 

Operating systems like Windows, Mac, Linux, and UNIX are the best examples that 
manage all the programs in a Computer. Since there are other systems software‘s that 
help the OS to perform all the tasks like BIOS (Basic Input/output system) that manages 
data flow between OS and other attached devices such as keyboard, mouse, hard 
drives etc. Boot program loads the Operating system to RAM, an Assembler takes basic 
instructions and converts them to machine language to perform operations and a 
Device manager controls all the devices attached to Computer. The utility software‘s like 
disk derangement, system restore, compilers and debuggers are also installed on the 
Operating system software. 

 Application Software is a program or a group of program designed for the end-
user to perform a specific task in a Computer. The user directly interacts with the 
application programs for performing a task in a system. Some of the applications 
software‘s are browsers, e-mail clients, word processors, spreadsheet, database 
programs and many more that has various built-in functions to be used. 
Furthermore the Applications Software‘s are also broadly categorized for better 
productivity. Some of them are:-   

Application suites are packed with multiple programs with user interfaces, features 
and functions to interact with the users. Some of them are Microsoft Office, Adobe 
Creativity suite, Security suite, Gaming apps and many more. 

Enterprise Software labels the organization requirements and also manages data flow 
in a huge environment. It may be an automated billing system, e-mail marketing, 
business intelligence and Content management. 
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Enterprise Infrastructure Software provides the capabilities required to support 
enterprise software systems. It is mainly used for businesses, society or Organization 
for network security, surveillance system, transportation, sewage, communication, 
electricity and water that need high investment for the systems. 

Educational Software includes all the contents of different subjects that can be used 
by a student or any individuals. There are several websites providing educational 
software about various topics and vast database makes it an easy to use application. 

Multimedia Software is used for development of media in our day to day life. There are 
various audio, video and image editing tools, printing media that can be used to 
maximize the growth of a business. 

Content Access Software is used to access the contents in a website for publishing 
digital contents and entertainment. 

Information Software is used for addressing the needs of an individual by creating and 
managing information for individual projects within the department. It may be the word 
processors, spreadsheets, e-mail or blog clients etc. 

Conclusion: 

Application software is the lifeline for a user as it creates an interface to communicate 
with the Computer by using various application programs. Each and Every application 
program is run by the system software which is the Operating system. You can run 
loads of applications in your Computer and can perform various tasks from creating 
documents to playing games. I hope you like this article about the Computer 
Application and its types, if you have any issues kindly write into my mail. 

Icons 

An icon is a small graphical representation of a program or file. When you double-

click an icon, the associated file or program will be opened. For example, if you were to 

double-click My Computer icon, it would open Windows Explorer. Icons are a 

component of GUI operating systems, including Apple macOS X and Microsoft 

Windows. Icons help users quickly identify the type of file represented by the icon. The 

image is an example of "My Computer" icons in different versions of Microsoft Windows. 

How to create a desktop icon 

1. Press Windows key+D or navigate to the Windows desktop. 

 

2. Right-click any blank space on the desktop. If you're on a laptop, tap the 

trackpad with two fingers at the same time. 

 

https://www.informationq.com/application-and-types-of-computer-applications/
https://www.informationq.com/application-and-types-of-computer-applications/
https://www.informationq.com/application-and-types-of-computer-applications/
https://www.informationq.com/application-and-types-of-computer-applications/
https://www.computerhope.com/jargon/d/doublecl.htm
https://www.computerhope.com/jargon/d/doublecl.htm
https://www.computerhope.com/jargon/e/explorer.htm
https://www.computerhope.com/jargon/g/gui.htm
https://www.computerhope.com/jargon/m/macosx.htm
https://www.computerhope.com/jargon/w/windows.htm
https://www.computerhope.com/jargon/w/windows.htm
https://www.computerhope.com/jargon/m/mycomput.htm
https://www.computerhope.com/jargon/w/winkey.htm
https://www.computerhope.com/jargon/r/righclic.htm
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3. In the drop-down menu that appears, move your mouse cursor over New, 

then select Shortcut. 

 

4. In the window that appears, select Browse... then navigate to the program, 

file, or folder which you'd like to create a shortcut, and then click Ok. 

 

5. In the Create Shortcut window, select Next, then Finish. 

How to create a desktop shortcut to a web page 

1. Press Windows key+D or navigate to the Windows desktop. 

 

2. Right-click any blank space on the desktop. If you're on a laptop, tap the trackpad 

with two fingers at the same time. 

 

3. In the drop-down menu that appears, move your mouse cursor over New, then 

select Shortcut. 

 

4. In the window that appears, type the web address, and then click Next. 

 

5. Type a name for the shortcut, and then click Finish. 

How to arrange desktop icons 

1. Press Windows key+D or navigate to the Windows desktop. 

2.  

3. Right-click any blank space on the desktop. If you're on a laptop, tap the trackpad 

with two fingers at the same time. 

 

4. In the drop-down menu that appears, select Sort by. You should see another 

menu appear to the right. 

 

5. Choose how you'd like the icons arranged, either by Name, Size, Item type, 

or Date modified. 

How to remove a desktop icon 

To remove a desktop icon, single-click it and press the Delete key. 

How to remove unused icons from the Windows desktop 

You may have many icons on your Windows desktop that came from different sources. 

Some were placed there after installing Windows, some appear when a program is 

installed, and others may have been created by you. The method of removing Windows 

https://www.computerhope.com/jargon/d/dropdm.htm
https://www.computerhope.com/jargon/m/mouspoin.htm
https://www.computerhope.com/jargon/w/winkey.htm
https://www.computerhope.com/jargon/r/righclic.htm
https://www.computerhope.com/jargon/d/dropdm.htm
https://www.computerhope.com/jargon/m/mouspoin.htm
https://www.computerhope.com/jargon/a/address.htm
https://www.computerhope.com/jargon/w/winkey.htm
https://www.computerhope.com/jargon/r/righclic.htm
https://www.computerhope.com/jargon/d/dropdm.htm
https://www.computerhope.com/jargon/c/click.htm
https://www.computerhope.com/jargon/d/delete.htm
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desktop icons varies based on how they were made. To proceed, identify the type of 

icon you're trying to remove and follow the steps in the appropriate section. 

General program icons and shortcuts 
 
To delete an icon created by saving a file, the installation of a software program, or 

user-created shortcuts: 

1. Right-click the icon you'd like to delete. 

 

2. In the drop-down menu that appears, select Delete. 

Option 2: 

1. Click the icon with your left mouse button once so that it is highlighted. 

 

2. Press the Delete key on your keyboard. 

Built-in Windows utilities 

To remove the icons for Windows utilities, such as My Computer, Recycle Bin, 

or Control Panel, locate your version of Windows below and follow the steps. 

Windows 8 and 10 users 

1. Right-click on a blank part of the Windows desktop. 

 

2. Select Personalize in the pop-up menu. 

 

3. In the left navigation menu, click on Themes. 

 

4. Under Related Settings, click the Desktop icon settings option. 

 

5. Uncheck the box next to the icon(s) you want to remove, click Apply, and 

then OK. 

Microsoft Windows Vista and 7 users 

1. Right-click on a blank part of the Windows desktop. 

 

2. Select Personalize in the pop-up menu. 

 

https://www.computerhope.com/jargon/r/righclic.htm
https://www.computerhope.com/jargon/d/dropdm.htm
https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/d/delete.htm
https://www.computerhope.com/jargon/m/mycomput.htm
https://www.computerhope.com/jargon/r/recycbin.htm
https://www.computerhope.com/jargon/c/controlp.htm
https://www.computerhope.com/jargon/r/righclic.htm
https://www.computerhope.com/jargon/c/checkbox.htm
https://www.computerhope.com/jargon/r/righclic.htm
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3. In the Personalize appearance and sounds window, click the Change desktop 

icons link on the left side. 

 

4. Uncheck the box next to the icon(s) you want to remove, click Apply, and 

then OK. 

Windows Accessories 

Windows operating system ships with some handy applications known as Windows 
accessories. Calculator, Notepad, Paint, Explorer, WordPad are some of the most 
frequently used accessories. 

Apart from above mentioned applications, Windows has a few tools for Ease of Access 
and some System Tools. We‘ll be briefly talking about them here. 

Calculator 

 

Windows Calculator is a calculating application included in all the versions of Windows. 
It can be used to perform simple calculation, scientific calculation and Programming 
calculation. 

 Choose Start >> Programs >> Accessories >> Calculator to start Calculator 
application, or 
 

 Alternately you can open Run dialog box (Start >> Run) dialog box then 
type calc and hit enter. 

https://www.computerhope.com/jargon/c/checkbox.htm
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 From View menu choose the required type of calculator – Standard, Scientific, 
Programmer, Statistical 
 

 Edit >> Copy and Paste commands can be used to input the numbers into 
calculator or paste the result to other applications 

Calculator was first included with Windows 1.0 as a simple arithmetic calculator. In 
Windows 3.0, a Scientific mode was added, which included exponents and roots, 
logarithms, factorial-based functions, trigonometry (supports radian, degree and 
gradians angles), base conversions (2, 8, 10, 16), logic operations, Statistic functions 
such as single variable statistics and linear regression. 

In Windows 7, separate Programmer, Statistics, Unit Conversion, Date Calculation, and 
Worksheets modes were added. Calculator‘s interface was revamped for the first time 
since its introduction. 

On the right of the main Calculator, one can add a panel with Date Calculation, Unit 
Conversion, and Worksheets. The included Worksheets allow one to calculate a result 
of a chosen field based on the values of other fields. Pre-defined templates include 
calculating a car‘s fuel economy (mpg and L/100 km), a vehicle lease, and a mortgage. 
In pre-beta versions of Windows 7, Calculator also provided a Wages template. 

Snipping Tool 

 

Snipping Tool is another useful of Windows accessories included in Windows 7, 
Windows Vista, and Experience Pack for Windows XP Tablet PC Edition 2005. It was 
originally released as a powertoy for the Tablet PC. The program is a screen-capture 
tool that allows taking screenshots (called snips) of an open window, rectangular areas, 
a free-form area, or the entire screen. Snips can then be annotated using a mouse or a 
tablet, saved as an image file (PNG, GIF, or JPEG file) or an HTML page, or e-mailed. 

The Snipping Tool captures all or part of the computer display screen as a picture. You 
can save the picture and attach it to an e-mail or paste the picture into a document. 
Click the Start button, type snip, and click the Snipping Tool from the search results. 
The screen fades slightly, and the Snipping Tool toolbar appears. 

Snipping tool can be used toPrintScreen, annotate and use in other applications. 
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Paint 

 

Image Source: Wikipedia 
 
 

Paint (formerly Paintbrush for Windows) is a simple graphics painting program that has 
been included with all versions of Microsoft Windows. It is often referred to as MS Paint 
or Microsoft Paint. The program opens and saves files as Windows bitmap (24-bit, 256 
color, 16 color, and monochrome) .BMP, JPEG, GIF. Paintbrush supports GIF without 
animation or transparency. Since Windows 98 Paint supports GIF with transparency. It 
also supports PNG (without alpha channel), and TIFF (without multiple page support). 

The program can be in color mode or two-color black-and-white, but there is no 
grayscale mode. For its simplicity, it rapidly became one of the most used applications 
in the early versions of Windows—introducing many to painting on a computer for the 
first time—and still has strong associations with the immediate usability of the old 
Windows workspace. 
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Character Map 

 

 

Character Map is a utility included with Microsoft Windows operating systems and is 
used to view the characters in any installed font, to check what keyboard input (Alt 
code) is used to enter those characters, and to copy characters to the clipboard in lieu 
of typing them. 

The tool is usually useful for entering special characters. It can be opened via the 
command line or Run Command dialog using the ‗charmap‘ command. 

Notepad 
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Notepad is a common text-only (plain text) editor. The resulting files—typically saved 
with the .txt extension—have no format tags or styles, making the program suitable for 
editing system files that are to be used in a DOS environment. 

Notepad supports both left-to-right and right-to-left based languages, and one can 
alternate between these viewing formats by using the right or left Ctrl+Shift keys to go to 
right-to-left format or left-to-right format, respectively. 

WordPad 

 

Microsoft WordPad is a free rich text editor included with Microsoft Windows 95 and the 
later. Earlier to Windows 95 there used to be an application called Write for the same 
task. Although capable of doing much more than Notepad, WordPad is not as advanced 
as Microsoft Word. 

WordPad can format and print text, but lacks intermediate features such as a spell 
checker, thesaurus, and support for tables. As such, it is suitable for writing letters or 
short pieces, but underpowered for work that relies heavily on graphics or typesetting. 

System Tools 

For a smooth performance of a system, periodic maintenance is necessary. Tools like 
Disk Check, Disk Derangement, etc., helps in system maintenance. Windows includes 
some of the system utilities such as Disk Cleanup, Disk Defragment, System Restore, 
Control Panel and so on. 
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Disk Cleanup 

 

In Windows 7, Vista, and XP, Disk Cleanup frees disk space by cleaning areas that 
gather unneeded files. Using Disk Cleanup regularly, along with ScanDisk, DEFRAG, 
and up-to-date virus patterns, will help keep your computer running smoothly. 

To run Disk Cleanup: 

 From the Start menu, select Programs or All Programs, then Accessories, then 
System Tools, and then Disk Cleanup. 

 Select the drive on which you would like to clear disk space (usually your C: 
drive), and click OK. 
 

 Select from the four areas that Disk Cleanup will check and clean up: 

Temporary Internet Files: Files stored on your local drive that allow web pages to load 
more quickly 
 
Downloaded Program Files: A storage location for programs downloaded when you 
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visit specific web sites that use ActiveX and Java applets 
Recycle Bin: Files that have been marked as deleted 
Temporary Files: Items in the TEMP folder 

Disk Defragment 

 

Disk Defragmenter consolidates files so that each is saved in contiguous physical space 
on the hard drive. When your computer crashes or freezes, the drive becomes 
fragmented. This means the files may be broken up and stored in different locations in 
your computer. This causes programs and files to run more slowly. 

To run Disk Defragmenter: 

 Close all programs. 
 

 Choose Start menu | All Programs | Accessories | System Tools | Disk 
Defragmenter. 
 

 Select the drive you want to clean and click OK. 
 

 Click Analyze. This may take several minutes. 
 

 Click Close or Defragment. If the drive needs defragmented and you choose 
Defragment, this may take several minutes to several hours, depending on the 
number of files to consolidate. 
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System Restore 

 

System restore is a feature of Windows that allows you to roll back the system to the 
same configuration it had at an earlier time. If this feature is turned on (which it is by 
default) Windows will take periodic snapshots (called restore points) of your installation. 
It can use the information gathered in these snapshots to restore your system to a 
previous configuration. It is a good idea to create a restore point before you make major 
changes to your system, such as before installing new hardware or doing any major 
updates. 

To run System Restore: 

 Go to Start > Programs > Accessories > System Tools > System Restore. 
 

 The System Restore screen will com up. 
 

 Follow the on screen instructions 
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Format 

 

There are times when Windows becomes so damaged or so compromised by hackers 
and Trojan programs that the only thorough solution is to essentially start all over. This 
is accomplished by formatting your hard drive, which means erasing all of the programs 
and the data on your machine, and re-installing Windows. 

The format creates a new root directory and file system for the disk. It can also check 
for bad areas on the disk, and it can delete all data on the disk. To be able to use a new 
disk, you must first use this command to format the disk. 

Control Panel 

The Control Panel is a part of the Microsoft Windows graphical user interface. It allows 
users to view and manipulate basic system settings and controls via applets. You can 
use control panel for the tasks such as adding hardware, adding and removing 
software, controlling user accounts, and changing accessibility options. Additional 
applets can be provided by third party software. 
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In recent versions of Windows, the Control Panel has two views, Classic View and 
Category View, and it is possible to switch between these through an option that 
appears on either the left side or top of the window. 

The classic view consists of shortcuts to the various control panel applets, usually 
without any description (other than the name). The categories are seen if the user use 
―Details‖ view. 

The category view consists of categories, which when clicked on display the control 
panel applets related to the category. In Windows Vista, the category used applets 
below the name of the category. 

Windows XP provides several accessories, or applications, that you can use to help you 
in your work. These accessories are not full-featured programs, but they are useful for 
specific jobs in the Windows environment. Accessories include a calculator, a painting 
program, a word processor, a text editor, and Internet applications. (Internet 
applications are discussed in Part 8, "Connecting to the Internet.") 

Tasks 

1. Using Calculator 

2. Using Command Prompt 

3. Using WordPad 

4. Typing Text 

5. Selecting Text 

6. Deleting Text 

7. Copying Text 

8. Moving Text 

9. Formatting Text 

10. Using Notepad 

11. Using Paint 

12. Drawing a Shape with Paint 

13. Adding Text to a Drawing 

14. Adding Color to a Drawing 

15. Erasing Part of a Drawing 
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Notepad 

You‘ve probably seen Notepad on your Windows computer or device. Did you wonder 

about what it is and what it does? This is a very old app that has been present in 

Windows operating systems for decades. Although it keeps mostly the same 

appearance in all Windows versions, lately, in Windows 10, it has received more 

attention from Microsoft. In this article, we‘re going to show you what Notepad is and 

how to use it. If you want to learn about it, read on: 

What is Notepad? What is Notepad used for? 
 
Notepad is a basic text editor that‘s built into Windows. It is excellent for writing 
relatively short text documents that you want to save as plain text. However, that‘s not 
all you can do with it. If you have not used Notepad much, or ever, you may be 
surprised by how easy it is to work with. 
Notepad looks and works mostly the same in Windows 10 and older versions of 
Microsoft‘s operating systems such as Windows 7. The main differences are related to 
how you open the application in different operating systems, and you can learn more 
about that in this tutorial: 11 ways to start Notepad in Windows (all versions). When you 
open Notepad, you get to see this no-frills screen: 

 

https://www.digitalcitizen.life/start-notepad-windows
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Notepad in Windows 10 

Nothing more is needed, since Notepad has a limited set of options. At the top of the 
window, you should see menus for File, Edit, Format, View, and Help. Let‘s take a look 
at what you can do with Notepad. Everything should be reassuringly familiar, but keep 
in mind that Notepad is just a text editor. If you try to paste graphics into it, it does not 
work. 
 

1. Create, open, and save text files with Notepad 
 
The choices you have in the File menu are New, New Windows, Open, Save, Save As, 
Page Setup, and Print. As you can see, many of these commands have keyboard 
shortcuts as well. You might already be familiar with some of them since they are the 
same in nearly every Windows application. 

 

The File menu from Notepad 

Creating and saving text documents in Notepad is simple: open Notepad, start typing, 
and then edit and format the text as you see fit. Once you are finished, use the Save 
As command to save your work. The default folder is the OneDrive folder in Windows 
10, and the My Documents folder in Windows 7. You can change this quite easily: use 
the Save As command, browse to your preferred folder, and click Open. Notepad will 

https://www.digitalcitizen.life/what-is-onedrive
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remember your choice. Keep in mind that your files are saved with a .txt extension and 
in plain text. 

 

Saving a document with Notepad 

2. Use Notepad to make simple text edits 
 
The Edit menu offers a few choices, but again, everything on this menu should be 
familiar to anyone who has used Windows. All the Edit choices have associated 
keyboard shortcuts. Note that most of the commands are greyed out until there is text 
selected in the Notepad window. 
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Notepad‟s Edit menu 

The first item on the Edit menu is Undo/Redo, which can be useful when you are editing 
the document. What appears in this place depends on what you have been doing. If you 
have just used the Undo command or pressed Ctrl + Z, you should see 
the Redo command at the top of the list (and its keyboard shortcut, Ctrl + Y). 
 

3. Search and replace text in Notepad documents 
 
Find, Find Next, and Replace are used to search and replace text in the document, 
while Go To can be used to navigate through it. To search for or replace a piece of text, 
select the Find option (keyboard shortcut Ctrl + F) or the Replace (Ctrl + H) option, 
depending on what you want. That makes Notepad open a box where you can type the 
text you‘re looking for in the ―Find what‖ field. If you want to replace text, 
the Replace window also gives you a ―Replace with‖ field. Either way, 
both Find and Replace include the same few search options: 

 

Using Notepad to find text in a document 

You can decide whether the search should ―Match case‖ the text and choose 
the Direction to be either Down or Up. Down means that the search is made starting 
from where your cursor is inside the text document until the end of the 
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document. Up, on the other hand, performs the search from the cursor‘s position 
upwards, up to the beginning of the document. Unfortunately, neither option ensures 
that a search is done on the entire document unless you‘ve placed the cursor at either 
the start or the end of the document. 

 

Choosing the search direction in Notepad 

Fortunately, you can ensure that your searches are performed on the entire document, 
from beginning to the end, by selecting the ―Wrap around‖ setting. When Wrap 
around is on, Notepad uses your other search options too. However, if the Direction is 
set to Down, when it reaches the end of the document, Notepad automatically continues 
the search from the beginning and never stops. Similarly, if you set the Direction to Up, 
when the search reaches the beginning of the document, Wrap around automatically 
continues the search from the end of the document. 
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The Wrap around setting from Windows 10‘s Notepad 

Go To is a less familiar command. You use Go To for jumping to a particular numbered 
line in the document. Go To only works if Word Wrap is turned off. If Word Wrap is on*, 
Go To* is greyed out. 
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The Go To function from Notepad 

4. Turn Word Wrap on or off 
 
The Format menu offers you only two choices: Word Wrap and Font. For some 
unknown reason, Notepad has always come with Word Wrap turned off. This means 
everything you type ends up on one long line until you press Enter, which starts another 
long line. 

 

Word Wrap in Notepad 

You have the option of pressing Enter when your typing approaches the right margin of 
the Notepad window, but that makes the lines some arbitrary length depending on the 
size of your window. If you would like to see what you are typing without having to scroll 
all the way to the right, turn Word Wrap on. Then Notepad should behave just like any 
other word processing program and automatically wrap the text to the next line as you 
approach the right margin of your window. 
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A document in Notepad displayed with Word Wrap 

In Windows 7, the Status Bar (which you can enable or disable from the View menu) is 
also linked with Word Wrap. If Word Wrap is off, you can see a notification on the lower 
border of your window, showing you where the cursor is currently located in a document 
that is not word-wrapped. If Word Wrap is on, the lower border is blank. In Windows 10, 
the Status Bar is on by default and shows line and column numbers regardless of 
whether you‘re using Word Wrap or not. 

 

Line and column numbers are shown in the Status Bar from Notepad 
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5. Zoom in and zoom out in Notepad (only in Windows 10) 
 
If you‘re using Windows 10 with May 2020 Update or newer, Notepad also has another 
nifty feature: text zooming. You can use this feature to increase or decrease the size of 
the text so that it‘s easier to see on your screen. 
 
To zoom text, open the View menu from the top of the Notepad window, select Zoom, 
and click or tap on Zoom In or Zoom Out. Repeat the same steps to further increase or 
decrease the zoom level. To go back to the normal zoom level, select ―Restore Default 
Zoom‖ from the same menu. 

 

Zoom settings in Notepad for Windows 10 

Also, for a faster experience, you might want to remember that you can also use these 
keyboard shortcuts for adjusting the zoom level in Notepad: 

 Zoom In – Ctrl + Plus 
 Zoom Out – Ctrl + Minus 
 Restore Default Zoom – Ctrl + 0 

6. Change the font of the text document 
The Font choice is self-explanatory: it offers you a list of all your installed fonts and the 
option to use bold, italic, and the like. However, unlike the way it works in programs 
like Microsoft Word, a change of font immediately affects the entire document. You 

https://www.digitalcitizen.life/windows-10-20h1-update


153 
 

cannot use one font in one part of the document and another font somewhere else. It is 
all or nothing. 

 

Font options in Notepad 

In the Font menu, there is a less familiar option available, the drop-down menu 
labeled Script. This lets you choose characters that are not available in the standard 
―Western‖ style fonts. The choices are Western, Greek, Turkish, Baltic (not available in 
Windows 7), Central European, Cyrillic, and Vietnamese (not available in Windows 7). 
Choose a set, and you should see some representative characters above it. 
The Western set is selected by default, and you need to change it to another one if 
necessary. 
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Font Script options in Notepad 

7. Print text files with Notepad 
 
If there is nothing else that you want to customize in the document that you‘re printing, 
open the File menu, and click or tap Print. If you do want to customize the print, first 
click or tap on Page Setup in the File menu. 
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Page Setup and Print in Notepad 

In more sophisticated programs, Page Setup offers a long list of options. 
In Notepad, though, your choices are simple. You can choose the paper size and where 
your printer keeps the paper, the page orientation, and whether to have a header and 
footer (and the text to include in each). 



156 
 

 

Page Setup settings available in Notepad 

By default, in Windows 10, there‘s no header or footer printed. In Windows 7, the text in 
the header is the name of the document and the date it was printed, and the text in the 
footer is the page number. If you want to customize the header and footer, type the 
texts you want to use for them. Note that you can also use some codes for printing the 
current date, time, name of the document, or page numbers. To see all the codes, click 
or tap on the Input Values link from the Page Setup window, or visit this page: Changing 
Header and Footer Commands in Notepad. 
 
8. Save text files using different encodings 
 
You can also use Save As to change the encoding of your file to match a particular 
character set. Here, a bit of text from our Romanian site digitalcitizen.ro has been cut 
and pasted into Notepad. 

https://support.microsoft.com/en-us/help/4009791/windows-10-changing-header-footer-commands-in-notepad
https://support.microsoft.com/en-us/help/4009791/windows-10-changing-header-footer-commands-in-notepad
https://www.digitalcitizen.ro/


157 
 

 

A document with Central European characters, created in Notepad 

If you were to try to save this in ANSI encoding, which is the default option in 
the Notepad from Windows 7 and old versions of Windows 10, you would get a 
message that if you save it as plain text, all the formatting would be lost. 
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Saving a document in ANSI encoding can lose characters 

You have to choose the appropriate encoding from the drop-down list. This might take a 
little experimentation to get right, depending on the types of characters in the file, but 
starting with Unicode is a good bet. If you are not familiar with encoding, the first section 
of this tutorial should help explain it: Make Windows correctly display characters from 
languages other than English (set non-Unicode programs). 

 

Choosing UTF-8 encoding for a document saved with Notepad 

9. Save documents as HTML files 
 
You can also use Notepad to create HTML files. Make sure that Word Wrap is turned on 
and type your HTML code the way you would type plain text. When it comes time to 
save your work, choose Save As, and select All Files from the list of choices. Then save 
your file with the .htm or .html extension. 

https://www.digitalcitizen.life/changing-display-language-used-non-unicode-programs
https://www.digitalcitizen.life/changing-display-language-used-non-unicode-programs
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Saving a document as an HTML file with Notepad 

Do you use Notepad for (light) text editing? 
 
Notepad has been around for a long time and continues to be a useful desktop app for 
writing simple text and HTML. Sometimes, that is all you need. If you require more than 
just the basics, WordPad might be a better choice. It is built into all versions of 
Windows, too! Do you use Notepad regularly? If you do, please tell us how you find it 
useful in the comments below. 
 
Paintbrush 
Microsoft Paint (frequently called MS Paint; formerly Paintbrush for Windows) is a 

simple graphics painting program that comes bundled with all modern versions 

of Microsoft Windows. Its original copyright dates to 1985. 

The program opens and saves files as Windows bitmap (24-bit, 256 color, 16 color, 

and monochrome, all with the .bmp extension), JPEG, GIF, PNG, and TIFF. Older 

https://www.digitalcitizen.life/how-work-new-wordpad
https://graphics.fandom.com/wiki/Computer_graphics
https://graphics.fandom.com/wiki/JPEG
https://graphics.fandom.com/wiki/GIF
https://graphics.fandom.com/wiki/PNG
https://graphics.fandom.com/wiki/TIFF
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versions cannot open or edit PNG files, and can only open GIF, JPEG, and TIFF files 

with a graphics filter for the specific file type. In addition, newer versions no longer 

support the PCX format, or some older special formats like RLE. Furthermore, the 

newer versions do not support the older MSP file format, readable by Paintbrush 

in Windows 3.x and used with versions of Paint in Windows version 1 and 2. 

The program can be in color mode and in monochrome mode (in the sense of having 

no shades of grey). Thus for shades of grey the color mode is used. Alternatively, in 

monochrome mode, shades of grey simulated by patterns of black dots, in various 

densities, can be painted. 

However, there is no option to convert real grey to this simulated grey. When loading an 

image with shades of grey, the program automatically goes into color mode. 

Tools and functions 

New versions of Microsoft Paint allow the user to pick up to three colors at a time: the 

primary color (left mouse click), secondary color (right mouse click), and tertiary color 

(control key + any mouse click). The tertiary color function seems to be present, but 

deactivated or left undeveloped, in the older versions. 

The program comes with the following options in its Tool Box: Free-Form Select, Select, 

Eraser/Color Eraser, Fill With Color, Pick 

Color, Magnifier, Pencil, Brush, Airbrush, Text, Line, Curve, Rectangle, Polygon, Ellipse, 

and Rounded Rectangle. MS Paint does not have the ability to automatically create 

color gradients. 

The "Image" menu offers the following options: Flip/Rotate, Stretch/Skew, Invert Colors, 

Image Attributes, Clear Image, and Draw Opaque. The "Colors" menu allows the user to 

Edit Colors (only menu option under Colors). The Edit Colors dialog box shows a 48-

color palette and 12 custom color slots that can be edited. Clicking "Define Custom 

Colors" displays a square version of the color wheel that can select a custom color 

either with a crosshair cursor (like a "+"), by Hue/Saturation/Luminance, or by 

Red/Green/Blue values. 

The default colors in the Color Box could be described as the following 

colors: Black, White, Gray, Silver, Maroon, Red, Olive, Yellow, Dark 

Green, Green, Teal, Cyan, Navy blue, Blue, Purple, Magenta, Old 

Gold, Lemon Yellow, Slate grey, Kelly green, Dark Carolina blue, Aquamarine, Midnight 

blue, Periwinkle, Violet-blue, Coral, and Pumpkin orange. A colour pallette is also 

avalible. 

https://graphics.fandom.com/wiki/Color
https://graphics.fandom.com/wiki/B%C3%A9zier_curve
https://graphics.fandom.com/wiki/Polygon
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MS Paint also has a few hidden functions not mentioned in the help file: a "stamp 

mode", "trail mode" and "10x Zoom". 

For the stamp mode, the user can select part of the image, hold the control key, and 

move it to another part of the canvas. This, instead of cutting the piece out, creates a 

copy of it. The process can be repeated as many times as desired, as long as the 

control key is held down. The trail mode works exactly the same, but it uses the shift 

key instead of the control key. 10x Zoom can be accessed by clicking right below the 8x 

Zoom button (there is a line about 2 pixels high. Click that to obtain 10x Zoom.) It may 

be a removed feature. 

Uses 

Despite its simplicity, Microsoft Paint is still widely used, especially for oekaki and pixel 

artists since both forms of art require minimal resources. 

 

Negative implications 

Because of its simplicity and the fact that it has been bundled with every version of 

Windows to date, Microsoft Paint is usually associated with the concept of a newbie or 

otherwise inexperienced or clueless user, and images and drawings of poor quality are 

usually labelled as "made with Paint" in a somewhat derogatory manner. In the past, 

there have been shareware Windows programs featuring graphics drawn with MS Paint, 

which were easy to recognize because of their rough outlines and flat coloring with no 

gradients or color smoothing, typical of Microsoft Paint drawings made in a hurry, since 

those effects are not automated. Intentionally horrible images are also considered to be 

Microsoft Paint creations, although the connotation is more lighthearted and humorous. 

Despite this, experienced artists (especially pixel and oekaki, as mentioned before) can 

indeed create high quality images with the program. 
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UNIT-V 

 

 

Editors and Word Processors 

Basic Concepts 

1.1 INTRODUCTION  

A computer is a programmable machine designed to perform arithmetic and logical 
operations automatically and sequentially on the input given by the user and gives the 
desired output after processing. Computer components are divided into two major 
categories namely hardware and software. Hardware is the machine itself and its 
connected devices such as monitor, keyboard, mouse etc. Software are the set of 
programs that make use of hardware for performing various functions.  

1.2 OBJECTIVES  

After going through this lesson you would be able to:   

familiarise yourself with characteristics of computers 

  identify the basic components of a computer 

  explain the importance of various units of a computer 

  differentiate between system software and application 

 software  explain the importance of operating system 

  get acquainted with open source 

  appreciate the need of computer security 
 
 

1.3 CHARACTERISTICS OF COMPUTERS  

The characteristics of computers that have made them so powerful and universally 
useful are speed, accuracy, diligence, versatility and storage capacity. Let us discuss 
them briefly. 

Speed  

Computers work at an incredible speed. A powerful computer is capable of performing 
about 3-4 million simple instructions per second.  
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Accuracy  

In addition to being fast, computers are also accurate. Errors that may occur can almost 
always be attributed to human error (inaccurate data, poorly designed system or faulty 
instructions/programs written by the programmer)  

Diligence  

Unlike human beings, computers are highly consistent. They do not suffer from human 
traits of boredom and tiredness resulting in lack of concentration. Computers, therefore, 
are better than human beings in performing voluminous and repetitive jobs.  

Versatility  

Computers are versatile machines and are capable of performing any task as long as it 
can be broken down into a series of logical steps. The presence of computers can be 
seen in almost every sphere – Railway/Air reservation, Banks, Hotels, Weather 
forecasting and many more.  

Storage Capacity  

Today‘s computers can store large volumes of data. A piece of information once 
recorded (or stored) in the computer, can never be forgotten and can be retrieved 
almost instantaneously. 

Examples:  

MS-Word:- Sometimes called Winword, MS Word, or Word, Microsoft Word is a word 

processor published by Microsoft. It is one of the office productivity applications 

included in the Microsoft Office suite. Originally developed by Charles Simonyi 

and Richard Brodie, it was first released in 1983. 

Microsoft Word is available for Microsoft Windows, Apple macOS, Android, and Apple 

iOS. It can also run on the Linux operating system using WINE. 

What is Microsoft Word used for? 

Microsoft Word allows you to create professional-quality documents, reports, letters, 

and résumés. Unlike a plain text editor, Microsoft Word has features including spell 

check, grammar check, text and font formatting, HTML support, image support, 

advanced page layout, and more. 

What does the Microsoft Word editor look like? 

Below is an overview of a Microsoft Word 2010 document. 

https://www.computerhope.com/jargon/w/word-processor.htm
https://www.computerhope.com/jargon/w/word-processor.htm
https://www.computerhope.com/comp/msoft.htm
https://www.computerhope.com/jargon/o/office.htm#msoffice
https://www.computerhope.com/people/richard_brodie.htm
https://www.computerhope.com/history/1983.htm
https://www.computerhope.com/jargon/w/windows.htm
https://www.computerhope.com/jargon/m/macos.htm
https://www.computerhope.com/jargon/a/android.htm
https://www.computerhope.com/jargon/i/ios.htm
https://www.computerhope.com/jargon/i/ios.htm
https://www.computerhope.com/jargon/l/linux.htm
https://www.computerhope.com/jargon/w/wine.htm
https://www.computerhope.com/jargon/p/plaintex.htm
https://www.computerhope.com/jargon/s/spelchec.htm
https://www.computerhope.com/jargon/s/spelchec.htm
https://www.computerhope.com/jargon/g/grammarc.htm
https://www.computerhope.com/jargon/f/font.htm
https://www.computerhope.com/jargon/h/html.htm
https://www.computerhope.com/jargon/p/page-layout.htm
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Where do you find or start Microsoft Word? 

If you have Microsoft Word or the entire Microsoft Office package installed on Microsoft 

Windows, you can find Microsoft Word in your Start menu. 

Keep in mind that new computers do not include Microsoft Word. It must be purchased 

and installed before running it on your computer. If you do not want (or cannot afford) to 

purchase Microsoft Word, you can use a limited version for free at the Microsoft Office 

website. 

If Microsoft Word is installed on your computer, but you can't find it in your Start menu, 

use the following steps to launch Microsoft Word manually. 

https://www.computerhope.com/jargon/s/startmen.htm
https://www.office.com/
https://www.office.com/
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1. Open My Computer. 

 

2. Click on or select the C: drive. If Microsoft Office is installed on a drive 

other than the C: drive, select that drive instead. 

 

3. Navigate to the Program Files (x86) folder, then the Microsoft 

Office folder. 

 

4. In the Microsoft Office folder, if there is a root folder, open that folder. 

Then open the OfficeXX folder, where XX is the version of Office (e.g., 

Office16 for Microsoft Office 2016). If there is no root folder, look for and 

open a folder having "Office" in the name. 

 

5. Look for a file named WINWORD.EXE and click or double-click that file to 

start the Microsoft Word program. 

What are the uses of Microsoft Word? 

Microsoft Word is a word processor, and, like other word processors, it's capable of 

helping users create a variety of different types of documents. For example, users can 

create a résumé, business contract, instruction document, or a letter to another person. 

We've included a list of the top uses of a word processor on our word processor page. 

How many lines are there on a page in Microsoft Word? 

By default, there are 29 lines on one page in Microsoft Word. 

What type of files can Microsoft Word create and use? 

Early versions of Microsoft Word primarily created and used the .doc file extension, 

while newer versions of Word create and use the .docx file extension. 

More recent versions of Microsoft Word can create and open the following types of files: 

.doc, .docm, .docx 

.dot, .dotm, .dotx 

.htm, .html 

.mht, .mhtml 

.odt 

.pdf 

https://www.computerhope.com/jargon/m/mycomput.htm
https://www.computerhope.com/jargon/w/word-processor.htm
https://www.computerhope.com/jargon/f/fileext.htm
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.rtf 

.txt 

.wps 

.xps 

.xml 

Example of a Microsoft Word .doc file 

You can download an example of a Microsoft Word .doc document by clicking 

the Microsoft Word .doc file link. 

Why use Word instead of a plain-text editor? 

Microsoft Word offers many features not found in a traditional text editor or a plain-

text file. Reasons to use Microsoft Word instead of a plain-text editor include the ability 

to change the formatting (e.g., center), change the font type, size, and color, insert 

pictures, and much more. 

Why use Word instead of a WordPad? 

A rich-text editor, like WordPad, offers many of the same basic features as Microsoft 

Word. Where Microsoft Word differs is the ability to do more advanced features. Some 

of the advanced features include mail 

merges, spellchecker, styles, tables, headers & footers, WordArt, columns, margins, 

and more. 

What are the different versions of Microsoft Word? 

Microsoft Word has had several versions throughout its history. The different releases, 

along with release dates are listed below. 

Introduction to desktop 

The desktop lies behind all of the other components in your desktop environment. The 
desktop is an active component of the user interface. You can perform the following 
tasks from your desktop: 

 Start your applications, and open your files and folders. 

You can add desktop objects for convenient access to files, folders, and 
applications that you use frequently. For example, you can add an application 
launcher to the desktop. You can create a symbolic link to a file that you use 

https://www.computerhope.com/jargon/w/example.doc
https://www.computerhope.com/jargon/e/editor.htm
https://www.computerhope.com/jargon/p/plaintex.htm
https://www.computerhope.com/jargon/p/plaintex.htm
https://www.computerhope.com/jargon/f/format.htm
https://www.computerhope.com/jargon/c/center.htm
https://www.computerhope.com/jargon/f/font.htm
https://www.computerhope.com/jargon/r/rtf.htm
https://www.computerhope.com/jargon/w/wordpad.htm
https://www.computerhope.com/jargon/m/mailmerg.htm
https://www.computerhope.com/jargon/m/mailmerg.htm
https://www.computerhope.com/jargon/s/spelchec.htm
https://www.computerhope.com/jargon/s/style.htm
https://www.computerhope.com/jargon/t/table.htm
https://www.computerhope.com/jargon/h/header.htm
https://www.computerhope.com/jargon/f/footer.htm
https://www.computerhope.com/jargon/w/wordart.htm
https://www.computerhope.com/jargon/c/column.htm
https://www.computerhope.com/jargon/m/margin.htm
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often, then add this link to your desktop. You can also store files and folders on 
the desktop. 

 Open the Desktop menu. 

Right-click on the desktop to open the Desktop menu. You can use the Desktop 
menu to perform actions on the desktop. 

 Work with Trash. 

You can move objects to Trash and empty your Trash. 

 Customize your desktop background. 

You can customize the pattern or color of the desktop background. 

By default, your desktop contains three objects. 

Publishing 

With desktop publishing software and hardware you can: 

 Design print communications such as brochures, fliers, ads, and posters. 
 

 Design print communications such as catalogs, directories, and annual reports. 
 

 Design logos, business cards, and letterhead. 
 

 Design and publish newsletters, magazines, and newspapers. 
 

 Design books and booklets. 
 

 Convert print communications to formats for the web and smart devices such 
as tablets and phones. 
 

 Create resumes and business forms including invoices, inventory sheets, 
memos, and labels. 
 

 Self-publish books, newsletters, and e-books. 
 

 Design and publish blogs and websites. 
 

 Design slides shows, presentations, and handouts. 
 

 Create and print greeting cards, banners, postcards, candy wrappers, and iron-
on transfers. 

https://www.lifewire.com/booklet-design-basics-1077960
https://www.lifewire.com/what-is-a-tablet-4157433
https://www.lifewire.com/iron-on-transfers-for-tshirts-1079024
https://www.lifewire.com/iron-on-transfers-for-tshirts-1079024
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 Make digital scrapbooks and print or digital photo albums. 
 

 Create decorative labels, envelopes, trading cards, calendars, and charts. 
 

 Design packaging for retail merchandise from wrappers for bars of soap to 
software boxes. 
 

 Design store signs, highway signs, and billboards. 
 

 Take work designed by others and putting it into the correct format for digital or 
offset printing or for publishing online. 
 

 Create more attractive, readable reports, posters, and print or on-screen 
presentations for school or business. 

How Desktop Publishing Has Changed 

In the '80s and '90s, desktop publishing was for print almost exclusively. Today, desktop 
publishing includes much more than just print publications. It's publishing as PDF or an 
e-book. It's publishing to blogs and designing websites. It's designing content for 
multiple platforms, including smartphones and tablets. 

Desktop publishing is the technical assembly of digital files in the proper format for 
printing or for electronic distribution. In practical use, much of the graphic design 
process is also accomplished using desktop publishing, graphics software, and web 
design software and is sometimes included in the definition of desktop publishing. 

Comparison of desktop publishing, graphic design, and web design: 

 Desktop publishing is the process of using the computer and specific types of 
software to combine text and graphics to produce documents such as 
newsletters, brochures, books, and web pages. 

 Graphic design uses text and graphics to communicate an effective message in 
the design of logos, graphics, brochures, newsletters, posters, signs, and other 
types of visual communication.  

 Web design is a spin-off of graphic design and desktop publishing that focuses 
exclusively on visual communications for display on websites and mobile devices 
– to include text, graphics, sound, animation, and video.  

Someone who does print design may or may not also do web design. Some web 
designers have never done any type of print design. 

The Present and Future of Desktop Publishing 

https://www.lifewire.com/best-graphic-design-software-1078921
https://www.lifewire.com/texture-in-graphic-design-1697500
https://www.lifewire.com/logo-design-basics-1078575
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At one time, only professional graphic designers used desktop publishing software. 
Then along came consumer-level desktop publishing software and an explosion of 
people who did desktop publishing for fun and profit, with or without a background in 
traditional design. Today, desktop publishing is still a career choice for some, but it is 
also increasingly a required skill for a wide range of jobs and careers. 

Spreadsheets and Database packages  
Purpose 

Spreadsheets are an essential business and accounting tool. They can vary in 

complexity and can be used for various reasons, but their primary purpose is to 

organize and categorize data into a logical format. Once this data is entered into the 

spreadsheet, you can use it to help organize and grow your business. 

Business Data Storage 

A spreadsheet is an easy way to store all different kinds of data. These data types can 
include financial data, customer data and product data. Excel spreadsheets can 
support more than a million rows and more than 16,000 columns, so you‘ll have plenty 
of space to store a huge amount. That‘s what makes them ideal for database creation. 

Accounting and Calculation Uses 

Businesses across the world use spreadsheets to keep track of their business 
accounts. You can enter formulas that will do all of your business calculations as you 
go without the expense of using accounting software. Spreadsheets will do all the 
calculations for you, which saves you having to do those calculations manually. 

Budgeting and Spending Help 

Keep track of your business spending on a spreadsheet. You can create custom 
budget spreadsheets to manage your income and your expenditures so you don‘t end 
up with any surprises when it‘s time to file your tax return. 

Assisting with Data Exports 

Spreadsheets can be used to contain data that has been exported from other systems. 
Sometimes online data management systems don‘t present data in a format that is 
easy to read, or it is difficult to access the data offline. 

Data Sifting and Cleanup 

Use your spreadsheets to identify inaccuracies and duplicates in your data. With a 
spreadsheet, it‘s easy to get rid of unwanted or low quality data. This is especially 
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necessary in relation to customer data, which you are required to keep up to date and 
accurate. 

Generating Reports and Charts 

Use spreadsheets to report trends or make business forecasts. These reports can be 
made available to everyone at the company; they can take the time to analyze the 
data for themselves. It‘s easy to make comparisons between sets of data. You can 
pivot tables to showcase particular aspects of your data as well, which is necessary 
when you‘ve got huge amounts of data to sort through. 

Data in a spreadsheet can be used to create charts that can then be used for 
reporting. You can create graphs and pie charts that condense the data in a format 
that‘s easy to read at a glance. It‘s a fantastic feature that can be great for business 
presentations that require you to showcase lots of data in a short time. 

Business Administrative Tasks 

Use spreadsheets for the creation of receipts and invoices. You can also use it to do 
business related forecasts and plan ahead for the future. 

These are some of the common purposes spreadsheets are used for, but there are 
additional ways you can utilize a spreadsheet to achieve your business goals. 
Configure them to your needs, and tap into all the ways you can use this simple yet 
effective tool. 

 

Usage 

Although spreadsheets are most often used with anything containing numbers, the uses 

of a spreadsheet are almost endless. Below are some other popular uses of 

spreadsheets. 

Finance 

Spreadsheets are ideal for financial data, such as your checking account information, 

budgets, taxes, transactions, billing, invoices, receipts, forecasts, and any payment 

system. 

Forms 

Form templates can be created to handle inventory, evaluations, performance reviews, 

quizzes, time sheets, patient information, and surveys. 
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School and grades 

Teachers can use spreadsheets to track students, calculate grades, and identify 

relevant data, such as high and low scores, missing tests, and students who are 

struggling. 

Lists 

Managing a list in a spreadsheet is a great example of data that does not contain 

numbers, but still can be used in a spreadsheet. Great examples of spreadsheet lists 

include telephone, to-do, and grocery lists. 

Sports 

Spreadsheets can keep track of your favorite player stats or stats on the whole team. 

With the collected data, you can also find averages, high scores, and statistical data. 

Spreadsheets can even be used to create tournament brackets. 

How do I enter data in a spreadsheet? 

In a spreadsheet, data is entered in one or more cells. To enter data in a cell, follow the 

steps below. 

Click the cell where you want to enter data. 

Start typing the data using your keyboard. The data is automatically entered in the 

selected cell. 

or 

Click the cell where you want to enter additional data. 

Click in the formula bar, located between the Ribbon and all cells, where you want to 

start entering the additional data. 

Type the data using your keyboard. The data is automatically entered in the selected 

cell. 

https://www.computerhope.com/jargon/c/cell.htm
https://www.computerhope.com/jargon/f/formulab.htm
https://www.computerhope.com/jargon/r/ribbon.htm
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If you want to add additional data to a cell that already has data entered in it, follow the 

steps below. 

Click the cell where you want to enter additional data. 

Click in the formula bar, located between the Ribbon and all cells, where you want to 

start entering the additional data. 

Type the data using your keyboard. The data is automatically entered in the selected 

cell where the mouse cursor is placed in the formula bar. 

Why not use a word processor instead of a spreadsheet? 

Although some uses above could be done in a word processor, spreadsheets have a 

considerable advantage over word processors when it comes to numbers. It would be 

impossible to calculate multiple numbers in a word processor and have the value of the 

calculation immediately appear. Spreadsheets are also more dynamic with the data and 

can hide, show, and sort information to make processing lots of information easier. 

What is an active worksheet? 

An active worksheet is the worksheet that is currently open. For example, in the earlier 

Excel picture, the sheet tabs at the bottom show "Sheet1," "Sheet2," and "Sheet3," 

with Sheet1 being the active worksheet. The active tab usually has a white background 

behind the tab name. 

How many worksheets open by default? 

In Microsoft Excel 2016 and earlier and OpenOffice Calc, by default, there 

are three sheet tabs that open (Sheet1, Sheet2, and Sheet3). In Google Sheets, your 

spreadsheets starts with one sheet (Sheet1). 

In Microsoft Excel 365, by default, there is only one sheet tab that opens (Sheet1). 

https://www.computerhope.com/jargon/f/formulab.htm
https://www.computerhope.com/jargon/r/ribbon.htm
https://www.computerhope.com/jargon/w/word-processor.htm
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What is the length limit of a worksheet name? 

Not to be confused with the file name, in Microsoft Excel, there is a 31 character limit for 

each worksheet name. 

How are rows and columns labeled? 

In all spreadsheet programs, including Microsoft Excel, rows are labeled 

using numbers (e.g., 1 to 1,048,576). All columns are labeled with letters from A to Z, 

then with two letters. For example, after the letter Z, the next column is AA, AB, AC, ..., 

AZ and then incrementing to BA, BB, BC, etc., to the last column XFD. 

When working with a cell, you combine the column with the row. For example, the very 

first cell is in column A and on row 1, so the cell is labeled as A1. 

How many sheets, rows, and columns can a spreadsheet have? 

Download an example of a spreadsheet file 

We've created a Microsoft Excel spreadsheet that can be downloaded and opened in 

any spreadsheet program including Microsoft Excel. This spreadsheet helps illustrate 

some a spreadsheet capability, formulas, and functions used in a spreadsheet, and 

allows you to experiment with a spreadsheet. 

The same spreadsheet is also available on Google Sheets. Visit the link below to open 

the spreadsheet in view mode in Google Sheets. If you want to edit any of the values, 

click File and then Make a copy option to save it to your Google Drive. 

What did people use before spreadsheets? 

Before computerized spreadsheets ledger paper was used to keep track of numbers 

and make calculations. In fact, many accountants and other individuals continued to use 

ledger paper even after the release of spreadsheet programs because they didn't trust 

computers to make proper calculations. 

Command 

I‘ve spent more than a decade working on Excel. Yet, there is so much to learn. If you 
dislike coding, excel could be your rescue into data science world (to some extent). 
Once you understand Excel operations, learning SQL is very easy. 

Why can‟t you use Excel for serious data science work? 

Now at this stage, you might ask, why can‘t I use excel for all my work. There are 
several reasons for it: 

https://www.computerhope.com/jargon/f/filename.htm
https://www.computerhope.com/jargon/c/charact.htm
https://www.computerhope.com/jargon/r/row.htm
https://www.computerhope.com/jargon/n/number.htm
https://www.computerhope.com/jargon/c/column.htm
https://www.computerhope.com/jargon/l/letter.htm
https://www.computerhope.com/jargon/c/cell.htm
https://www.computerhope.com/issues/ch000357.htm
https://www.computerhope.com/jargon/d/download.htm
https://www.computerhope.com/jargon/g/google-sheets.htm
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1. For large datasets, excel is not effective. Computations on large datasets either 
won‘t happen or would take a lot of time. Just a caveat: Microsoft recently 
launched Power BI and I need to explore it. It might have changed the 
boundaries of large data. 

2. There is no audit trail in Excel. With tools based on coding and work flow 
management, you can re-look and re-run the process again and again. It is very 
difficult to do so in excel. If you change or delete a cell in Excel in an accidental 
manner, it is difficult to trace it back. 

3. Finally, Excel takes a lot of time to update libraries with latest algorithms in data 
science and machine learning. Try searching for XGboost and FTRL in excel! 

Moving to SQL would address point 1 and point 2 to some extent. Moreover, SQL is one 
of the most sought out skills in a data scientist. 

If you don‟t know SQL yet and have worked in Excel, you can get started right 
now. I‘ve designed this tutorial with keeping in mind, the most commonly used excel 
operations. Your previous experience blended with this tutorial can quickly make you a 
SQL expert. (Note: If you find any trouble, please write to me in comments section 
below. 

Related : Basics of SQL and RDBMS for Beginners 

 

  

List of Common Excel Operations 

Here is the list of commonly used excel operation. In this tutorial, I‘ve performed all 
these operations in SQL: 

https://www.analyticsvidhya.com/blog/2015/03/basics-sql-rdbms/
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/abc.jpg
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1. View Data 
2. Sort Data 
3. Filter Data 
4. Delete Records 
5. Add Records 
6. Update Data in Existing Record 
7. Show Unique Values 
8. Write an expression to generate new column 
9. LookUp data from another table 
10. Pivot Table 

To perform operations listed above, I‘ll use the data listed below (Employee)\: 

 

  

1. View Data 

In excel, we can view all the records directly. But, SQL requires a command to process 
this request. This can be done by using SELECT command. 

Syntax: 

SELECT column_1,column_2,…column_n | *  FROM table_name; 

Exercise: 

A. View all data of Employee table 

https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Table2.png
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Select * from Employee;

 

B. View only ECODE and Gender data of Employee table 

Select ECODE, Gender from Employee  

  

2. Sort Data 

Organizing information becomes important when you have more data. It helps to 
generate quick inferences. You can quickly organize an excel worksheet 
by sorting your data in ascending or descending order. 

Syntax: 

SELECT column_1,column_2,…column_n | *  FROM table_name order by column_1 
[desc], column_2 [desc]; 

https://www.analyticsvidhya.com/wp-content/uploads/2015/12/All.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Selected_Cols.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/All.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Selected_Cols.png
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Exercise: 

A. Arrange records of Employee table in Descending order of Total_Payout. 

Select * from Employee order by Total_Payout desc; 

 

B. Arrange records of Employee table by City (ascending) and 
Total_Payout(descending). 

Select * from Employee order by City, Total_Payout desc; 

 

https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Sort_Data_Set.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Multi_Variable_Sort1.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Sort_Data_Set.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Multi_Variable_Sort1.png
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3. Filter Data 

In addition to sorting, we often apply filter to analyze data in a better way. When data is 
filtered, only rows that meet the filter criteria is displayed while other rows get hidden. 
Also, we can apply multiple criterion to filter data. 

Syntax: 

SELECT column_1,column_2,…column_n | *  FROM table_name where 
column_1 operator value; 

Below are the common list of operators, we can use to form a condition. 

Operator Description 

= Equal 

<> 
Not equal. Note: In some versions of SQL this operator may be written as 

!= 

> Greater than 

< Less than 

>= Greater than or equal 

<= Less than or equal 

BETWEEN Between an inclusive range 

LIKE Search for a pattern 

IN To specify multiple possible values for a column 

  

Exercise: 



179 
 

A. Filter observations associated with city “Delhi” 

Select * from Employee where City="Delhi"; 

 

B. Filter observations of Department “Admin” and Total_Payout >= 500 

Select * from Employee where Department="Admin" and Total_Payout >=500; 

 

  

4. Delete Records 

Deleting records or columns is a commonly used operation in Excel. In excel, we simply 
press ‗Delete‘ key on keyboard to delete a record. Similarly, SQL has 
command DELETE to remove records from a table. 

Syntax: 

DELETE FROM table_name WHERE some_column=some_value; 

Exercise: 

A. Delete observations which have Total_Payout >=600 

Delete * from Employee where Total_Payout >=600; 

It removes two record only since these two observations satisfy the condition stated 
above. But be careful! if we do not provide any condition, it will remove all records from 
a table. 

B. Delete observations which have Total_Payout >=600 and Department =”Admin” 

Delete * from Employee where Total_Payout >=600 and Department ="Admin"; 

Above command will remove only one record which satisfies the condition. 

https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Subset.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Subset_1.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Subset.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Subset_1.png
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5. Add records 

We have seen methods to remove records, we can also add records to SQL table as we 
do in excel. INSERT command helps to perform this operation. 

Syntax: 

INSERT INTO table_name VALUES (value1, value2, value3,…); -> Insert values to all 
columns 

OR, 

INSERT INTO table_name (column1,column2,column3,…) VALUES 
(value1,value2,value3,…); -> Insert values to selected columns 

Exercise: 

A. Add below records to the table „Employee‟ 

 

Insert into employee values('A002','05-Nov-

12',0.8,'Female','Admin',12.05,26,313.3,'Mumbai'); 

Select * from Employee where ECODE='A002'; 

 

B. Insert values to ECODE (A016) and Department (HR) only. 

Insert into employee (ECODE, Department) values('A016','HR'); 

Select * from Employee where Department='HR'; 

 

  

https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Add_Records1.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Insert_All.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Insert_Selected.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Add_Records1.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Insert_All.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Insert_Selected.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Add_Records1.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Insert_All.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Insert_Selected.png
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6. Update Data in Existing Observations 

Suppose, we want to update the name of ―HR‖ department to ―Manpower‖ for all 
employees. For such cases, SQL has a command UPDATE which performs this 
function. 

Syntax: 

UPDATE table_name SET column1=value1,column2=value2,… WHERE 
some_column=some_value; 

Exercise: Rename Department “HR” to “Manpower” 

Update Employee SET Department='Manpower' where Department='HR'; 

Select * from Employee;

 
 

7. Show unique values 

We can show unique values of variable(s) by applying DISTINCT keyword prior 
to variable name. 

Syntax:  

SELECT DISTINCT column_name,column_name FROM table_name; 

Exercise: Show unique values of City 

https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Update.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Update.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Update.png
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Select distinct City from Employee;  

 

8. Write an expression to generate new column 

In excel, we can create a column, based on existing column using functions or 
operators. This can be done in SQL using the commands below. 

Exercise: 

A. Create a new column Incentive which is 10% of Total_Payout 

Select *, Total_Payout*01 as Incentive from Employee;

 
 

B. Create a new column City_Code which has first three characters of City. 

Select *, Left(City,3) as City_Code from Employee where Department="Admin"; 

 

For more details on SQL functions, I would recommend you to refer this link. 

https://www.analyticsvidhya.com/wp-content/uploads/2015/12/City.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/City.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Incentive.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Incentive.png
http://www.tutorialspoint.com/sql/sql-useful-functions.htm
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/City.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Incentive.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/String.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/City.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Incentive.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/String.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/City.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Incentive.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/String.png
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9. LookUp data from another table 

The most used function of excel by any BI professional / data analyst is VLOOKUP(). It 
helps to map data from other table to parent table. In other words, we can say that it is 
the ‗excel‘ way of joining 2 data sets through a common key. 

In SQL, we have similar functionality known as JOIN. 

SQL JOIN is used to combine rows from two or more tables, based on a common field 
between them. It has multiple types: 

 INNER JOIN: Return rows when there is a match in both tables 
 

 LEFT JOIN: Return all rows from the left table and the matched rows from the 
right table 
 

 RIGHT JOIN: Return all rows from the right table and the matched rows from the 
left table 
 

 FULL JOIN: Return all rows when there is a match in ONE of the tables 

Syntax:  

SELECT table1.column1, table2.column2..... FROM table1 INNER | LEFT| RIGHT| 

FULL JOIN table2 ON table1.column = table2.column; 

Exercise: Below is city category table “City_Cat”, now I want to map city category 

to Employee table and show all records of Employee table.
Here, I want to show all records of table Employee. So, we will use left join. 

SELECT Employee.*,City_Cat.City_Category FROM Employee LEFT JOIN City_Cat O

N Employee.City = City_Cat.City; 

https://www.analyticsvidhya.com/wp-content/uploads/2015/12/City_Mapping.png
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To know more about JOIN operations, I would recommend you to refer this link. 

  

10. Pivot Table 

Pivot Table is an advanced way of analyzing data in excel. Not only it is useful, but it 
allows you to extract the hidden insights from data. 

Moreover, it helps us to generate inference by summarizing data and allow 
us to manipulate it in different ways. This operation can be done in SQL by using 
aggregate functions and GROUP BY command. 

Syntax: 

SELECT column, aggregate_function(column) FROM table WHERE column operator 
value GROUP BY column; 

Exercise:  

A. Show sum of Total_Payout by Gender 

SELECT Gender, Sum(Total_Payout) from Employee Group by Gender; 

 

B. Show sum of Total_Payout and Count of Records by Gender and City 

http://www.tutorialspoint.com/sql/sql-using-joins.htm
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Left_Join1.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Pivot1.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Left_Join1.png
https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Pivot1.png
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SELECT Gender, City, Count(City), Sum(Total_Payout) from Employee Group by 

Gender, City; 

 

  

End Notes 

Once you work on SQL, you would realize data handling and manipulation can be much 

faster. For installation, mysql is open source. You can install it and get started. 

In this article, we have looked at the SQL commands for 10 common excel operations 

like view, sort, filter, delete, lookup and summarizing data. We also looked at the 

different operators and types of Joins to perform SQL operation seamless. 

MS-Excel 

MS Excel is a commonly used Microsoft Office application. It is a spreadsheet program 
which is used to save and analyse numerical data. 

In this article, we bring to you the important features of MS Excel, along with an 
overview of how to use the program, its benefits and other important elements. Few 
sample MS Excel question and answers are also given further below in this article for 
the reference of Government exam aspirants. 

Basics of MS Excel 

What is MS Excel? 

MS Excel is a spreadsheet program where one can record data in the form of tables. It 
is easy to analyse data in an Excel spreadsheet. The image given below represents 
how an Excel spreadsheet looks like: 

 

How to open MS Excel? 

To open MS Excel on your computer, follow the steps given below: 

 Click on Start 

https://www.analyticsvidhya.com/wp-content/uploads/2015/12/Pivot2.png
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 Then All Programs 

 Next step is to click on MS Office 

 And then finally, choose the MS-Excel option 

Alternatively, you can also click on the Start button and type MS Excel in the search 
option available. 

What is a cell? 

A spreadsheet is in the form of a table comprising rows and columns. The rectangular 
box at the intersection point between rows and columns forms a cell. Given below is an 
image of a cell: 

 

What is Cell Address? 

The cell address is the name by which is cell can be addressed. For Example, if row 7 is 
interested in column G, then the cell address is G7.  

 

 

Other Related Links 

High-Level Computer Languages  Basics of Cloud Computing  

Computer Networks Internet 

Computer Software and Hardware Questions Types of Computer 

Features of MS Excel 

Various editing and formatting can be done on an Excel spreadsheet. Discussed below 
are the various features of MS Excel.  

The image below shows the composition of features in MS Excel: 

 

 Home 

 Comprises options like font size, font styles, font colour, background 
colour, alignment, formatting options and styles, insertion and deletion of 
cells and editing options 
 

https://byjus.com/bank-exam/high-level-computer-language-for-bank-exam/
https://byjus.com/bank-exam/basics-of-cloud-computing-for-ibps-so-and-sbi-so-exam/
https://byjus.com/govt-exams/computer-networks/
https://byjus.com/govt-exams/internet/
https://byjus.com/govt-exams/computer-software-hardware-questions/
https://byjus.com/govt-exams/types-of-computer/
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 Insert 

 Comprises of options like table format and style, inserting images and 
figures, adding graphs, charts and sparklines, header and footer option, 
equation and symbols 

  

 Page Layout 

 Themes, orientation and page setup options are available under the page 
layout option 

  

 Formulas 

 Since tables with a large amount of data can be created in MS excel, 
under this feature, you can add formulas to your table and get quicker 
solutions  

  

 Data 

 Adding external data (from web), filtering options and data tools are 
available under this category 

  

 Review 

 Proofreading can be done for an excel sheet (like spell check) in the 
review category and a reader can add comments in this part  

  

 View 

 Different views in which we want the spreadsheet to be displayed can be 
edited here. Options to zoom in and out and pane arrangement are 
available under this category 

For those willing to learn more about MS Excel, can refer to the video given below and 
understand every small aspect of this program in detail. 

Benefits of Using MS Excel 

MS Excel is widely used for various purposes because the data is easy to save, and 
information can be added and removed without any discomfort and less hard work. 

Given below are a few important benefits of using MS Excel: 

 Easy To Store Data: Since there is no limit to the amount of information that can 
be saved in a spreadsheet, MS Excel is widely used to save data or to analyse 
data. Filtering information in Excel is easy and convenient. 
 

 Easy To Recover Data: If the information is written on a piece of paper, finding it 
may take longer, however, this is not the case with excel spreadsheets. Finding 
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and recovering data is easy. 
 

 Application of Mathematical Formulas: Doing calculations has become easier 
and less time taking with the formulas option in MS excel 
 

 More Secure: These spreadsheets can be password secured in a laptop or 
personal computer and the probability of losing them is way lesser in comparison 
to data written in registers or piece of paper. 
 

 Data at One Place: Earlier, data was to be kept in different files and registers 
when the paperwork was done. Now, this has become convenient as more than 
one worksheet can be added in a single MS Excel file. 
 
Neater and Clearer Visibility of Information: When the data is saved in the 
form of a table, analysing it becomes easier. Thus, information is a spreadsheet 
that is more readable and understandable. 
 

Competitive exam aspirants must also be aware of other subjects which are a part of 
the Government exam syllabus. To review and analyse the same, refer to the links 
below: 

Logical Reasoning Quantitative Aptitude 

Verbal Ability  Current Affairs  

Static GK Banking Awareness 

MS Excel – Points To Remember 

There are certain things which one must know with respect to MS Excel, its applications 
and usage: 

 An MS Excel file is saved with an extension of .xls 

 Companies with large staff and workers use MS Excel as saving employee 
information becomes easier 

 Excel spreadsheets are also used in hospitals where the information of patients 
can be saved more easily and can be removed conveniently once their medical 
history is cleared 

 The sheet on which you work is called a Worksheet 

 Multiple worksheets can be added in a single Excel file 

 This is a data processing application 

https://byjus.com/govt-exams/logical-reasoning/
https://byjus.com/govt-exams/quantitative-aptitude/
https://byjus.com/govt-exams/verbal-ability/
https://byjus.com/current-affairs/
https://byjus.com/govt-exams/static-gk/
https://byjus.com/bank-exam/banking-awareness/
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Creation of files in MS-Access 

Microsoft Access is a Database Management System offered by Microsoft. It uses the 
Microsoft Jet Database Engine and comes as a part of the Microsoft Office suite of 
application. 

Microsoft Access offers the functionality of a database and the programming capabilities 
to create easy to navigate screens (forms). It helps you analyze large amounts of 
information, and manage data 

Database File: 

It is a file which stores the entire database. The database file is saved to your hard drive 

or other storage devices. 

Datatypes: 

Datatypes are the properties of each field. Every field has one datatype like text, 

number, date, etc. 

Table 

 A Table is an object which stores data in Row & Column format to store data. 

 

 A Table is usually related to other tables in the database file. 

 

 Each column must have Unique name 

 

 We can also define Primary Key in a table. 

 

Query 

 Queries answer a question by selecting and sorting and filtering data based on 

search criteria. 

 

 Queries show a selection of data based on criteria (limitations) you provide. 

 

 Queries can pull from one or more related Tables and other Queries. 

 

 Types of Query can be SELECT, INSERT, UPDATE, DELETE. 
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Form 

 A form is a database object that you can use to create a user interface for a 

database application. 

 

 Forms help you to display live data from the table. It mainly used to ease the 

process of data entry or editing. 

Report 

 A report is an object in desktop databases primarily used for formatting, 

calculating, printing, and summarizing selected data. 

 

 You can even customize the report's look and feel. 

Macros 

Macros are mini computer programming constructs. They allow you to set up 

commands and processes in your forms, like, searching, moving to another record, or 

running a formula. 

Modules: 

Modules are procedures(functions) which you can write using Visual Basic for 

Applications (VBA). 

Microsoft Access Data Types 

MS Access common data types are listed below: 

Type of 

Data 

Description Size 

Short Text Text, including numbers which does not need 

calculation. (e.g., Mobile numbers). 

Up to 255 characters. 

Long Text This data type is used for lengthy text or alphanumeric 

data. 

Maximum 63, 999 characters. 

Number Numeric data type used for storing mathematical 

calculations. 

1, 2, 4, 8, and 16 bytes. 
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Date/Time Store Date/time for the years 100 through 9999. 8 bytes. 

Currency It allows you to store currency values and numeric data 

with one to four decimal places. 

8 bytes. 

Auto 

Number 

Assign a unique number or assigned by Microsoft 

Access when any new record is created. Usually used 

as the primary key 

Four bytes (16 bytes if it is set as a 

Replication ID). 

Yes/No It only stores logical values Yes and No. 1 bit 

Attachment It stores files, such as digital photos. Multiple files can 

be attached per record. 

Up to 2 GB Data can be stored. 

OLE 

objects 

OLE objects can store audio, video, other Binary Large 

Objects. 

Up to 2 GB data can be stored. 

Hyperlink Text or combinations of text and numbers stored. That 

text is used as hyperlink address. 

Each part of a Hyperlink data type 

allows you to store a maximum 2048 

characters. 

Calculated Helps you to create an expression that uses data from 

one or more fields. 

You can create an expression which 

uses data from one or more fields. 

Differences between Access and Excel 

Microsoft Access and Excel are very similar yet very different. Here, are some important 

difference points between both of them- 

Access Excel 

Deals with text, numbers, files and all kinds of data Microsoft Excel generally deals with numerical data 

All the data is stored one time, in one place. Lots of worksheets or documents are a store with similar, 

repeated data. 

Helps you to build highly functional data entry forms and Only the primary data entry screen is available. 
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report templates. 

Users will be able to enter the data more efficiently and 

accurately. 

Data accuracy and speed is not much because of the 

format. 

Advantages of MS Access 

 Now in this MS Access Tutorial, we will learn the pros/benefits for using MS 

Access application: 

 

 Access offers a fully functional, relational database management system in 

minutes. 

 

 Easy to import data from multiple sources into Access 

 

 You can easily customize Access according to personal and company needs 

 

 Microsoft Access online works well with many of the development languages that 

work on Windows OS 

 

 It is robust and flexible, and it can perform any challenging office or industrial 

database tasks. 

 

 MS-Access allows you to link to data in its existing location and use it for viewing, 

updating, querying, and reporting. 

 

 Allows you to create tables, queries, forms, and reports, and connect with the 

help of Macros 

 

 Macros in Access is a simple programming construct with which you can use to 

add functionality to your database. 

 

 Microsoft Access online can perform heterogeneous joins between various data 

sets stored across different platforms 

Disadvantages of MS Access 

Here, are the cons for using MS Access 
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 Microsoft Access database is useful for small-to-medium business sectors. 
However, it is not useful for large-sized organizations 
 

 Lacks robustness compared to dbms systems like MS SQL Server or Oracle 
 

 All the information from your database is saved into one file. This can slow down 
reports, queries, and forms 
 

 Technical limit is 255 concurrent users. However, the real-world limit is only 10 to 
80 (depending on the type of application which you are using) 
 

 It requires a lot more learning and training compares with other Microsoft 
programs 

How to Start Microsoft Access 

Note: We assume you have the latest Microsoft Access installed which comes bundled 
with Microsoft Office 365 package. 

There are two ways to Start MS Access. 

1. From Windows, 'Start' button. 
 

2. From Desktop, Right Click> 'New' option. 

Now in this Microsoft Access tutorial, let's have a look of starting MS Access using both 
the ways: 

Option 1) From Windows, Start button. 

Step 1) Click on the 'Windows' icon. You will find the list of installed programs. 

Step 2) Check and click on Access Icon. 

 

https://www.guru99.com/dbms-tutorial.html
https://www.guru99.com/ms-sql-server-tutorial.html
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Step 3) MS Access Application window will appear 

 

Steps 4) Press 'Esc' 

Result: This will open the MS Access windows application 
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Option 2) From Desktop, 'New' option. 

Step 1) Right Click from Desktop and Click 'New' 

Step 2) Click on 'Microsoft Access Database Option' 

 

Step 3) Below MS Access Application window will appear 
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Switching between application, MS-PowerPoint 

If you want to work with more than one presentation in PowerPoint, you can open two or 
more presentations next to each other. This arrangement makes it easy to compare 
presentations and edit them as well. This is also helpful when you want to copy or move 
slides from one presentation to another. Let's imagine you have four presentations open 
and you can only see the one that is active. What about the other three presentations? 
How do you navigate to those presentations without having to close, or minimize the 
active presentation? 

In this tutorial, you will learn how to switch between multiple open presentations 
in PowerPoint 2016. With this option, you can easily switch between different 
presentation windows, without reducing the window size. Follow these steps to learn 
more: 

1. Open multiple presentations in PowerPoint 2016. As shown in Figure 1, only the 
last opened presentation is visible. Are you wondering about where the other 
presentations disappeared? 

 

Figure 1: Only one of the multiple open presentations is visible 

https://www.indezine.com/products/powerpoint/learn/interface/2016/compare-presentations-manually.html
https://www.indezine.com/products/powerpoint/learn/interface/2016/compare-presentations-manually.html
https://www.indezine.com/products/powerpoint/learn/interface/2016/reuse-slides-through-drag-drop.html
https://www.indezine.com/products/powerpoint/learn/interface/2016/reuse-slides-through-drag-drop.html
https://www.indezine.com/products/powerpoint/learn/powerpoint-2016/
https://www.indezine.com/products/powerpoint/learn/powerpoint-2016/
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Way 1 

1. a. Access the View tab on the Ribbon, as shown highlighted in red within Figure 
2. 

 

 

Figure 2: View tab on the Ribbon 

b. Within the View tab, click the Switch Windows button, as shown highlighted 
in blue within Figure 2, above. 

c. This opens the Switch Windows drop-down menu, as shown in Figure 3. 

 

Figure 3: Switch Windows drop-down menu 

d. This drop-down list displays all the presentations which are open. To navigate to 
any of these open presentations, click on the name of the presentation within this 
menu. 

 

https://www.indezine.com/products/powerpoint/learn/interface/2016/ribbon-and-tabs.html
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Way 2 

a. When your presentations are open, you will find an instance of PowerPoint on the 
Taskbar (highlighted in red within Figure 4). 

Figure 4: PowerPoint instance on the Taskbar 

b. Hover your cursor over the PowerPoint instance to see a preview of all open 
presentations, as shown in Figure 5 below. Then click on the preview of the 
presentation you want to access now. 

 

Figure 5: Preview of all open presentations 

Function Keys 

F1 Display Help or the Office Assistant 

F2 Select the text box containing an object or text 

F4 Repeats the last presentation action (Edit > Repeat)  

(not Format Autoshape dialog) 

F5 Runs the presentation (View > Slide Show) 

F6 Moves to the next pane in the presentation (clockwise) 

F7 Displays the (Tools > Spelling) dialog box 

F10 Toggles the activation of the Menu Bar 

F12 Displays the (File > Save As) dialog box 
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Shift + Function 

Shift + F1 Activates the context sensitive Whats this ?  

prompt (Help > Whats This) 

Shift + F3 Toggles between lowercase, mixedcase  

and uppercase on the selection 

Shift + F4 Repeat the last Find, the same as (Edit > Find Next) 

Shift + F6 Moves to the previous pane in the presentation (anti-clockwise) 

Shift + F9 Toggles the display of Guide Lines 

Shift + F10 Display the (Shortcut) menu for the selected item 

Shift + F12 Saves, Displays the (File > Save As) dialog box  

if a new presentation 

 

 

Ctrl + Function 

Ctrl + F4 Closes the active presentation or window (File > Close) 

Ctrl + F5 Restore the size of the active presentation or window 

Ctrl + F6 Moves to the next presentation window 

Ctrl + F7 Activates the Move window command 

Ctrl + F8 Activates the Resize window command 

Ctrl + F9 Minimises the size of the active presentation or window 

Ctrl + F10 Maximise the size of the active presentation or window 
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Ctrl + F12 Displays the (File > Open) dialog box 

 

 

Other + Function 

Alt + F2 Displays the (File > Save As) dialog box 

Alt + F4 Closes the active presentation (saving first)  

and exits PowerPoint (File > Exit) 

Alt + F5 Restore the program window size 

Alt + F7 Find next mispelt word - continue (Tools > Spelling) ?? 

Alt + F8 Displays the (Tools > Macros > Macro) dialog box 

Alt + F9 Toggles the display of the Grid 

Alt + F10 Maximise the program window 

Alt + F11 Toggles between the Visual Basic Editor window  

and the PowerPoint window 

Alt + Shift + F2 Displays the (File > Save As) dialog box 

Alt + Shift + F4 Closes the active presentation (saving first)  

and exits PowerPoint (File > Exit) 

Alt + Shift + F10 Displays the drop-down menu for the corresponding smart tag 

Ctrl + Shift + F10 Activates the Menu Bar or displays the (View > Toolbars)  

dialog box 

Ctrl + Shift + F12 Displays the (File > Print) dialog box 
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Ctrl + Numbers 

Alt + Shift + 1 Show Heading 1 (Outline view) 

Alt + Shift + 9 Expands all text in the presentation (Outline view) 

 

 

Ctrl + Letters 

Ctrl + A Selects all the objects on the active slide 

Ctrl + B Toggles bold on the current selection 

Ctrl + C Copies the current selection to the clipboard (Edit > Copy) 

Ctrl + D Make a duplicate of the selected slide (Edit > Duplicate) 

Ctrl + E Centre aligns the current selection 

Ctrl + F Displays the (Edit > Find) dialog box 

Ctrl + G Displays the (View > Grid and Guides) dialog box 

Ctrl + H Displays the (Edit > Replace) dialog box 

Ctrl + I Toggles italics on the current selection 

Ctrl + J Justifies the current selection 

Ctrl + K Displays the (Insert > Hyperlink) dialog box (in a textbox) 

Ctrl + L Left aligns the current selection 
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Ctrl + M Inserts a new slide (Insert > New Slide) 

Ctrl + N Creates a new presentation (File > New) 

Ctrl + O Displays the (File > Open) dialog box 

Ctrl + P Displays the (File > Print) dialog box 

Ctrl + R Right aligns the current selection 

Ctrl + S Saves, Displays the (File > Save As) dialog  

box if a new presentation 

Ctrl + T Displays the (Format > Font) dialog box 

Ctrl + U Toggles (continuous) underlying of the selection 

Ctrl + V Pastes the entry from the clipboard (Edit > Paste) 

Ctrl + W Closes the active presentation or window (File > Close) 

Ctrl + X Cuts the current selection to the clipboard (Edit > Cut) 

Ctrl + Y Repeats the last Presentation action (Edit > Repeat) 

Ctrl + Z Undo the last Presentation action (Edit > Undo) 

 

 

Others + Letters 

Ctrl + Shift + B Opens the Outlook Address Book 

Ctrl + Shift + C Copies the formatting attributes from the current  

selection to the clipboard 
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Ctrl + Shift + F Activates the Font Names drop-down on the Formatting toolbar 

Ctrl + Shift + G Group the currently selected objects / shapes 

Ctrl + Shift + H Ungroups the currently selected object / shape 

Ctrl + Shift + P Activates the Font Size drop-down on the Formatting toolbar 

Ctrl + Shift + V Pastes the formatting attributes from the clipboard  

on to the selection 

Alt + D Displays the (Slide Show) menu 

Alt + E Displays the (Edit) menu 

Alt + F Displays the (File) menu 

Alt + H Displays the (Help) menu 

Alt + I Displays the (Insert) menu 

Alt + K Checks the names in the To, Cc and Bcc lines  

against the Address Book 

Alt + O Displays the (Format) menu 

Alt + S Displays an e-mail message containing the active  

presentation 

Alt + T Displays the (Tools) menu 

Alt + U Displays the AutoShapes drop-down menu on the  

Drawing toolbar 

Alt + V Displays the (View) menu 
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Alt + W Displays the (Window) menu 

Alt + Shift + A Show all or collapse all text or headings (Outline view) 

 

 

Entering Data 

Enter Enters a new paragraph 

Shift + Enter Enters a line break (Soft break) 

Ctrl + Tab Inserts a tab in a table cell 

 

 

Extending Data 

Shift + Home Extends the selection to the beginning of the line 

Shift + End Extends the selection to the end of the line 

Shift + Up Arrow Extends the selection one line up 

Shift + Down Arrow Extends the selection one line down 

Shift + Left Arrow Extends the selection one character to the left 

Shift + Right Arrow Extends the selection one character to the right 

Ctrl + Shift + Home Extends the selection to the beginning of the textbox 

Ctrl + Shift + End Extends the selection to the end of the textbox 
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Selecting Data 

Ctrl + Shift + Up Arrow Selects to the line above 

Ctrl + Shift + Down Arrow Selects to the line below 

Ctrl + Shift + Left Arrow Selects to the beginning of the word 

Ctrl + Shift + Right Arrow Selects to the end of the word 

Delete Deletes one character to the right 

Backspace Deletes one character to the left 

Ctrl + Delete Deletes one word to the right 

Ctrl + Backspace Deletes one word to the left 

 

 

Formatting Data 

Ctrl + ] Increases the font size to the next size in the drop-down list 

Ctrl + [ Decreases the font size to the next size in the drop-down list 

Ctrl + Shift + > Increases the font size to the next size in the drop-down list 

Ctrl + Shift + < Decreases the font size to the next size in the drop-down list 

Ctrl + = Toggles Subscript on the selection 

Ctrl + Shift + = Toggles Superscript on the selection 
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Manoeuvring 

Arrow Keys Moves one character or line in the given direction 

Tab Moves to the first or next hyperlink / object / cell 

Shift + Tab Moves to the last or previous hyperlink / object / cell 

Home Moves to the beginning of the line 

End Moves to the end of the line 

Page Up Moves to the previous slide 

Page Down Moves to the next slide 

Shift + Page Up Moves to the previous slide 

Shift + Page Down Moves to the next slide 

Ctrl + Home Moves to the beginning of the text box 

Ctrl + End Moves to the end of the text box 

Ctrl + Up Arrow Moves up one paragraph 

Ctrl + Down Arrow Moves down one paragraph 

Ctrl + Left Arrow Moves one word to the left 

Ctrl + Right Arrow Moves one word to the right 

Ctrl + Enter Moves to the next title or body text placeholder 
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Other 

Alt + Tab Toggles between all your open applications 

Alt + Shift + Tab Toggles backwards between all your open applications 

Ctrl + Shift + Tab Toggles between the Outline tab and the Slides 

 tab in Normal view. 

Ctrl + Spacebar Remove manual character formatting returning  

the text back to its default 

Esc Cancels the action or closes the dialog box 

Alt + Shift + Left Arrow Promotes a paragraph (Outline view) 

Alt + Shift + Right Arrow Demotes a paragraph (Outline view) 

Alt + Shift + Up Arrow Moves the selected paragraphs up (Outline view) 

Alt + Shift + Down Arrow Moves the selected paragraphs down (Outline view) 

Alt + Shift + + Expands the text below a heading (Outline view) 

Alt + Shift + - Collapses the text below a heading (Outline view) 

/ Turn character formatting on or off (numeric keypad) 

Alt + Escape Switches to the next program 

Ctrl + Escape Displays the Start Menu 

Print Screen Copies a picture of the whole screen to the clipboard 

Alt + Print Screen Copies a picture of just the active window to the clipboard 
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Over the past thirty years, PowerPoint has become synonymous with presentations. 

Give a speech, present a new product, share finances in a board meeting—all are 

typically done with a PowerPoint presentation. That‘s easy enough if you‘re presenting 

from your laptop and have Microsoft Office installed. 

Or it can be far more difficult. You might need to email your slide deck to the event 

organizer—and hope they have the same version of PowerPoint installed. Or you may 

carry your PowerPoint file around on a flash drive to open it on the presentation 

computer. Neither are great solutions, especially for all the times you need to make a 

last-minute change to your slides or if you don‘t typically use Microsoft Office. 

PowerPoint Online is the alternative you need. Here‘s everything you need to use 

PowerPoint for free online, where you can edit and present your slides from anywhere. 

It starts with Office Online. Launched in 2010 as Office Web Apps, Office Online today 

includes simplified, free versions of Microsoft Office‘s most popular apps: Word, Excel, 

PowerPoint, and OneNote. 

If you‘ve ever used the iPad or Android tablet versions of Office, Office Online will feel 

instantly familiar. The basics are the same. Each Office Online app includes an Office-

style toolbar with Home, Insert, Design, and other tabs to organize core editing tools. 

Office Online apps don‘t include all of their Windows features. They include instead a 

focused set of editing tools that, for most documents, spreadsheets, and presentations, 

are all you need. 

The big difference is that the apps are online. Instead of emailing files back and forth, or 

syncing changes via OneDrive or Dropbox then sending messages to colleagues when 

https://office.live.com/start/PowerPoint.aspx
https://products.office.com/office-online/documents-spreadsheets-presentations-office-online
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something‘s finished, changes happen automatically in Office Online. Your team can 

open files at the same time, make changes or add comments, and Office will save and 

sync it to all your OneDrive accounts automatically. Office Online apps also work 

everywhere. Open any browser, go to Office.com, and your work is ready to pick up 

where you left off. 

Office Online is free for personal use—log into Office.com with a Microsoft account and 

fill up OneDrive‘s free 5GB of storage with all your Office files. A business version is 

included with Office 365 for business and enterprise accounts as well. 

The basics are the same. If you‘ve used PowerPoint before, you‘ll feel at home in 

PowerPoint online. Here are the things to keep in mind, the tips to help you work 

efficiently in your browser, and ways to work around Office Online‘s limitations. 

 

 

 

 


